Sysmex

OPERATOR’'S MANUAL

AUTOMATED HEMATOLOGY ANALYZER

KX-21

CHAPTER 1. INTRODUCTION

CHAPTER 2: SAMPLE ANALYSIS

CHAPTER 3: DISPLAY AND PROCESSING OF ANALYSIS RESULTS
CHAPTER 4: MAINTENANCE AND SUPPLIES REPLACEMENT
CHAPTER 5: QUALITY CONTROL

CHAPTER 6: CALIBRATION

CHAPTER 7: TROUBLESHOOTING

CHAPTER 8: ADJUSTMENT

CHAPTER 9: FUNCTIONAL DESCRIPTION

CHAPTER 10: INSTRUMENT SETUP

APPENDIX A: INSTALLATION

APPENDIX B: TECHNICAL INFORMATION

INDEX

SYSMEX CORPORATION
KOBE, JAPAN

Copyright 0 1997 - 2000 by SYSMEX CORPORATION

All rights reserved. No part of this Operator's Manual may be Code No. 461-2261-1
reproduced in any form or by any means whatsoever without PRINTED IN JAPAN
prior written permission of SYSMEX CORPORATION. Date of Last Revision: January 2000



Sysmex is aregistered trademark of SY SMEX CORPORATION.
CELLCLEAN, CELLPACK, EIGHTCHECK-3WP, STROMATOLY SER-WH are
trademarks of SY SMEX CORPORATION.

Cubitainer is aregistered trademark of Hedwin Corporation.
Teflon isaregistered trademark of E.I. du Pont de Nemours & Co., Inc.
VENOJECT isaregistered trademark of Terumo Corporation.

Other trademarks referenced are property of their respective owners.

Itis prohibited to reproduce part or al of the contents of this Manual without permission.
The display screens carried in this Manua may in some cases differ from actual screens.

We reserve the right to make further improvements and incorporate them in our products,
which then will have some points that differ from descriptionsin this Manual.

Patient names and doctor names are entered for information and illustration purposes only,
and do not imply real specific persons.

Sysmex KX-21 Operator’s Manual -- Revised October 1998




RECEIVING INSTRUCTIONS

The KX-21 has been thoroughly tested before shipment, and has been packaged
carefully to prevent damage from shipping and handling. Reagents and options have
also been sent and will arrive at approximately the same time asthe analyzer. Follow
these guidelines when the system arrives:

. Check to see that the arrows on the sides of the packages are pointing up. If the
arrows do not point up, remark thisinformation on the bill of lading.

*  Visualy inspect the outside of the package for rips, dents, or possible shipping
damage. Document any sign of damage on the bill of lading, regardless of how
insignificant it may appear. Thisisfor your protection!

. Notify your service representative that the KX-21 system and its components
have arrived.

*  Wait for your service representative to unpack the system and open the
packages.

. Follow the unpacking and storage instructions provided on the outside of the
package. Specia requirements such as refrigeration are clearly marked on the

outside of the carton and will be included in the unpacking instructions and
package inserts.

WARRANTY INFORMATION

All instruments manufactured by Sysmex® are warranted against defective materials
or workmanship for a period of one year commencing on the install ation date at the
customer's required location.

This Warranty does not cover any defect, malfunction, or damage due to:

1. Accident, neglect or willful mistreatment of the product

2. Fallureto use, operate, service, or maintain the product in accordance with the
applicable Sysmex Operator's Manual

3. Failureto usethe appropriate reagents or chemicals specified for the product
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ENSURE SAFE OPERATION OF THE INSTRUMENT

Before operating this instrument, carefully read the "Ensure Safe Operation of the Instrument”
and OPERATOR’'S MANUAL, and strictly follow the instructions given in them.
Thismanual carries avariety of illustrations to make sure that the product can be used safely
and correctly, thus preventing you and others from suffering injuries and damage to property.

The illustrations and meaning are described in the following.
Do understand what they mean before proceeding to the text of the MANUAL.

Meaning of Signs

& « If this sign is ignored and the instrument is operated incorrectly, there is
WARNING : L . . ;
a potentially hazardous situation which could result in death or serious

injury of an operator, or grave property damage.

« If this sign is ignhored and the instrument is operated incorrectly, there is
&CAUT'ON a potentially hazardous situation which may result in injury of an
operator, adverse effect on output results, or will cause property
damage.

Caution on Diagnosis

/_\ CAUTION This product is a clinical instrument for screening of abnormalities.
Clinical judgments by physicians should take into account results from
clinical examinations and other test results besides hematology result.
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/N\WARNING

* In the event the instrument emits abnormal odor or any smoke, turn off the power
immediately and disconnect the power plug from the wall socket.
If the instrument is used continuously in that state, there is a hazard that fire, electrical shock, or
injury may result.
Contact your Sysmex service representative for inspection.

» Take care not to spill blood or reagent, or drop wire staples or paper clips into the
instrument.
Those might cause short circuit or smoke emission. If such trouble should occur, turn off the power
supply immediately and pull off the power plug from the wall socket. Then contact Sysmex service
representative for inspection.

* Do not touch the electrical circuits inside the cover. Especially if your hands are wet,
there is a hazard that electrical shock may result.

» Always wear rubber gloves when performing maintenance work or inspection.
Use specified tools and parts.
After work is over, wash your hands with disinfectant.
There is a possibility that those areas of the hand which came in contact with blood could suffer
infection, electrical shock, or burn.

* Be careful when handling samples.
Always wear rubber gloves; otherwise infection by bacteria could result. If bacteria happen to enter
your eye or a cut, wash it off with plenty of water, and immediately see a doctor.

» When discarding waste liquid, or disassembling/assembling the related parts, do not
touch the waste liquid.

If it is contaminated with blood, infection of bacteria may result. If you should touch the waste liquid
inadvertently, wash it off with disinfectant first, then wash it off with soap.

When Handling Reagent

« If a reagent happens to enter your eye, wash it off immediately using plenty of water, and
take medical treatment at once.

« If you should swallow it inadvertently, call for a doctor immediately, drink plenty of water,
and throw up.

« If it happens to adhere to the hand or the skin of other area, wash it off using plenty of
water.

* When discarding waste liquid and instrument consumable, take proper disposing steps
as medical, ineffective, and industrial wastes.
If they are contaminated with blood, infection of bacteria may result.

* Do not modify the instrument. (Modification is prohibited by Pharmaceutical Affairs Law in
Japan.) Check the regulations that apply to laboratories in your country.

Sysmex KX-21 Operator’s Manual -- Revised October 1998 11




/N\WARNING

Power Supply, Connection, and Grounding
* Never put the power plug in any socket other than the specified voltage.
Otherwise, fire or electrical shock will result.

* When installing the instrument, be sure to ground it.
Otherwise, fire or electrical shock will result.

Handling Power Supply Cord
» Take care not to damage the power cord, place a heavy device on it, or pull it forcibly.
Otherwise, the wire may break causing fire or electrical shock.

« When connecting the instrument to a peripheral (host computer), be sure to switch off the
power supply beforehand.
Otherwise, electrical shock or instrument failure may result.
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&CAUTION

Use of Reagents

« After unpacking, be sure not to allow dust, dirt, or bacteria to come in touch with
the reagent.

* Do not use reagents which are out of the expiration date.

« Handle a reagent gently to prevent formation of bubbles.
» Take care not to spill a reagent. If it spills, wipe it off immediately using a wet
cloth or the like.

* Follow other instructions described on the Package Insert on each reagent.

Use of Instrument
« When performing maintenance work or inspection, use specified tools and parts.
Do not use substitute parts, or modify the instrument. It is hazardous.

* Do not bring your body or clothes close to the instrument.

« Those who have no or only limited experience in using reagents are
recommended to have guidance or assistance of those with sufficient
experience.

« If the instrument has developed a trouble by any chance, a person in charge of it
should take steps within the range specified in the OPERATOR’'S MANUAL. As to
troubles other than mentioned in it, contact Sysmex service representative for
repair.

* Unpacking, installation, and confirmation of initial operation must be done by
Sysmex service representative.

Environment for Use

 Install the instrument in a place which is not subject to water splash.

 Install the instrument in a place which is not subject to adverse effects of high
temperature, high humidity, dust, direct sunlight, etc.

« Do not give the instrument a strong vibration or impact.

« Do not install the instrument near a chemical storage or a place where a gas is
generated.
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STRUCTURE OF THIS MANUAL

Read this manual carefully so you will be able to use the instrument to its full extent, and
operate it correctly. This manual contains ten Chapters and APPENDICES as listed in the

following:

Chapter 1: Introduction Describes overview of this instrument, including the
outline of the instrument, operation procedure, and
messages, and cautions during installation.

Chapter 2: Sample Analysis Describes procedures for start-up of the instrument,
measurement of the sample, and shut-down.
Summarizes the operation method for analyzing the
sample.

Chapter 3: Display and Processing of Describes the displayed content of the analysis data,

Analysis Results and the process of the latest sample/stored data.
Also describes the manual analysis and the external
output.

Chapter 4: Maintenance and Supplies Describes scheduled maintenance and replacement

Replacement method of supplies such as reagent.

Chapter 5: Quality Control Describes execution procedures of the X control and L-
J control for quality control.

Chapter 6: Calibration Describes procedures for automatic/manual calibration.

Chapter 7: Troubleshooting Describes error messages and troubleshooting.

Chapter 8: Adjustment Describes the method of pressure adjustment based on
the troubleshooting.

Chapter 9: Functional Description Describes the analyzing principles of this instrument
and names of the components.

Chapter 10: Instrument Setup Describes the system environment setting such as
date, time, and unit, and the data analysis setting such
as data error judgment.

Appendix A: Installation Describes the installation method of the KX-21.

Appendix B:  Technical Information Technical reference data describing the specification for

host output format.
(The host output function is an option.)

VI
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INTRODUCTION

Thank you for purchasing the Sysmex® Automated Hematology Analyzer KX-21.
Carefully read the OPERATOR'S MANUAL for correct use of the unit.

Keep this MANUAL handy after reading. 1t will continue to be of your servicein finding
specific information about this instrument.
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PREMISES FOR SIGNS

Meaning of Signs

& « If this sign is ignored and the instrument is operated incorrectly, there is
WARNING 4 . . . . .
a potentially hazardous situation which could result in death or serious
injury of an operator, or grave property damage.

& CAUTION * If this sig_n is ignored and _the i_nstrum_ent is operated_ in_c_orrectly, there is
a potentially hazardous situation which may result in injury of an
operator, adverse effect on output results, or will cause property
damage.

CAUTION: « Indicates what we would like you to know to maintain instrument
performance and prevent its damage.

NOTE: « Indicates information which will come handy in operating the instrument.

Document Conventions

In explaining operation, this manual uses the conventions as shown below.

» Thekeyson the panel keyboard are expressed within square brackets.
For example: [SELECT], [ENTER], [A]

» Thedisplay on LCD appears within quotation marks.
For example: "Stand-by," "WB"

* The name of menu appears within quotation marks.
For example: "2: Quality Control," "6: Settings"

NOTE: » LCD and printing described in this manual may differ from that in
practice.
 Due to the improvement of the product, the content of this manual may
not conform with the product.
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INTRODUCTION

1. INTRODUCTION

The Sysmex™ KX-21 is an automatic multi-parameter blood cell counter for in vitro
diagnostic use in clinical laboratories.

The KX-21 processes approximately 60 samples an hour and displays on the LCD screen the
particle distribution curves of WBC, RBC, and platelets, along with data of 18 parameters,
asthe analysis results.

Chapter 1 introduces the overview of the instrument, analysis procedure, etc. that we
recommend you to read before using the KX-21. The main contents of Chapter 1 are as
follows:

Overview of Instrument
The important functions of the KX-21 and the options for efficient operation are explained.

Main Points of Analysis Procedure
Explanation is given on the procedure for implementing each analysis mode, descriptions and
functions of the keys on panel keyboard, and the messages on the LCD screen.

Precautions at Time of Installation
Explanation is given on the matters that need to be confirmed before installation, such as
installation space, required equipment, environmental conditions.

Instrument Specifications
The instrument specifications are described.

Menu Tree
This chapter describes the KX-21 menu tree and the corresponding chapters which explain
the usage of the menus.
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INTRODUCTION

2. OVERVIEW OF INSTRUMENT

The KX-21 performs speedy and accurate analysis of 18 parametersin blood and detects the
abnormal samples. To assure easy sorting of abnormal samplesin the laboratory, the
instrument displays abnormal analysis data with abnormal marks attached on the LCD
screen. Thus displayed analysis data allows detecting those samples which are outside the
tolerance and need further analysis and reconsideration.

The KX-21 employs three detector blocks and two kinds of reagents for blood analysis. The
WBC count is measured by the WBC detector block using the DC detection method. The
RBC count and platelets are taken by the RBC detector block, also using the DC detection
method. The HGB detector block measures the hemoglobin concentration using the non-
cyanide hemoglobin method.

P

Figure 1-2-1: Overview of KX-21
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INTRODUCTION

3. OPTION UNITS

Thisinstrument offers several option unitsto ensure its efficient operation. The options that
can be used with the KX-21 are:

o Serid interface:  Outputs analysis data and QC data to the host computer. Ordering
Information: OUTPUT UNIT NO. 1 KX-21 (Part No. 973-4531-1)

4. OUTLINE OF OPERATION

Two analysis modes are available with the KX -21: whole blood mode and pre-diluted mode.
Analysis procedures in these modes are listed below.

Whole blood mode ‘ Pre-diluted mode
Check before turning ON the power.
Turn ON the power.

* Self-check
» Background check
Select whole blood mode. Select pre-diluted mode.
Set sample No. Prepare analysis samples in pre-diluted mode

(1:26 dilution).
Set sample No.
Set sample to the sample probe.
Press the start switch.
« Execute analysis.

* End analysis.

Check after analysis.
Execute shutdown.
Turn off the power.

Table 1-4-1. Outline of Operation

» Thework by an operator is shown in shaded cells.
. : "Ready" isdisplayed on the LCD screen. In this state, various operations
including analysis, settings, and data processing can be performed.

5. AUTOMATIC STOP FUNCTION OF PNEUMATIC UNIT

The KX-21, when left non-operating for 15 minutes, automatically stops the pneumatic unit.
This function saves power consumption and extends component service life. In addition,
with this function, analysis-ready status can be resumed faster than by turning on the power.
It isalso possible to manually stop the pneumatic unit through the Select Menu screen.
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6. ANALYSIS PARAMETERS

Thisinstrument analyzes the following parameters using three detector blocks and two kinds

of reagents:

1)  Whole WBC (white blood cell) (Analysis principle: DC detection method)
WBC count in 1 pL of whole blood

2) LYM%[W-SCR] (WBC-Smdll Cdl Ratio)
Ratio (%) of lymphocytes (small cells) to whole WBC

3) MXD%[W-MCR] (WBC-Middle Cdl Ratio)
Ratio (%) of the summation of basophils, eosinophils and monocytes (middie cells) to
whole WBC

4)  NEUT% [W-LCR] (WBC-Large Cell Ratio)
Ratio (%) of neutrophils (large cells) to whole WBC

5  LYM#[W-SCC] (WBC-Small Cell Count)
Absolute count of lymphocytes (small cells) in 1 L of whole blood

6) MXD#[W-MCC] (WBC-Middle Cell Count)
Absolute count of the basophils, eosinophils and monocytes (middle cells) in 1 pL of
whole blood

7)  NEUT#[W-LCC] (WBC-Large Cell Count)
Absolute count of neutrophils (large cells) in 1 uL of whole blood

8) RBC (red blood cdll) (Analysis principle: DC detection method)
RBC count in 1 pL of whole blood

9) HGB (Hemoglobin) (Analysis principle: Non-Cyanide hemoglobin analysis method)
Volume (gram) of hemoglobinin 1 dL of whole blood

10) HCT (Hematocrit value) (Analysis principle: RBC pulse height detection method)
Ratio (%) of whole RBC volume in whole blood

11) MCV (Mean RBC volume)
Mean RBC volume (fL) in whole blood, which is calculated by Hct/RBC.

12) MCH (Mean RBC hemoglobin)
Mean hemoglobin volume (pg) per RBC, which is calculated by Hgb/RBC.

13) MCHC (Mean RBC hemoglobin concentration)
Mean hemoglobin concentration (g/dL ), which is calculated by Hgb/Hct.
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14) RDW-CV (RBC distribution width - CV)
RBC distribution width (%) calculated from the points defining 68.26% of the entire
area spreading from the peak of the RBC particle distribution curve.

15) RDW-SD (RBC distribution width - SD)
The distribution width (fL) at the height of 20% from the bottom when the peak RBC
particle distribution curve is taken as 100%.

16) PLT (Platelet) (Anaysis principle: DC detection method)
Platelet count in 1 uL of whole blood

17) PDW (Platelet distribution width)*
The distribution width (fL) at the height of 20% from the bottom with the peak of
platelet particle distribution curve taken as 100%.

18) MPV (Mean platelet volume)
Mean volume of platelet (fL)

19) P-LCR (Largeplatelet ratio) *
Ratio (%) of large platelet volume exceeding 12 fL to the platelet volume

NOTE: * When analyzing in the pre-diluted mode, only the CBC8 parameters
are output.
» The RBC distribution width is the switchover type between RDW-SD
and RDW-CV.

*  For Investigational Use Only in the United States of America.
Not areportable parameter.
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7. PANEL KEYBOARD
The KX-21 is provided with the 22-key panel keyboard.
|
G )E]) o=
SHECT— @)
(o)) ooe—@
=
~)
Figure 1-7-1: Panel Keyboard
Name Function
SAMPLE No. | Used to set a sample No. and QC File No.
ENTER Used to fix a sample No., selected menu, etc.
SELECT Used to select a menu. Press this key to display the Select Menu screen. When
you press it while the Select Menu screen is displayed, the Analysis screen returns.
MODE Used to changeover analysis mode (whole blood mode/pre-diluted mode).
HELP Used when an error has occurred.
SHUTDOWN | Used to execute shutdown program.
0-9 Used to enter numerics such as a sample No., QC File No., and set value.
-/ Used to enter "-" (hyphen) of a sample No., the decimal point of a set value.
C Used to delete characters when entering numerics, and stop the alarm.
AY Used to select a menu. Each time a key is pressed, the cursor moves to the
previous or the next item.
« > Used to select conditions when setting, and to select Manual Discriminator.
Table 1-7-1: Functions of Panel Keyboard
CAUTION: * When the alarm is sounding after an error, etc. occurred, press [C] key
to stop it or press [HELP] key to display the HELP screen. By
pressing [HELP] key, the alarm stops and the HELP screen appears.
While the alarm is sounding, the keys other than [C] key and [HELP]
key cannot be used.
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8. GRAPHIC SCREEN

8.1 Contents of Display

Next Sample
Next Sample No.  Analysis Mode Stﬁ Display Analysis Progress Status
Ready
. 00/ 00 00: 00
WBC 0. 0x10% puL LYM% ---.-%
RBC 0. 00x10%/ pL MXD% ---.-%
HEB 0. Og/ dL NEUT% ---.-%
HCT 0. 0% LYM# ---.-x10% pL
MoV ---.-fL VXD# - --. -x10% pL| | Analysis Result
MCH ---.-pPg NEUT# --- . -x10% pL Display Area
MCHC ---.-g/dL RDW ---.-fL
PLT 0x10%/ uL PDW ---.-fL
MPV ---.-fL
P-LCR ---.-%
1:MDiscri. 2:Print 3: Paper Feed | |Menu Display Area
Figure 1-8-1: GraphicLCD
Name Function
Next Sample No. Displays the sample No. to be analyzed next.
Next Sample Displays the analysis mode for the sample to be analyzed next.

Analysis Mode

WB: whole blood mode
PD: pre-diluted mode

Analysis Progress
Status

With the start-to-end analysis progress classified into six steps, the

present progress status is displayed.

Status Display

Status of the unit is displayed.

Menu Display Area

Useable menus for each screen are displayed.

Analysis Result
Display Area

The area for displaying analysis result

Table 1-8-1: Contents of Display
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8.2 Status Display M essages

The KX-21 displays instrument status message on the LCD screen.
This section gives the meanings of status messages displayed on the LCD screen.

Display Message Meaning

The instrument is making self-check. When
the power is turned ON, the instrument
checks itself automatically. When the power
is turned ON, [00-01] appears briefly in the
right lower corner, which indicates the version
of the unit control program.

Sysnmex KX-21

[ 00-01]

Pl ease wait.

The hydraulic system is undergoing Auto
*AUlo R nse* Rinse. When the power is turned ON, the
instrument starts self-check and motor check,
followed by auto rinse of the hydraulic
system. Auto rinse is also performed when
"5: Auto Rinse" in the Select menu is

Pl ease wait . executed and when [SHUTDOWN] key is
pressed. When an automatic background
check shows a background count exceeding
the permissible background count level, rinse
sequence is automatically extended.
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Display Message Meaning
The instrument is ready for analysis in the
No. 1 \”BRead'>'>'>'>'>'> whole blood mode. "No." in the left upper
No. O VB y y 00/ 00 00: 00 corner indicates the sample No. to be
VBC 0.0x10% L LYM — ---.-%
RBC 0.00x10% uL MXD% ~ ---.-% analyzed next.
HGB 0.0g/dL  NEUT% ---.-%
HCT 0. 0% LYMF  ---.-x10% pL
MV - -fL MKDE  ---. - x10% L
MCH ---.-pg NEUT#  ---.-x10% pL
MHC  ---.-g/dL RDW ---.-fL
PLT 0x10% uL PDW - -fL
MRV ----fL
P-LOR ---.-%
1:MDiscri. 2:Print 3: Paper Feed
L . ;\bill . | PD) l>l>l>l.>l.>l.>. . J The instrument is ready for pre-diluted mode
Read H " "
No. O PD y 00/ 00 00- 00 analysis. "No." in the left upper corner shows
VBC 0.0xI0% UL LYMo  ---.-% the sample No. to be analyzed next.
RBC 0.00x10% uL MXD% ~ ---.-%
HGB 0.0g/dL  NEUT% ---.-%
HCT 0. 0% LYM¢  ---. - x10% pL
MV —---fL MXD#  ---.-x10% pL
MCH ---.-pg NEUT#  ---.-x10% pL
MHC  ---.-g/dL RDW ---.-fL
PLT 0x10% pL PDW —--fL
MPV —_——
P-LOR ---.-%
1:MDscri. 2:Print 3: Paper _Feed
FILE No. 1 EEReaclj>l>l>l>l>'> The instrument is ready for X control. "FILE
Yy " :
%2 % Judgerent No. 1" in the left upper corner shows QC file
WBC No.
RBC
HGB
HCT
MV
MCH
MCHC
PLT
| FILE No. 1 s o> The instrument is ready for L-J control. "FILE
Ready No. 1" in the left upper corner shows QC file
ta Judgenent N
RBC
HGB
HCT
MV
MCH
MCHC
PLT
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Display Message

Meaning

*Change Mbdex

Pl ease wait.

The whole blood mode is turning into the pre-
diluted mode, or the pre-diluted mode is
turning into the whole blood mode.

No. 123457 W8 B->>>>0>
Aspirating

The sample is being aspirated in whole blood
mode analysis.

No. 123457 [y P>
BEBRENENE Aspirating HERRRNN

The sample is being aspirated in pre-diluted
mode analysis.

No. 123457 W8 B>
Anal yzi ng

Samples are being aspirated, diluted, and
counted in whole blood mode (or pre-diluted
mode).

No. 123457 V\B >
Ri nsi ng

Hydraulic line in the whole blood mode (or
pre-diluted mode) is being rinsed.

No. 123457 VB R JE KT Mo HEV=1q0
Not Ready

An error occurs, making analysis impossible.
(When an error occurs, the error message
appears in reversed display in the right upper
area of the LCD screen.)

No. 123457 VB [RVESKEI Nl
Not Ready

When operation has been suspended over
15 minutes, the compressor power is turned
OFF and this message is displayed. Press

the [START] switch to get ready for analysis.

Momentary power failure occurred.

When the power is turned off without making
shutdown process or when power outage
caused the instrument to stop, this message
appears when the unit is started next time.

WB S>> *
Ready

When data is automatically output to the host
computer, " * " mark lights up in the right
upper corner of the screen. This applies only
when an optional serial interface is
incorporated.

1-10
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10.

11.

8.3 LCD Brightness Adjustment

OO0 —o
Open the front cover of the instrument. LCD DOd 0
brightness can be adjusted using the brightness @
adj ustment knob under the panel keyboard. D%D — o
Turning to the right brightens the light and turning
to the left dimsit. m
o1
a———=I=

EMERGENCY STOP PROCEDURE

When there arises the need to stop the instrument urgently because of power outage, etc., in
the laboratory, turn off the instrument power switch.

ALARM SOUNDS

The KX-21 indicates different situations by five kinds of alarm sounds:

1. Key sound (single beep)
Sounds about 0.1 second when akey on the panel keyboard is pressed.

2. Input error sound (short beep)
Sounds about 1 second when awrong key is pressed on the panel keyboard.

3. Anaysiserror sound (long beep)
Sounds when an error occurs in the instrument and continues until you press [C] key
or [HELP] key on the panel keyboard.

4.  Sound at sample aspiration
Usualy: A single "beep" when the start switch is pressed; "beep, beep” when
aspiration is finished.
Sample No. "0" or in pre-diluted mode: Beep sounds (beep, beep, ...) continue from
pressing the start switch until aspiration ends.

CONTENTS OF PACKAGE

The instrument is fully inspected before leaving the factory and carefully packed to withstand
shocksintransit. Upon arrival, check the package to see that thereis no external damage.
Sysmex service representative will unpack, install the instrument, and make initial settings.
To confirm the contents of the package, refer to " Appendix A: Installation.”
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12. INSTALLATION ENVIRONMENT

12.1 Installation and Relocation

The KX-21 isinstalled by Sysmex Service representative. I1n case relocation becomes
necessary after installation, contact your Sysmex service representative.

Pay careful attention to this because if relocation, etc. of the instrument should be conducted
by the customer, resulting in any trouble, warranty would not be applied evenin the
warranty period.

12.2 Grounding

The instrument power supply cord uses the 3-prong plug. When the power supply socket is
3-prong with grounding, smply plug it to the socket.

117 VAC Spec. 220 VAC Spec. 240 VAC Spec.
Figure 1-12-1: Plugs

&WARNING » Make sure to ground the instrument. Inadequate grounding could cause
electrical shocks.

NOTE: » The number of power supply sockets required is one. “

1-12 Sysmex KX-21 Operator’s Manual -- Revised October 1998



INTRODUCTION

12.3 Installation Space

To ensure that the instrument fulfillsits function, it isimportant to install it at an appropriate

place:

» Choose aplacethat is close to the power supply and proper waterway.

 Secure a place spacious enough for maintenance and service. Giving consideration to
heat radiation by the instrument, provide at least 50 cm distance from the wall to side,
rear, and top panels.

» Choose aplace where reagent is easy to handle.

The instrument dimensions are shown below. The power supply cord is 1.8 m long, the
waste tube up to 6 m long, and the diluent (CELLPACK) tube up to 2 m long.

Width (mm) Depth (mm) Height (mm) Weight (kg)
Main Unit 420 355 480 28

|

480

/@
=

420

Y

:

Figure 1-12-2: Instrument Dimensions

CAUTION: * When the diluent (CELLPACK) tube is more than 2 m long, it may be
impossible to have reagent aspirated. Avoid setting CELLPACK at a
level higher than the instrument; otherwise, reagent may flow into the
vacuum line, possibly damaging the instrument.
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12.4 Installation Environment

Use theinstrument at an ambient temperature of 15°C - 30°C (optimum: 23°C).

Useit at arelative humidity range of 30% - 85%.

When air conditioning is used, the maximum cooling capacity of about 172 kcal/hour is
required to offset the heat from the instrument.

Avoid aplace that can become extremely hot or cold.

Avoid aplace that can be exposed to direct sunlight.

Choose awell-ventilated place.

Avoid aplace close to awirelesstelegraph or communication facility where high
frequency waves can be generated or radio interference can occur.

1-14
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13. INSTRUMENT SPECIFICATIONS

Analysis parameters:

WBC (White Bloodcell Count), RBC (Red Bloodcell Count), HGB (hemoglobin), HCT
(hematocrit), MCV (mean corpuscular volume), MCH (mean corpuscular hemoglobin),
MCHC (mean corpuscular hemoglobin concentration), PLT (platelet), RDW-SD (RBC
distribution width-standard deviation), RDW-CV (RBC distribution width-coefficient of
variation), PDW (platelet distribution width)*, MPV (mean platelet volume), P-LCR (platelet
large cell ratio)*, LY M% (W-SCR), MXD% (W-MCR), NEUT% (W-LCR), LY M# (W-
SCC), MXD# (W-MCC), NEUT# (W-LCC) (RDW-SD or RDW-CV: Switch over type)
However, the parameters in pre-diluted mode are eight: WBC, RBC, HGB, HCT, MCV,
MCH, MCHC, PLT.

*  For Investigational Use Only in the United States of America.
Not areportable parameter.

Display range

WBC 0.0-299.9 (><103/l,1L)
RBC  0.00 - 19.99 (x10°/uL)
HGB 0-25.0 (g/dL;
PLT  0-1999 (x10°/uL)

Reagent
Diluent: CELLPACK
WBC/HGB lysereagent: STROMATOLY SER-WH

Deter gent
CELLCLEAN

Consumption of reagent (per sample)
Diluent (CELLPACK): Approx. 30 mL
WBC/HGB lyse reagent (STROMATOLY SER-WH): Approx. 1.0 mL

Throughput
Approx. 60 samples/hour

Analysisprinciple

WBC: DC detection method

RBC: DC detection method

HGB: Non-cyanide hemoglobin analysis method
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Reproducibility
Reproducibility iswithin the following range at the reliability level of 95%.

1)  Whole blood mode
WBC (4.0 x 10%uL or over) 3.5% or less
RBC (4.00 x 10%/uL or over) 2.0% or less
HGB 1.5% or less
HCT 2.0% or less
MCV 2.0% or less
MCH 2.0% or less
MCHC 2.0% or less
PLT (100 x 10°/uL or over) 6.0% or less
LYM# (W-SCC) 15.0% or less
MXD# (W-MCC) (1.0 x 10%uL or over) 30.0% or less
NEUT# (W-LCC) 15.0% or less
LYM% (W-SCR) 15.0% or less
MXD% (W-MCR) (12% or over) 30.0% or less
NEUT% (W-LCR) 15.0% or less
RDW-SD or RDW-CV 4.0% or less
PDW 12.0% or less
MPV 5.0% or less
P-LCR 20.0% or less
2)  Pre-diluted mode
WBC (4.0 x 10%uL or over) 6.0% or less
RBC (4.00 x 10%/uL or over) 3.0% or less
HGB 2.5% or less
HCT 3.0% or less
MCV 3.0% or less
MCH 3.0% or less
MCHC 3.0% or less
PLT (100 x 10°/uL or over) 9.0% or less
Accuracy
1)  Whole blood mode
WBC: +3% or +0.2 x 103/4,1L or less
RBC: +2% or £0.03 x 10°/uL or less
PLT: +5% or 10 x 10%/uL or less
2)  Pre-diluted mode
WBC: +5% or +0.3 x 103/4,1L or less
RBC: +3% or £0.05 x 10°/uL or less
PLT: +8% or =15 x 10%/uL or less
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Linearity
1)  Wholeblood mode
WBC: 1.0-9.9(x 10%uL) +0.3 (x 10%/uL) or less
10.0 - 99.9 (x 10%uL) +3% or less
RBC:  0.30-0.99 (x 10%uL) +0.03 (x 10°/uL) or less
1.00 - 7.00 (x 10°%uL) +3% or less
HGB: 0.1-10.0(g/dL) +0.2 (g/dL) or less
10.0 - 25.0 (g/dL) +2% or less
HCT: 10.0 - 33.3 (HCT%) +1.0 (HCT%) or less
33.4-60.0 (HCT%) +3% or less
PLT: 10 - 199 (x 103/y +10 (x 10°/uL) or less
200 - 999 (x 10°/u +5% or less
(However, RBC < 7 00 x 10%puL)
Carryover

WBC: 3%orless
RBC: 1.5% or less
HGB: 1.5% or less
HCT: 1.5% or less
PLT: 5% or less

Blood volume aspirated
Whole blood mode: Approx. 50 pL
Pre-diluted mode:  Approx. 200 pL (Diluted blood sample)
Blood volume required for the pre-dilution is 20 UL or over.

Power supply
117/220/230/240 VAC £ 10% or less (50/60 Hz)

Power consumption
Approx. 230 VA or less

Heat Compensation Required
Approx. 785 BTU/h (198 kcal/h)

Dimensions
Main Unit: 420 (W) x 355 (D) % 480 (H) mm

Weight
Main Unit: Approx. 28.0 kg

Classification
According to the type of protection against el ectric shock: Class| Equipment
According to the degree of protection against electric shock: Type B Equipment
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14. MENU TREE

1: M. Discri. iChapter3,2.2

|Ana. Screen |
1 2: Print Chapter 3, 2.3,
— 3: Paper Feed Chapter 3, 2.4
| SELECT I__| 1: Stored Data! Chapter 3 I 1: Delete i Chapter 3, 3.3
—1 2:Print Chapter 3, 3.4
—| 3:HC Output Chapter 3, 3.5
— 2 Uy | Chapters | 1:QCAnalyze iChapter5,2
— 2: Settings Chapter 5, 2.5
— 3: Erase All Chapter 5, 2.4
—|3: Calibration {Chapter 6 |——| 1: Auto Cal. i Chapter 6, 2 | 1: HGB i Chapter 6, 2
2: HGB/HCT Chapter 6, 2
3: HCT Chapter 6, 2
—| 2: Manual Cal. Chapter 6, 3 |

& E\v/espelace iChapter 4, 8.1|

_| 5: Auto Rinse iChapter 4, 7.1|

—| 6: Settings iChapterlO I

1: System Setup

iChapter 10, 2

—12: Date/Time

Chapter 10, 3

—13: Patient Limit

Chapter 10, 4

—14: QC Settings

Chapter 10, 5

—15: Host Settings

Chapter 10, 6

—6: Printer Settings

Chapter 10, 7

—7: Print Set Values

Chapter 10, 8

—| 7: Maintenancei Chapter 4 |

1: Clean W. Chamber

iChapter 4,51

8: Periph. H
—| Settigqs i Chapter 10, 9|

_| 00: PU Sleep i Chapter 2, 8 |

| SAMPLE No. | Chapter 2, 4 |

[ mope

Chapter 2, 4 |

|HELP

ich

apter 7, 1 |

| SHUTDOWN | Chapter 2, 6 |

I:I : Applicable when the option is provided.

—12: Clean Transducer

Chapter 4, 5.2

—3: Reset SRV Counter:Chapter 4, 6.2

—14: Drain TD Chamber

Chapter 4, 7.3

—5: Status Display

Chapter 7, 4
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1. INTRODUCTION

This instrument works in two analysis modes: whole blood mode and pre-diluted mode.
This chapter describes the general operation procedures from instrument start-up to
shutdown, with the procedures in respective analysis modes.

1.1 Overview of Analysis Modes

® Whole blood mode
Thisis the mode of analyzing collected blood samplein the whole blood status. The tube
cap is opened and the sample is aspirated through the sample probe one after another.

® Pre-diluted mode
This modeis used in analyzing a minute amount of child's blood, for instance, collected
from the earlobe or fingertip. In this mode, blood sample diluted into 1:26 before
analysisisused. The sample aspiration procedure is the same as in the whole blood
mode.

NOTE: * In the pre-diluted mode, particle distribution curve and particle
distribution analysis data are not output, and the output is confined to
only the CBC8 parameter.
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1.2 Analysis Procedure Flow Chart

Shown below is the Flow Chart for the operation procedure with pages to refer to.

Inspection before Turning ON i )
(the Power } Page 2-3

Turning ON the Power and
CSeIf-Check P Page 2'5>

(Execution of Quality Control P Page 2-8)

U

Whole Blood Mode | | Pre-Diluted Mode
Analysis Analysis
P Page 29 P Page 2-16

( Display and Printing of P Page 2_24>

Analysis Result

CExecution of Shutdown P Page 2-26>

( Turning OFF the Power )

Table 2-1-1: Analysis Procedure Flow Chart
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2. START-UP PROCEDURE

2.1 Inspection before Turning ON the Power

1. Inspection of reagents

Check to see that the reagents needed for the number of the samples to be processed
for the day are available. If the number available is such as might become short during
the day, make ready the reagents for use in replenishment. When reagents run out
during analysis, the instrument will automatically cometo astop. Replenish the
reagent that gave an error. Until replenishment is completed, analysis cannot be
resumed. The number of samplesthat can be analyzed with one pack of reagent is

listed below:

* Number of the samplesthat can be analyzed with one pack of reagent
CELLPACK: Approx. 600 samples/20 L (cubitainer)
STROMATOLY SER-WH: Approx. 470 samples/500 mL (bottle)
(The above values are the result of continuous analyses performed in one day in the
whole blood mode. Depending on the use conditions of the instrument, the result

may differ.)
® Replenishing reagent

» Makeready anew reagent and make sure that it has not passed its expiration
date. (For detail, refer to Chapter 4, Section 8: SUPPLIES REPLACEMENT.)

more than 24 hours.
occur.

before starting sample analysis.

adhere to the cubitainer spout Kit.

which could impair proper analysis.

&CAUTION » Use a reagent that has been left at room temperature (15 - 30°C) for
« If CELLPACK that has just arrived is used, "Background Error" may
* After replenishing a reagent, make sure that its background count is low
* As to a reagent that may have frozen, handle it in accordance with the
precautions stated on the Package Insert. Otherwise, there is a
possibility that proper analysis cannot be performed.
» When replacing the reagent container, take care not to have dust

» After unpacking, take care to prevent entry of dust, dirt, bacteria, etc.

CELLPACK 20L

60 days

STROMATOLYSER-WH 500 mL

90 days

Table 2-2-1: Expiration After Opening the Seal

Sysmex KX-21 Operator’s Manual -- Revised October 1998

2-3



SAMPLE ANALYSIS

»  Werecommend preparing "Reagent Replenishment Record" in which to enter date
of replenishment, name of reagent, reagent lot No., expiration date, name of person
who replenished. Such record would come handy.

2. Inspection of the instrument
Inspect the connection of tubings and cords to see that there are no broken tubes and
the power cord is properly plugged in the outlet.

3. Inspection of waste
If waste isfound to have collected in the trap chamber on the | eft side of the unit and
the waste tank (when provided), discard the waste.

4. Inspection of printer paper
Open the front cover and check if printer paper needed for processing the samples for
the day isavailable.

Figure 2-2-1: Inspection of Printer Paper

CAUTION: » Use the printer paper specified by Sysmex. Avoid using print paper
that has its end fixed to the core. Such paper can cause failure.
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2.2 Turning ON the Power and Self-Check

Turn ON the power switch on the right side of the unit. Self-check, auto rinse, and
background check will be automatically performed, and the "Ready” (ready for analysis) will

appear.

1.  Turn ON the power switch

(1) Theinitia display appears on the LCD screen. The program version (Example: [00-

01]) appears at the right lower area of the screen.

Sysmex KX-21

[ 00- 01]

Figure 2-2-2: Initial Display

(2) Next, the instrument makes self-check of motor operation, scheduled maintenance
items, etc. The LCD screen displays "Please wait." during this period.

Pl ease wai t.

Figure 2-2-3. LCD Screen during Self-check
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CAUTION:

* When self-check reveals any error, an error message will appear on the
LCD screen. In this case, turn OFF the power once, then turn it ON
again. If the error still occurs, contact Sysmex service representative.

 To ensure optimum operation of the instrument, service counters are
provided for the components which require scheduled maintenance. If
upon the power turn-on, the counter is found exceeding the
predetermined times, the screen advising scheduled maintenance is
displayed. When the Scheduled Maintenance screen appears, press
[C] key to stop the alarm sound, then perform maintenance operation
by following the instructions on the screen.

For detail, refer to Chapter 4: INSTRUMENT MAINTENANCE AND
SUPPLIES REPLACEMENT.

(3) When salf-check is normally completed, auto rinse and background check are

performed.
*Auto R nse*
Pl ease wait.
Figure 2-2-4: LCD Screen during Auto Rinse
NOTE: * Auto rinse is repeated 3 - 5 times. If the background count of any

parameter exceeds tolerance after rinsing a maximum of 5 times, the
message "Background Error" is displayed and the alarm sounds. In this
case, press [HELP] key to stop the alarm and display the Action
Message screen. In accordance with the Action Message screen, take
an appropriate action.

(Refer to Chapter 7: TROUBLESHOOTING.)

Permissible background counts

WBC | 0.3[x10%uL] or less

RBC 0.02 [x10°%uL] or less

HGB 0.1[g/dL] or less

PLT 10 [x10*/uL] or less

2-6
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SAMPLE ANALYSIS

2. Confirming the" Ready"
When auto rinse and background check are normally completed, the buzzer (single
beep) sounds briefly and "Ready"” is displayed. The LCD screen displays the result of
background check (sample No. "0").

No. 1 B >
h Ready ﬁ

No. O VB 00/ 00 00: 00
VBC 0. Ox10% uL LYM% ---.-%
RBC 0. 00x10%/ L. MXD% ---.-%
H&B 0.0g/dL  NEUT% ---.-%
HCT 0. 0% LYM# ---.-x10% L
MoV ---.-fL VXD# ---.-x10% L
MCH ---.-pg NEUT#  ---.-x10% pL
MCHC ---.-g/dL RDW ---.-fL
PLT 0x10%/ uL PDW ---.-fL
MPV ---.-fL
P-LCR ---.-%
1: MDscri. 2:Print 3: Paper Feed

Figure 2-2-5: Ready Status

NOTE: * When the power is on, the next sample No. is displayed "1." “
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QUALITY CONTROL

Quiality control is of great importance for obtaining highly reliable data over along period of
time, asis the constant monitoring of the instrument for preventing troubles or for early
detection of problems. Before starting sample analysis, analyze control blood
(EIGHTCHECK-3WP) using x control or L-J control program. The analysis mode used in
analyzing control blood is described below.

® Anaysis modeto analyze a control blood
Control blood is analyzed in the QC analysis mode. For analysis procedure and
examination of analysis result, refer to Chapter 5: QUALITY CONTROL.
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4. PROCEDURES IN EACH ANALYSIS MODE

With thisinstrument, sample mixing, cap removal, and tube setting are performed manualy.
Sample analysis can be executed when the instrument is in the Ready status.

4.1 Whole Blood (WB) Mode

Samples are processed in the following steps:

1. Collecting and preparing samples

2.  Selecting whole blood mode

3.  Inputting sample No.

4.  Anayzing samples

1. Collecting and preparing samples

A specified amount of sample, corresponding to the amount of EDTA anticoagulant, is
collected from the vein.

&CAUTION » Some anticoagulants alter test results due to their effects on RBC
hemolysis or platelet agglutination. As anticoagulant, use EDTA-2K,

EDTA-3K, or EDTA-2Na.

* In the case of refrigerated blood, leave the blood taken from the
refrigerator for 30 minutes until it equilibrated to room temperature.

* When the reagent might have frozen, handle it according to the
precautions stated on the Package Insert of each reagent. Otherwise,
improper analysis may result.

Tubes up to 80 mm in height should be used. The volume of sample that can be
aspirated isasfollows:

| Volume of sample aspirated | Approx. 50 uL |
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2. Selecting whole blood mode
When "PD" isindicated in the system status area on the LCD screen, the pre-diluted
(PD) modeisin use for analysis, so change it over to the whole blood (WB) mode by
the following procedure:

(1) Confirm the Ready status.
(2) Press[MODE] key to display the Change Mode screen.

*Change Mode*

Whol e Bl ood( VB) Pre-Di | ut ed( PD

Change node with [<Jor[}]. Press [ENTER to Set.

Figure 2-4-1: Change M ode Screen
(3) Press[ <] or [™] key to select "Whole Blood (WB)."

*Change Mdex

Wiol e Bl ood(WB Pre-Di | ut ed( PD)

Change node with [<Jor[[]. Press [ENTER to Set.

Figure 2-4-2: Selecting WB Mode

(4) Press[ENTER] key to changeover the analysis mode and return to the Analysis
screen.

NOTE: » The analysis mode selected here is maintained after completion of
analysis, until it is switched to the other analysis mode.
* At the time of turning-on the power, the system is in the whole blood
mode.
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3. Inputting sample No.

° Input from the panel keyboard

(1) Press[SAMPLE No.] key in the Ready status. In the system status area on the LCD
screen, the next sample No. turns to the reverse display and the system is waiting for
Sample No. input (in the "Not Ready" status).

o M Ve oo
- Not ReRady ————
No. O B 00/ 00 00: 00
WBC 0. Ox10% uL LYM% ---.-%
RBC 0. 00x10%/ L. MXD% ---.-%
HEB 0.0g/dL  NEUT% ---.-%
HCT 0. 0% LYMt ---.-x10% L
MoV ---.-fL VXD# ---.-x10% L
MCH ---.-pg NEUT#  ---.-x10% pL
MCHC ---.-g/dL RDW ---.-fL
PLT 0x10% puL PDW ---.-fL
MPV ---.-fL
P-LCR ---.-%
1:MDscri. 2:Print 3: Paper Feed

Figure 2-4-3: Inputting Sample No.
(2) Thecursor appears under sample No. Input sample No. using the numeric keys.

[Example€] Input of sample No. 5
Press [5] key on the numeric keys.

CAUTION: » Sample No. "0" (zero) is treated as a special sample number.
1) Judgement on patient limit is not made for analysis data.
2) Analysis data is not stored.
3) Data is not transferred to the host computer.
4) Sample No. is not incremented.
5) Judgment on abnormal histogram is not made.
6) When one attempts to make analysis with the sample No. of "0"
(zero), the buzzer sounds during sample aspiration.
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NOTE: » When entering the sample No. (on the screen of the previous page),
press [C] key first. This will clear the entire sample No. Then, enter a
new sample No.

* In the course of entering the sample No., each time you press [C] key,
one character disappears with the cursor moving to the left.
» A sample No. of a maximum of six digits, comprising numerics and a
hyphen, can be used.
» The hyphen cannot be used at the first or last digit of a number, and
two or more hyphens cannot be entered in succession.
[Example] NG -123
NG 123-
NG 1--23
* Any number beginning with "0" (zero) cannot be entered.
[Example] NG 0123

(3) Press[ENTER] key. Thiswill fix the sample No. and the status becomes Ready,
namely, ready for analysis.

NOTE: » When all sample Nos. are cleared, [ENTER] key is not accepted.
When you attempt to do so, an alarm sounds.
* In the status of waiting for sample No. input ("Not Ready"), press
[SAMPLE No.] or [SELECT] key. The screen returns to the Analysis
screen without updating sample No.

2-12
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4.  Analyzing samples

« When anayzing samples, always wear rubber gloves. After
/IN\WARNING  completion of work, wash hands with disinfectant. If your hands are
contaminated by blood, etc., infection of bacteria can occur.

(1) Mixthe sample sufficiently.

Figure 2-4-4: Mixing the Sample
(2) Removethe plug while taking care not to allow blood scatter.

2,
\\ /

Figure 2-4-5: Removing the Plug
(3) Set thetubeto the sample probe, and in that condition, press the start switch.

Start Switch

Figure 2-4-6: Pressing the Start Switch
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(4) Thebuzzer sounds two times - "beep, beep” - and when the LCD screen displays
"Analyzing," remove thetube. After that, the unit executes automatic analysis and
displaysthe result on the LCD screen. Then the unit turns to the Ready status,
becoming ready for analysis of the next samples.

The screens from the start to the end of analysis are as shown in the following:

(Ready)
No. 123457 WB D>
Ready
(Aspirating)
No. 123457 WB D>
Aspirating
(Analyzing)
No. 123457 W8 BP0
Anal yzi ng
(Rinsing)
No. 123457 \B =B
Ri nsi ng
(Ready)

No. 123458 VB >>>>>>
Ready

Figure 2-4-7: LCD Screen (in WB M ode)

» While the LCD screen is displaying "Aspirating," keep holding the tube
&CAU-“ON in the aforementioned status. If the tube is removed during its display,
correct analysis result may not be obtained.

CAUTION: * Several seconds after the buzzer sounds "beep, beep" and
"Aspirating" appears on the LCD screen, the rinse cup lowers. By that
time, remove the tube.

» To remove the tube, lower it straight down. Take care not to bend the
sample probe.

NOTE: » The sample probe is automatically rinsed, so there is no need to wipe it
clean.
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(5 Whenthe LCD screen displays "Ready," prepare the next samples and repeat the

procedure (1) to (4).

"0" (zero) is not incremented.

[Example] 123 - 124
999999 - 1
12-3 - 12-4
12-999 - 12-000

NOTE: » Sample No., if not changed, is automatically incremented by 1, although

Sysmex KX-21 Operator’s Manual -- Revised October 1998

2-15
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4.2 Pre-Diluted (PD) Mode

In thismode, asampleisdiluted into 1:26 before analysis. Thismodeis applied in analyzing
acapillary blood collected from the earlobe or fingertip. Samples are processed by the
following steps:

Collecting and preparing samples

Preparing analysis samplesin PD mode (dilution of 1:26)
Selecting Pre-Diluted mode

Inputting sample No.

Anayzing samples

GhownhE

1.  Collecting and preparing samples
Dilute samplesto theratio of 1:26 using CELLPACK dispensed beforehand in
containers.
[Example]

20 L of blood isdiluted in 500 pL of CELLPACK.

&CAUTION * A capillary blood collected from the earlobe or fingertip is prone to
platelet agglutination, so dilute and analyze it within 30 minutes.
Otherwise, correct analysis result may not be obtained.

» With a sample of blood collected from the earlobe or fingertip, blood cell
count is generally higher than normal, with lower reproducibility. If
possible, analyze the same diluted sample twice and compare the
results. When the blood collection tube containing a commercial anti-
coagulant is used, there is a possibility that RBC hemolysis or platelet
agglutination occurs depending on the types of anticoagulant, with a
consequent change in analysis result. As anti-coagulant, use EDTA-
2K, EDTA-3K, or EDTA-2Na.

Tubes up to 80 mm in height should be used. The volume of sampleisasfollows:

Volume of whole blood required Approx. 20 UL or more
Volume of sample aspirated Approx. 200 uL
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2.

D)

(2)
3)
(4)
(5)

Preparing analysis samplesin PD mode (1:26 Dilution)

Clean acontainer such as erlenmeyer flask, beaker, etc. with CELLPACK and remove
any dirt.

Using asyringe, etc., take CELLPACK into a cleaned container.
Using a500 pL transfer pipette, dispense 500 pL of CELLPACK into a micro-tube.
Using a capillary tube, etc., collect 20 puL of blood and dispense it into the micro-tube.

Attach the cap and mix well.

C WARNING gloves. After completion of work, wash hands with disinfectant. If

* When preparing PD-mode analysis samples, always wear rubber

your hands are contaminated by blood, etc., infection of bacteria or
the like can occur.

/_\ CAUTION * A 1:26 dilution sample is prone to platelet agglutination. So, analyze

the sample within 30minntes after blood dispensing and diluting. If
diluent is dispensed in advance, evaporation and dirt mixing will result
in errors in analysis values. Therefore prepare one sample at a time.

When preparing a 1:26 dilution sample, use the tools listed below:

Diluent (CELLPACK)

Micro-tube (MT-40, etc.)

Capillary tube

A 500 pL transfer pipette

A container, such as erlenmeyer flask or beaker
A syringe

Sysmex KX-21 Operator’s Manual -- Revised October 1998 2-17



SAMPLE ANALYSIS

3. Sdlecting Pre-Diluted mode
When "WB" is displayed in the system status area on the LCD screen, the whole blood
(WB) modeisin usefor analysis, so change it over to the pre-diluted (PD) mode by
the following procedure:

(1) Confirm the Ready status.
(2) Press[MODE] key to display the Change Mode screen.

*Change Mode*

Wiol e Bl ood( VB Pre-D | ut ed( PD)

Change mode with [<Jor[]. Press [ENTER to Set.

Figure 2-4-8: Change M ode Screen
(3) Press[ <« or [P] key to select "Pre-Diluted (PD)."

*Change Mode*

Wol e Bl ood( VB) Pre-D | ut ed( PD

Change mode with [<Jor[D]. Press [ENTER to Set.

Figure 2-4-9: Selecting PD Mode

(4) Press[ENTER] key to changeover the analysis mode and return to the Analysis
screen.

NOTE: » The analysis mode selected here is maintained after completion of
analysis, until it is switched to the other analysis mode.
* At the time of turning-on the power, the system is in the whole blood
mode.
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4.  Inputting sample No.

° Input from the panel keyboard

(1) Press[SAMPLE No.] key in the Ready status. The next Sample No. in the system
status area on the LCD screen turnsto the reverse display and the system waits for
Sample No. input (in the "Not Ready" status).

o MY oo
————————  Not Ready —————
No. O PD 00/ 00 00: 00
WBC 0. 0x10% yL LYM»o ---.-%
RBC 0. 00x10% pL MXD% ---.-%
H&EB 0. Og/ dL NEUT% ---.-%
HCT 0. 0% LYM¢ ---. - x10% uL
MV ---.-fL MXD# ---.-x10° pL
MCH ---.-pg NEUT#  ---.-x10% uL
MCHC ---.-g/dL RDW ---.-fL
PLT 0x10% yL PDW ---.-fL

MPV ---.-fL
P-LCR ---.-%
1:MDscri. 2:Print 3: Paper Feed

Figure 2-4-10: Inputting Sample No.
(2) The cursor appears under sample No. Input sample No. using the numeric keys.

[Example] Input of Sample No. 5
Press [5] key on the numeric keys.

CAUTION: » Sample No. "0" (zero) is treated as a special sample number.
1) Judgement on patient limit is not made for analysis data.
2) Analysis data is not stored.
3) Data is not transferred to the host computer.
4) Sample No. is not incremented.
5) Judgment on abnormal histogram is not made.
6) When one attempts to make analysis with the sample No. of "0"
(zero), the buzzer sounds during sample aspiration.
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NOTE:

» When entering the sample No. (on the screen of the previous page),
press [C] key first. This will clear the entire sample No. Then, enter a
new sample No.

* In the course of entering the sample No., each time you press [C] key,
one character disappears with the cursor moving to the left.

» A sample No. of a maximum of six digits, comprising numerics and a
hyphen, can be used.

» The hyphen cannot be used at the first or last digit of a number, and
two or more hyphens cannot be entered in succession.

[Example] NG -123
NG 123-
NG 1--23

* Any number beginning with "0" (zero) cannot be entered.

[Example] NG 0123

(3 Press[ENTER] key. Thiswill fix the sample No. and the status becomes Readly,
namely, ready for analysis.

NOTE:

» When all sample Nos. are cleared, [ENTER] key is not accepted.
When you attempt to do so, an alarm sounds.

* In the status of waiting for sample No. input ("Not Ready"), press
[SAMPLE No.] or [SELECT] key. The screen returns to the Analysis
screen without updating sample No.

2-20
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5. Analyzing samples

« When analyzing samples, always wear rubber gloves, and after
&WARMNG completion of work, wash hands with disinfectant. If your hands are
contaminated by blood, etc., infection of bacteria can occur.

(1) Mix the sample sufficiently.

Figure 2-4-11: Mixing the Sample

(2) Removethe plug while taking care not to allow blood scatter.

Figure 2-4-12: Removing the Plug
(3) Set the micro-tube to the sample probe, and in that condition, press the start switch.

Start Switch

Figure 2-4-13: Pressing the Start Switch
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(4) Thebuzzer sounds two times - "beep, beep” - and when the LCD screen displays
"Anayzing," remove the micro-tube. After that, the unit executes automatic analysis
and displays the result on the LCD screen. Then the unit turns to the Ready status,
becoming ready for analysis of the next samples.

The screens from the start to the end of analysis are as shown in the following:

(Ready)
No. 123457 @ S>>
(A RRER Ready ERRNNN
(Aspirating)
No. 123457 [ >
Lllllll Aspirating HEREENNE
(Analyzing)
No. 123457 [x8 b0
Anal yzi ng
(Rinsing)
No. 123457 [x8] »-m-bbb
R nsi ng
(Ready)

No. 123458 [} >
(A RRER Ready ERRNNN

Figure 2-4-14: LCD Screen (in PD Mode)

» While the LCD screen is displaying "Aspirating," keep holding the
&CAUT'ON micro-tube in the aforementioned status. If the micro-tube is removed
during its display, correct analysis result may not be obtained.

CAUTION:  Several seconds after the buzzer sounds "beep, beep" and
"Aspirating" appears on the LCD screen, the rinse cup lowers. By that
time, remove the micro-tube.

» To remove the micro-tube, lower it straight down. Take care not to
bend the sample probe.

NOTE: » The sample probe is automatically rinsed, so there is no need to wipe it
clean.
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(5 Whenthe LCD screen displays"Ready," prepare a next sample and repeat the

procedure (1) to (4).

"0" (zero) is not incremented.

[Example] 123 - 124
999999 - 1
12-3 - 12-4
12-999 - 12-000

NOTE: » Sample No., if not changed, is automatically incremented by 1, although
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5. DISPLAY AND PRINTING OF ANALYSIS RESULT

5.1 Display of Analysis Result

The result of each analysisis displayed on the LCD screen.
The display screen of analysis result consists of three pages, and pages are turned over by

using [ <] or [»] key.

No. 123458 VB >D>>D>>>

Ready
No. 123457 \WB 31/12 23:59
WBC 7. 1x10% pL LYMA 31. 2%
RBC 3. 97x10°/ uL. MXD% 19. 6%
HEB 14.7g/dL  NEUT% 49. 2%
HCT 32.8% LYME 2. 2x10°% pL
MV - 82.6fL VKD# 1. 4x10% pL
MCH 37.0pg NEUT# 3. 5x10°%/ pL
MCHC  + 44.8g/dL  RDW - 25.6fL
PLT 180x10%/ yL PDWV - 7.9fL
MRV 9.3fL
P-LCR - 9.5%
1:MDiscri. 2:Print 3: Paper Feed
No. 123458 WB D>E>D>>>>
Ready
No. 123457 WB 31/ 12 23:59
LYMA 31. 2%
WBC MXD% 19. 6%
NEUT% 49. 2%
LYMt 2. 2x10% pL
RBC MXD# 1. 4x10°%/ pL
NEUT# 3. 5x10% pL
‘ RDW - 25.6fL
PLT /\/ PDV - 7.9fL
: MPV 9.3fL
P-LCR - 9.5%
1:MDiscri. 2:Print 3: Paper Feed
No. 123458 WB >
Ready
No. 123457 WB 31/12 23:59
WBC 7. 1x10°% pL
RBC 3. 97x10° pL
HGB 14. 7g/ dL
HCT 32. 8%
MoV - 82.6fL
MCH 37.0pg
MCHC  + 44.8g/dL
PLT 180x10% pL
1:MDiscri. 2:Print 3: Paper Feed

(Whole Blood Mode)
Figure 2-5-1: Analysis Result Display Screen

No. 123459 PD S>>
Ready
No. 123458 PD 31/12 23:59
WBC 7. 1x10% pL LYMA ---.-%
RBC 3. 97x10°/ uL. MXD% ---.-%
HEB 14.7g/dL NEUT% ---.-%
HCT 32.8% LYMF  ---.-x10% L
MV - 82.6fL MXDH# ---.-x10% pL
MCH 37. Opg NEUT#  ---.-x10% pL
MCHC  + 44.8g/dL ROW ---.-fL
PLT 180x10°%/ yL PDW ---.-fL
MPV -
P-LCR ---.-%
1:MDiscri. 2:Print 3: Paper Feed
No. 123459 PD D>
ad
No. 123458 PD Y 31/12 23:59
LYM/o ---.-%
VBC MXD% ---.-%
NEUT% ---.-%
LYMt ---. - x10% pL
RBC MXD# ---. - x10% pL
NEUT#  ---.-x10% uL
RDW ---.-fL
PLT PDW ---.-fL
MPV ---.-fL
P-LCR ---.-%
1:MDscri. 2:Print 3: Paper Feed
No. 123459 PD S>>
Ready
No. 123458 PD 31/12 23:59
WBC 7. 1x10°% pL
RBC 3. 97x10° pL
HEB 14. 7g/ dL
HCT 32. 8%
MV - 82.6fL
MCH 37.0pg
MCHC  + 44.8g/dL
PLT 180x10% L
1:MDiscri. 2:Print 3: Paper Feed

(Pre-diluted Mode)
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5.2 Printing of Analysis Result

Analysisresult can be printed out on the built-in printer.

NOTE: * One print format can be selected from among Types 1, 2, and 3. For
the selecting procedure, refer to Chapter 10, Section 7: Printer Output
Setting.

[Type 1] [Type 2] [Type 3]

. 123457 Tl\b 123457 NO. 123457
Date 31/12/97 10: 02 Date 31/12/97 10:02 Date 31/12/97 10: 02
Mode VB Mode WB Mode VB
WBC 7.3 x10% pL WBC 7.3 x10% pL \VBC 7.3 x10% pL
RBC 4.52 x10° pL RBC 4.52 x10° pL RBC 4.52 x10° pL
HE®B 14.8 g/ dL HGB 14.8 g/ dL HEB 14.8 g/ dL
HCT 36.2 % HCT 36.2 % HCT 36.2 %
MoV 80.1 fL MoV 80.1 fL MoV 80.1 fL
MCH 32.7 Pg MCH 32.7 Pg MCH 32.7 Pg
MCHC 40.9 g/dL MCOHC 40.9 g/dL MCHC 40.9 g/dL
PLT 206 x10% pL PLT 206 x10% U PLT 206 x10% pL

VBC LYM/b 27.2 %
MXD% 13.4 %
NEUT% 59.4 %
LYM# 2.0 x10¥ pU
[fL MXDH# 1.0 x10% py
NEUT# 4.3 x10% pU
LYMAo 27.2 % RDW 98.3 fL
MXD% 13.4 % PDW 8.3 fL
NEUT% 59.4 % MPV 9.1 fL
LYMt 2.0 x10% pL P-LCR 14.8 %
MXDH# 1.0 x10% pL.
NEUT# 4.3 x10%/ pL
RBC
[fu)
RDW 98.3 fL
PLT
[fu]
PDW 8.3 fL
MPV 9.1 fL
P-LCR 14.8 %

Figure 2-5-2: Printing of Analysis Result
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6. LIMITATIONS

6.1 Cell Count Parameters

Some abnormal samples may give incorrect results by automated cell counting methods. The
following table shows examples of specific specimens that could cause errors.

Parameter Specimen Error Possible Indication of Error
WBC Cold Agglutinin +) tMCV, | HCT, red cell clumping on smear
Platelet aggregation +) Platelet aggregates on smear

Erythroblastosis +) Erythroblasts on smear
Nucleated RBC +) NRBC on smear
Cryoglobulins (+)
RBC Cold Agglutinin () tMCV, | HCT, red cell clumping on smear
Severe Microcytosis O]
Fragmented RBC O]
Leukocytosis +) Elevation of WBC
(>100,000/pL)
HGB Leukocytosis +) Elevation of WBC
(>100,000/pL)
Lipemia )] Tt MCHC, “milky” appearance of plasma
Abnormal Protein )] tMCHC, Lysed Hgb/WBC sample turns
cloudy
HCT Cold Agglutinin O] tMCV, L HCT, red cell clumping on smear
Leukocytosis +) Elevation of WBC
(>100,000/pL)
Abnormal Red Cell Fragility ?
Spherocytosis (?) L MCV, spherocytes on smear
PLT Pseudothrombocytopenia O] Platelet Satellitism on smear
Platelet Aggregation O] Platelet Aggregation on smear
Increased Microcytosis +) |MCV
Megalocytic Platelets ()

(+):  Instrument count is affected by an increase in the result.

(-):  Instrument count is affected by a decrease in the resullt.

(?):  Instrument count is affected by either an increase or decrease in the result which is
sample dependent.

CAUTION: » WBC results may be elevated erroneously due to unlysed red cells in
patients with hemoglobinopathies, severe liver disease or in neonates.
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6.2 Limitation of Hemoglobin

1.

Hemoglobin measurements may be falsely elevated due to the influences of abnormal
samplesincluding leukocytosis above 100,000/uL, lipemiaor abnormal proteinsin
blood plasma. The affect of lipemiaand abnormal proteins may be removed by plasma
replacement or plasma blank procedures.

Performance specifications for hemoglobin results are assured only when instrument
environment and sample requirements are observed.

The hemoglobin method available for this analyzer cannot detect sulfhemoglobin,
verdohemoglobin choleglobin or other unusual degradation products of hemoglobin.
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7. EXPECTED RESULTS

Reference intervals (normal population reference ranges) were devel oped for the KX-21 using
normal individuals. Therangesfor each parameter --- WBC, RBC, Hemoglobin, Hematocrit,
MCV, MCH, MCHC, RDW-CV, RDW-SD, Platelet, PDW*, MPV, P-LCR*, Lym% and #,
Mxd% and #, and Neut% and # were determined and displayed in Table 1-16-1.

*  For Investigational Use Only in the United States of America.

Not areportable parameter.
Parameter Range for Range for Males
Females n=117 n=124
WBC 3.1-10.3 2.6-8.8
RBC 3.2-4.6 3.6-5.3
Hgb 9.9 -13.6 11.3 - 15.7
Hct 30.2 - 42.3 32.6 - 47.5
MCV 78.6 - 102.2 80.3 - 103.4
MCH 25.2 - 34.7 26 - 34.4
MCHC 31.3-354 31.8 - 36.3
Plt 128 - 434 134 - 377
Lym% 15-45.8 17.5 - 47.9
Mxd% 1.3-25.9 1.9-24.6
Neut% 43.7 - 77.1 38.3-69
Lym# 09-238 0.8-2.7
Mxd# 0.1-1.6 0.1-15
Neut# 1.6-6.9 1.2-53
RDW-CV 10.6 - 15.7 10.8 - 14.9
RDW-SD 35.3 - 48.9 33.4-49.2
PDW 9.4-18.1 9.8 -18.0
MPV 85-12.4 8.1-124
P-LCR 14.3-44 10.7 - 45.0

Table 2-7-1: Normal Population Refer ence Ranges

NOTE:

» The age range for females was 17 - 66 years with a mean age of 33.4.
» The age range for males was 17 - 72 years with a mean age of 42.2.

Sysmex recommends that each laboratory establish its own expected reference intervals
based upon the laboratory’ s patient population encountered during daily operation. Expected
reference intervals may vary dueto differencesin sex, age, diet, fluid intake, geographic
location, etc. The NCCLS Document C28A1, “How to Define and Determine Reference
Intervalsin the Clinical Laboratory; Approved Guideling”. This document contains
guidelines for determining reference values and intervals for quantitative clinical |aboratory

test.

1NCCLS, 771 East Lancaster Avenue, Villanova, PA 19085, USA.
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8. STOPPING THE PNEUMATIC UNIT

The KX-21, when left non-operating for 15 minutes, automatically stops the pneumatic unit.
It isalso possible to manually stop the pneumatic unit using the following procedures:

(1) Press[SELECT] key inthe Ready status. The Select Menu screen appears.
(2) Using [A] key or [ ¥] key, move the cursor to select "00: PU Sleep."”
* SELECT*

:Stored Data
:Quality Control
:Calibration

. Repl ace Lyse
Auto R nse

: Settings

: Mai nt enance
:Periph. Settings

00: PU S eep

CO~NOUIRAWNPEF

Figure 2-8-1: Select Menu Screen
(3 Press[ENTER] key. This stops the pneumatic unit.

NOTE: * Press the start switch to return to the ready status. “
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9. EXECUTION OF SHUTDOWN

When analyses of al samples are finished, execute shutdown before turning the power off.
By executing shutdown, the TD chamber and diluted sample line are cleaned. Execute
shutdown after the day's work is finished, and also when this instrument is used
continuously, shut it down at least once in 24 hours.

CAUTION: « If the power is turned OFF before executing shutdown, failures could
occur, such as fluid dripping from the rinse cup and crystals forming
around the rinse cup.

9.1 Shutdown Procedure
(1) Press[SHUTDOWN] key in the Ready status. The Shutdown screen appears.

| * Shut down* > |
Ready

Aspirate CELLCLEAN
It will take approx. 5 m nutes.

3: Cancel

Figure 2-9-1: Shutdown Screen

NOTE: * When [3] key is pressed, shutdown is canceled and the Analysis
screen returns.
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(2) When executing shutdown, set CELLCLEAN to the sample probe and press the start
switch in that status. While "Aspirating" is being displayed on the screen, keep
holding CELLCLEAN in the same status.

Start Switch

T
r’\

Figure 2-9-2: Pressing the Start Switch

» Because CELLCLEAN is a strong alkaline detergent, take care not to
&WARMNG have it adhere to the skin or clothes. If the skin or clothes should
come in touch with it, flush it away using plenty of water. Otherwise,
it can damage the skin or clothes.

NOTE: » Once shutdown is executed, it cannot be canceled until it is completed.

(3 When the buzzer sounds two times - beep, beep- , informing the completion of
aspiration, remove CELLCLEAN from the sample probe.
After that, shutdown is executed automatically.

* Shut down* > > >
— R nsi ng

Pl ease wait.

Figure 2-9-3: Shutdown Execution Screen

CAUTION: » To remove CELLCLEAN, lower it straight down. Take care not to bend
the sample probe.
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(4) When shutdown isfinished and the following message is displayed, turn off the power
switch on the right side of the unit.

* Shut down* bbb b

Shut - down sequence was conpl et ed.
Turn CFF the power.

Figure 2-9-4: Shutdown Completion M essage Screen

NOTE: » Shutdown will take approximately 5 minutes. “
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DISPLAY AND PROCESSING OF ANALYSIS RESULTS

1. INTRODUCTION

Thisinstrument displays analysis result and information that assists in breaking down
analysis result and outputs such data to external devices. This chapter describes the
processing of analysis result, such as displaying latest or stored data on the screen or
outputting them to external devices. The gist of the contentsis asfollows:

Processing of L atest Samples

When analysisisfinished, analysisresult is displayed in three kinds of screens. The display
contents of Analysis Result screen, what they mean, and how to process them are explained
here.

Processing of Stored Data

The analysis data stored in the instrument can be read at anytime. Description is made on the
display contents of stored data, what they mean, deletion by marking, and output to external
devices.
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2.

PROCESSING LATEST SAMPLES
2.1 Display of Analysis Result

The analysisresult isdisplayed in the Analysis Result Display Areaon the LCD screen. In
the Analysis Result Display Area, the analysis result is displayed each time anew sampleis
analyzed. When the analysisresult is displayed, the menu display area displays the menu of
"1: M. Discri.," "2: Print," and "3: Paper Feed," which can each be executed using the
numeric keys.

The Analysis screen consists of three pages that differ from each other in "Anaysis Result
Display Area."

Use [ 4] key or [ ] key to change over pages.

P1. All Analysis Data P2. Particle Distribution P3. CBC8 Parameter
Display Screen Display Screen Display Screen

Figure 3-2-1: Page Selection in the Analysis Screen
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No. 123457 W8 >I>D>

ady % System Status Display Area
31/ 12 23: 59—

—— Date/Time Analyzed

Analysis Result Display Area

Latest Sample No. TNO123458 v BIJ12°23:59
o VBC 7). 1x10% L LYMro 31. 2%
Mode Indication— g~ 3.97x10 pL MKD% 19, 6%
HEB 14.7g/ dL NEUT% 49. 2%

HCT 32. 8% LYM# 2. 2x10°% pL

MV - 82.6fL MXDH 1. 4x10% pL

MOH 37. Opg NEUT# 3. 5x10°9 pL
MCHC  + 44.8g/dL RDW - 25.6fL
PLT 180x10% L PDW - 7.9fL
MPV 9.3fL
P-LCR - 9.5%

1:MDiscri. 2:Print 3: Paper Feed

:| Menu Display Area

Figure 3-2-2: All Analysis Data Display Screen

NOTE: » When analysis is made in the pre-diluted mode, particle distribution
analysis parameters are displayed in "- -
curve is not displayed.

-. =" The particle distribution

No. 123457 WB >D>D>

Mode Indication

Ready

LYMA
MXD2%
NEUT%
LYM#
MXD#
NEUT#
RDW
PDW
MPV
P-LCR

>>> |

31712 23: 59— Date/Time Analyzed

31. 2%
19. 6%
49. 2%

2. 2x10°9 L
1. 4x10% pL
3. 5x10°% pL

- 25.6fL
- 7.9fL

9.3fL
- 9.5%

1:MDscri. 2:Print

3: Paper Feed

Figure 3-2-3: Particle Distribution Display Screen

Latest Sample No
Mode Indication

MCHC
PLT

7. 1x10%
3. 97x10%/

14. 7g/ dL

32. 8%
- 82.6fL
37.0pg

+ 44, 8g/ dL

180x10°%

pL
pL

pL

1:MDscri. 2:Print

3: Paper Feed

Figure 3-2-4: CBC8 Parameter Display Screen
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Display Contents of Analysis Data Display Screens

1)

2)

3)

4)

5)

System Status Display Area
This area displays the status of the instrument. For details, refer to Chapter 1, Section
8.1: Contents of Display.

L atest Sample No.
The latest sample No. is displayed.

Mode Indication
The latest sample's analysis mode is displayed.
The whole blood mode is displayed as "WB" and the pre-diluted mode as "PD."

Date/Time Analyzed
Date and time when analysis result was obtained are displayed.

Analysis Data
The analysis data of the following 18 parameters or part of them are displayed
depending on the screen:
Analysis parameters (8): WBC, RBC, HGB, HCT, MCV, MCH, MCHC, PLT
Cdculation parameters (10): LYM%, MXD%, NEUT%,

LYM#, MXD#, NEUT#, RDW, PDW, MPV, P-LCR

NOTE: * As for RDW, either RDW-CV or RDW-SD is output.

When shipped from factory, it is set at RDW-SD
When you want to display RDW-CV, refer to Chapter 10, Section 2:
System Setup.

* The instrument can be set to block out PDW and P-LCR. Contact
Sysmex service representative for assistance.

The marksto the left of analysis dataindicate the following:
1. ! : Thedataisout of thelinearity limit.
2. + : The data exceedsthe upper Mark Limits.

- : The data exceeds the lower Mark Limits.

3. * : Thedataislow inreiability.

NOTE: » The marks are added with the priority order of 1, 2, and 3.

» The Mark Limits with "+" and "-" can be set by the customer. For
details, refer to Chapter 10, Section 4: Patient Limit.

3-4
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When an analysis error, etc. has caused errorsin analysis data, the marks below are
attached to the affected data:

1. +++.+  When data has exceeded the display range.

2. ***_ *: When data could not be calculated due to instrument failure.
3.---.-1  Whendatacould not be calculated due to data error.

NOTE: * When analysis is made in the pre- dlluted mode particle distribution

analysis parameters are displayed in "- - -, -.'

When an error isfound in particle distribution, a histogram error flag among the
followi ng is displayed:
1. WL: Reative frequency of WBC-LD has exceeded the range.
2.WU: Re ative frequency of WBC-UD has exceeded the range.
3. T1l: Tldiscriminator position cannot be determined.
4. T2: T2discriminator position cannot be determined.
5.F1: Reativefrequency of T1 has exceeded the range.
6. F2: Reativefrequency of T1 or T2 has exceeded the range.
7. F3: Reativefrequency of T2 has exceeded the range.
8. RL: Rdative frequency of RBC-LD has exceeded the range.
9. RU: Rédative frequency of RBC-UD has exceeded the range.
10. DW: Distribution width cannot be calculated.
11. MP: There are multiple peaks.
12. PL: Reativefreguency of PLT-LD has exceeded the range.
13. PU: Reativefrequency of PLT-UD has exceeded the range.
14. AG: The particle count equal to or lessthan WBC-LD has exceeded the range.

NOTE: * When analysis is made in the pre-diluted mode, no flag is displayed to

particle distribution analysis parameters. For details, refer to Chapter 9,
Section 6: Particle Distribution Analysis.

6)

7)

8)

9)

Menu Display Area
The Menu is displayed in accordance with the screen. For details, refer to Chapter 1,
Section 8.1: Contents of Display.

WBC Particle Distribution Chart
The WBC Particle distribution chart is displayed.

RBC Particle Distribution Chart
The RBC Particle distribution chart is displayed.

PLT Particle Distribution Chart
The PLT Particle distribution chart is displayed.
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2.2 Manual Discrimination

This menu allows relocation of particle distribution discrimination position and re-cal culation

of data.

CAUTION: » Manual Discrimination can be performed only on the latest sample
displayed on the Analysis screen, but not on the data with sample
number O.

NOTE:  "1: M. Discri." on the menu is valid only for the analysis result in the
whole blood mode.

Execution of Manual Discrimination

(1) Press[1] key on the Analysis screen displaying analysis result and select "1: M.
Discri."
The Manua Discrimination screen (WBC) appears.

*M D scri.»*
No. 123458 VB 31/12 23:59
wWBc VBC 7. 1x10%/ pL

I LYMo 31. 2%
I MXD% 19. 6%
i NEUT% 49. 2%

LYMt - 2.0x10% L
LD 43 fL KD 1. 4x10% pL
TI 93 fL NEUT# 3. 5x109 pL

T2 123 fL

Select itemicursor by [<J[D/[A[M.

Figure 3-2-5: P1. M. Discri. Screen (WBC)

(2) Using [« key or [»] key, select adesired page of the M. Discri. screen. The M.
Discri. screen consists of three pages.

’—P( P1. M. Discri. Screen (WBC) |‘—'| P2. M. Discri. Screen (RBC)|4—'| P3. M. Discri. Screen (PLT) }4—‘

Figure 3-2-6: Page Selection in the M. Discri. Screen
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*M Discri.x*

No. 123458 B
RBC

LD 30 fL
uD 250 fL

RBC

. HEB
- HCT
MV

MCH
MCHC
RDW

31/12 23:59

3. 97x10°%/ L
14. 79/ dL
32. 8%

- 82.6fL
37.0pg

+ 44, 8¢/ dL

- 25.6fL

Select itemcursor by [<]J[D/[A[M -

Figure 3-2-7: P2. M. Discri. Screen (RBC)

*M D scri.»*

No. 123458 WB
PLT

PLT
PDW
MPV
P-LCR

31/12 23:59

180x10%/ L
7.9fL
9.3fL

- 9.5%

Select itemcursor by [<][D]I/[A[V].

Figure 3-2-8: P3. M. Discri. Screen (PLT)

(3) Using [A] key or [ ¥] key, move the cursor to select the discriminator for manual

discrimination.

(4) Press[ENTER] key.

The discriminator for manual discrimination is set and the discriminator selected on the
Particle Distribution Chart is shown with solid line.
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(5)

Using [ 4] key or [P] key, move the Discri. position on the Particle Distribution
Chart. The Discri. position relocated is displayed.
The range within which each Discri. position can move is shown below.

Table 3-2-1: M. Discri. Screen (WBC)

Discri. to Move Lower Limit Upper Limit
LD 6 fL (Och) T1
T1 LD T2
T2 T1 ubD

WBC particle distribution covers 50 channels of 0 to 49 (6 fL per channel), and the
channel changes by one at atime.
The relation between WBC particle distribution channel and fL display isasfollows:

Discri. position (fL) = (Channel No. + 1) x 6

Table 3-2-2: M. Discri. Screen (RBC)

Discri. to Move Lower Limit Upper Limit
LD 5 fL (Och) ub
uD LD 250 fL (49ch)

RBC particle distribution covers 50 channels of 0to 49 (5 fL per channel), and the
channel changes by one at atime.
The relation between RBC particle distribution channel and fL display is asfollows:

Discri. position (fL) = (Channel No. + 1) x5

Table 3-2-3: M. Discri. Screen (PLT)

Discri. to Move Lower Limit Upper Limit
LD 1 fL (Och) uD
UD LD 40 fL (39ch)

PLT particle distribution covers 40 channels of 0 to 39 (1 fL per channel), and the
channel changes by one at atime.
The relation between PLT particle distribution channel and fL display isasfollows:

Discri. position (fL) = (Channel No. + 1) x 1

(6) After Discri. movement, press[ENTER] key.
The Discri. position is set and analysis data is re-calculated on the basis of new Discri.
position.
When [SELECT] key is pressed without pressing [ENTER] key, the Discri. positionis
not changed, and the status returns to the Discri. position selection status.

(7)  When you want to change another Discri., repeat the above (2) - (6) operation.
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(8) When Discri. changeisfinished, press[SELECT] key. The Setting Change
Confirmation M essage appears.

K to set? BTl Set Cancel
Figure 3-2-9: Setting Change Confirmation M essage

(99 Using [ 4] key or [P] key, move the cursor to select "Cont.," "Set," or "Cancel,"
then press [ENTER] key.
[Cont.]: Returnsto the M. Discri. screen and alows M. Discri. operation.
[Set]: Updates the contents and returns to the Analysis screen.
[Cancd]: Cancels the changed contents and returns to the Analysis screen.

(10) When you update the contents, analysis values changed in M. Discri. on the Analysis
screen are reverse-displayed.

| No. 123457 VB D> |
Ready

No. 123458 VB 31/ 12 23:59
L . LYMrn 31. 2%
VBC | | MXD% %
: NEUT% 49, 204
‘ LYMt 2. 2x10% L
RBC| | MXD# 71 10°/ L
1 NEUT# CRES<10%/ L
‘ RDW - 25.6fL
PLT | PDW - 7.9fL
; MV 9.3fL
P-LCR - 9.5%
1:MDscri. 2:Print 3: Paper Feed

Figure 3-2-10: Analysis Screen
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2.3 Printing

This menu can be used to output the latest sample's analysis result from the built-in printer.

Printing of Latest Sample
(1) Press[2] key on the Analysis screen and select "2: Print."
The built-in printer starts printing analysis resullt.

NOTE: * For printing format, refer to Chapter 2, Section 5.2: Printing of Analysis
Result. To change the printing format, refer to Chapter 10, Section 7:
Printer Settings.

Contents of Printing

123456T Sample No.

Dat e 31/12/97 23: 59 Date/Time Analyzed

Vode W8 [WIRTP: i Parameter Discriminated Manually
WBC  W.+11.3 x10% L

RBC +3. 80 x10% pL

HEB +11.5 g/dL

Mode Indication

Figure 3-2-11: Example of Printing

1) Sample No.
The latest sample No. is printed.

2) Mode Indication
The mode in which sample was analyzed is printed. The whole blood modeis
printed as "WB" and the pre-diluted mode as "PD."

3) Date/Time Analyzed
Date and time when analysis result was obtained are printed.

4) Parameter Discriminated Manually
When M. Discri is used, the parameter discriminated manually are printed.

2.4 Printer Paper Feed

(1) Press[3] key onthe Analysis screen and select "3: Paper Feed." Whilethekey is
being held in, paper feed continues.

3-10
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3. PROCESSING STORED DATA

Thisinstrument is capable of storing data of up to 240 samples. The stored datais retained
after the power isturned off and can be called up unless deleted.

NOTE: * The particle distribution chart is not stored.
» When the stored data exceeds 240, the oldest data are automatically
deleted.

3.1 Executing and Quitting Stored Data Processing Program

Executing the Program
(1) Press[SELECT] key inthe Ready status. The Select Menu screen appears.

(2) Using [A] key or [¥] key, move the cursor to select "1: Stored Data.”
(3 Press[ENTER] key. The Stored Data screen [1/5] appears.

*St ored Dat a*

No. VBC RBC HEB HCT
123451* 7.7+ 3.97 14.7 32.8
Q01 7.5 4.51 14.1 34.7
123453 7.5+ 3.85 13.8 30.5
123454 PD 7.1 4.30+ 12.2 29. 5-
123455* PD 7.2 3.91 14. 3 32.
123456 PD 55- 3.90 15.1 40. 2+
123457 7.0 4. 05 18.5 31. 4
123451* 7.6+ 3.98 15.0 35.1

Date 31/12/97 12:59 [1/5]
[ENTER to nmark, [SELECT] to exit.

Figure 3-3-1: Stored Data Screen

Quitting the Program
(1) Press[SELECT] key on the Stored Data screen. The Analysis screen returns.

NOTE: » The sample No. and analysis mode on the Analysis screen return to
the status before the execution of the stored data processing program.
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3.2 Stored Data Screen

The Stored Data screen lists data of up to eight samplesin the order of analysis. When the
first Stored Data screen is displayed after turning on the power, the data of the last eight
sampleson thelist are displayed. When anew sampleis analyzed, its datais automatically

added to the last line of the list.

Asto analysis data, four parameters are displayed on one page. And there are five pagesin
total. Using [ 4] key or [»] key, a page with four parameters can be changed over to the

next page.

P1. Stored Data P2. Stored Data
Screen [1/5] Screen [2/5]

P3. Stored Data
Screen [3/5]

4

P5. Stored Data
Screen [5/5]
RDW, PDW, MPV, P-LCR

"'WBC, RBC, HGB, HCT [ MCV, MCH, MCHC, PLT

l

P4. Stored Data
Screen [4/5]
WBC, LYM#, MXD#, NEUT#

WBC, LYM%, MXD%, NEUT% :|

Figure 3-3-2: Page Selection in the Stored Data Screen

*St ored Dat a*

No. VBC RBC HEB HCT
123451* 7.7+ 3.97 14.7 32.8
Q01 7.5 451 14.1 34.7
123453 7.5+ 3.85 13.8 30.5
123454 PD 7.1 4.30+ 12.2 29.5
123455* PO 7.2 3.91 14.3 32.0
123456 PD 5.5- 3.90 15.1 40.2+
123457 7.0 405 18.5 31l.4
123451* 7.6+ 3.98 15.0 35.1

Date 31/12/97 12:59 [1/5]

[ENTER] to nar

k, [SELECT] to

Figure 3-3-3: Stored Data Screen

Key Operation for Stored Data Screen

[A] key: Moves up the underline cursor by one sample. When the underline
cursor is at the top, the list scrolls down.

[V] key: Moves down the underline cursor by one sample. When the
underline cursor is at the bottom, the list scrolls up.

[, [™] key: Changes over the page.

[ENTER] key: Attaches or deletes marks.

[SAMPLE No.] key:  Allowsyou to correct the sample number at the underline cursor.

3-12
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Marking

To mark the analysis data, specify an analysis data using the underline cursor and press
[ENTER] key.

The marked analysis data has a B added to its | eft end and the underline cursor movesto the
next analysisdata. When an analysis data is marked, the Menu Display Areadisplays: "1:
Deletion,” "2: Print," "3: HC Output.” When the mark is aready attached, press[ENTER]
key to deleteiit.

NOTE: * When you keep pressing [ENTER] key, the marking is made
continuously.
* When you return to the Analysis screen, all the marks on analysis data
are deleted.
* "3. HC Output" on the Menu is displayed only when the optional Serial
Interface is incorporated.

*St ored Dat a*

No. VBC RBC HEB HCT
123451* 7.7+ 3.97 14.7 32.8
Q01 7.5 4.51 14.1 34.7

M123453 7.5+ 3.85 13.8 30.5
W123454 PD 7.1 4,30+ 12.2 29.5
123455* PD 1.2 3.91 14. 3 32.0

123456 PD 5.5- 3.90 15.1 40. 2+
123457 7.0 4,05 18.5 31.4
123451* 7.6+ 3.98 15.0 35.1
Date 31/12/97 12:41 [1/9]

1. Del ete 2: Print 3: HC Qut put

Figure 3-3-4: Marking the Data

Display Contents of Stored Data Screen

1) Sample No.
The sample No. of stored datais displayed.
Identical sample Nos. processed on an identical analysis date are marked with * at the
ends of the Nos. QC data are displayed in the format of "QC + File No."

2) Mode Indication
The analysis mode for stored data is displayed.
"PD" isindicated for the pre-diluted mode while no indication is given for the whole
blood mode.
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3)

Analysis Data

Analysis data of 18 parameters are displayed in agroup of four parameters on five
pages.

Stored Data Screen [1/5]: WBC, RBC, HGB, HCT

Stored Data Screen [2/5]: MCV, MCH, MCHC, PLT

Stored Data Screen [3/5]: WBC, LY M%, MXD%, NEUT%

Stored Data Screen [4/5]: WBC, LY M#, MXD#, NEUT#

Stored Data Screen [5/5]: RDW, PDW, MPV, P-LCR

The marks on the |eft of analysis data indicate the following:
1. ! : Thedataisout of the linearity limit.
2. + : The data exceedsthe upper Mark Limits.

- : The data exceeds the lower Mark Limits.

3. * : Thedataislow inrdiability.

NOTE: » The marks are added with the priority order of 1, 2, and 3.

» The Mark Limits with "+" and "-" can be set by the customer. For
details, refer to Chapter 10, Section 4: Patient Limit.

When an analysis error, etc. has caused errorsin analysis data, the marks below are
attached to the affected data:

1. +++.+  When data has exceeded the display range.

2. ***_ *: When data could not be calculated due to instrument failure.
3.---.-1  Whendatacould not be calculated due to data error.

NOTE: * When analysis is made in the pre- dlluted mode particle distribution

analysis parameters are displayed in "- - -, -.'

4)

5)

Date Analyzed
The date when the analysis data in the underline cursor position was analyzed is

displayed.

Manual Discrimination Data
Asto data changed through manual discrimination, analysis values are reverse-

displayed.

3-14
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6) Not-output Data
If the optional seria interface has been mounted, the Bl mark will appear next to the
data which has not been output to the host computer. This mark disappears when the
data output is completed.

*St ored Dat ax

No. WBC RBC HEB HCT
123451* PD 7.7+ 3.97 14.7 32.8
Q01 PD 7.5 4.51 14.1 34.7
123453 PD 7.5+ 3.85 13.8 30.5
123454*gPD 7.1 4.30+ 12.2  29.5-
123455*@PD 7.2 3.91 14.3 32.0
123456*@PD 5.5- 3.90 15.1 40.2+
123457*@PD 7.0 4.05 18.5 31.4
123451*kPD 7.6+ 3. 15. 21

Date 31/12/99 12:59 [1/5]

[ENTER] to nmark, [SELECT] to exit.

Figure 3-3-5: Not-Output Data

3.3 Deletion

This menu allows deletion of marked analysis data from stored data.

Execution of Deletion

(1) Using the underline cursor, specify the analysis data you want to delete and press
[ENTER] key. This puts the mark on the analysis data.

(2) Press[1] key to select "1: Deletion.” The Deletion Confirmation message appears.

Del et e? YES  HN<A

Figure 3-3-6: Deletion Confirmation M essage

(3 Using [ 4] key or [»] key, move the cursor to select "Yes' or "NO."
[Yeg]: Deletes the marked analysis data.
[NQJ: Cancels deletion.

(4) Press[ENTER] key to execute the selected process.
When you press [SELECT] key, the processis canceled.

NOTE: « Before deleting data, make sure the KX-21 completes any output
operation to the printer or host computer.
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3.4 Printing

This menu allows the marked analysis data to be printed by the built-in printer.

Execution of Printing

(1) Using the underline cursor, specify the analysis data you want to print and press
[ENTER] key. This puts the mark on the analysis data.

(2) Press[2] key to select "2: Print." The built-in printer starts printing the marked
analysis data.

NOTE: * For print format, refer to Chapter 2, Section 5.2: Printing of Analysis
Result.
* In printing stored data, Type 2 print is performed even when Type 1
print format is selected. (Particle distribution is not printed.)

3.5 HC Output (Option)

This menu allows outputting the marked analysis data to the host computer, if an optional
seria interface isincorporated.

NOTE: * "3: HC Output" on the Menu is displayed only when the optional serial
interface is incorporated.

Execution of HC Output
(1) Using the underline cursor, specify the analysis data you want to output to the host
computer and press[ENTER] key. This puts the mark on the analysis data.

(2) Press[3] key to select "3: HC Output.”
Analysis datais output to the host computer in the order of marking.
During output to the host computer, the * mark blinks at the right top edge of the
system status display area.

*St ored Dat a* @

Figure 3-3-7: Screen during Output to Host

NOTE: * Output to the host computer cannot be interrupted. “
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3.6 Correcting a Sample Number
Use the [SAMPLE No.] key to correct a sample number of analysis data.

(1) Usethe underline cursor to select the desired analysis data, then press the [SAMPLE
No.] key. The selected sample number will be highlighted.

(2) Usethe numeric keypad to enter a new sample number, then pressthe [ENTER] key.
(3) When the confirmation message appears, select the [Set] button.
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INTRODUCTION

To ensure that the instrument can function in its best state, it is necessary to give scheduled
maintenance. Perform maintenance according to the schedule below and record the result in
the Maintenance Checklist.

Daily Maintenance

Clean the TD chamber and diluted sample line. (Execute shutdown.)
Check trap chamber level, and discard if necessary.

Weekly Maintenance
Clean the sample rotor valve (SRV) tray.

Monthly Maintenance (or Every 2500 Samples)

Clean the waste chamber (rinse sequence).
Clean the transducer (rinse sequence).

Every 3-Month Maintenance (or Every 7500 Samples)
Clean the sample rotor valve (SRV).

As-Needed Maintenance

Auto Rinse

Clean the rinse cup.

Clean WBC/RBC transducer aperture.
Replace the waste tank.

This chapter describes supplies replacement together with these maintenance items.

Supplies Replacement
Replenish reagent.
Replace fuses.

Replace printer paper.
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KX-21 MAINTENANCE CHECKLIST
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Reagent Replenishment Record

Sysmex KX-21 Operator’s Manual -- Revised January 2000

Month Year
CELLPACK
Lot No. Date Expiry Signature|| Lot No. Date Expiry |Signature
STROMATOLYSER-WH
Lot No. Date Expiry |Signature|| Lot No. Date Expiry |Signature
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3. DAILY MAINTENANCE AND PROCEDURE

3.1 Clean TD Chamber and Diluted Sample Line (Shutdown)

By executing shutdown, the transducer chamber and diluted sample line are cleaned.

Perform shutdown after completion of the day's work, and also at least once every 24 hours

when thisinstrument is used continuously.

(1) Press[SHUTDOWN] key in the Ready status. The Shutdown screen appears.

| * Shut down* > |
Ready

Aspirate CELLCLEAN
It will take approx. 5 mnutes.

3: Cancel

Figure 4-3-1: Shutdown Screen

NOTE: * When [3] key is pressed, shutdown is canceled and the Analysis
screen returns.

(2)  Inexecuting shutdown, set CELLCLEAN to the sample probe and press the start
switch in that status. While"Aspirating” is being displayed on the screen, keep
holding CELLCLEAN in the same state.

Start Switch

Figure 4-3-2: Pressing the Start Switch
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&WARNING » Because CELLCLEAN is a strong alkaline detergent, take care not to
have it adhere to the skin or clothes. If the skin or clothes should come
in touch with it, flush it away using plenty of water. Otherwise, it can
damage the skin or clothes.

NOTE: » Once shutdown is executed, it cannot be canceled until completed. H

(3) When the buzzer sounds two times - beep, beep, - informing the completion of
aspiration, remove CELLCLEAN from the sample probe. After that, shutdown is
executed automatically.

* Shut down* [
— R nsi ng

Pl ease wait.

Figure 4-3-3: Shutdown Execution Screen

CAUTION: » To remove CELLCLEAN, lower it straight down. Take care not to bend
the sample probe.

(4) When shutdown is completed and the following message is displayed, turn off the
power switch on the right side of the unit.

* Shut down*

Shut - down sequence was conpl et ed.
Turn CFF the power.

Figure 4-3-4: Shutdown Completion M essage Screen

NOTE: » Shutdown will take approximately 5 minutes. “
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3.2 Check Trap Chamber Level and Discard

After completion of analysesfor the day, check trap chamber level and discard any liquid that
has collected.

(1) Turn off the power and wait approximately 30 seconds.
(2) Turnthe chamber on the |eft side of the unit counterclockwise and remove.

-

Trap Chamber Float
\H Loosen
e
=50

Figure 4-3-5: Checking the Trap Chamber

(3) After discarding the liquid, mount the chamber. Make sure the float isinside.

&WARMNG * When discarqling the trap _chamber liquid, alvyays_ wear rubber gloves.
After completion of operation, wash hands with disinfectant. If your
hands are contaminated by the liquid, infection of bacteria or the like can
occur.

&CAUTION * If liquid collects everyday, the hydraulic system may have failed.
Contact Sysmex service representative.
* Pay attention to the direction of the float in the chamber. Place it with its
pointed end facing upward.
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4. WEEKLY MAINTENANCE AND PROCEDURE

4.1 Clean SRV Tray

Clean the sample rotor valve (SRV) tray once aweek in the following procedure:

&WARNING * When cI_eaning the SRV tray, always wear _ru_bber gloves. After
completion of operation, wash hands with disinfectant. If your hands
are contaminated by blood, etc., infection of bacteria or the like can
occur.

(1) Turn off the power of the main unit and wait approximately 30 seconds.
(2) Open the front cover of the main unit.
(3 Removethe SRV tray.

Probe Fixing Screw

Figure 4-4-1: Removing the SRV Tray

* When removing the tray, take care not to loosen the probe fixing screw.
&CAU-“ON If analysis is made with the screw loosened, air can enter the system
and affect the data.

(4) Washthe SRV tray using tap water.

Tray

Figure 4-4-2: Washing the SRV Tray
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(5) Make sure no contaminants remain, then wipe off water.

(6) Re-mount the SRV tray to the original state.

* After mounting the tray, make sure the probe fixing screw is not loose.
&CAUT'ON If analysis is made with the screw loosened, air can enter the system
and affect the data.

CAUTION: * Mount the SRV tray properly as to the face/bottom and the direction. “

(7) Closethefront cover of the main unit.
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MONTHLY MAINTENANCE AND PROCEDURE

5.1 Clean Waste Chamber (Rinse Sequence)

When the power is turned on, the message is displayed once a month or for every 2500
samples to instruct the scheduled maintenance.

*Schedul ed Mai nt. *

A ean the Waste Chanber.
It will take approx. 15 m nutes.

Cycle No. after cleaning. 2567
Date | ast serviced 31/ 12/ 97

1: Exec. d ean 3: Cancel

Figure 4-5-1: Scheduled Maintenance M essage Screen

When this message appears, press [1] key to select "1: Exec. Clean," and clean the waste
chamber by the following procedure:

NOTE: * When you press [3] key and select "3: Cancel," the start-up process
continues without cleaning the waste chamber. Until the waste
chamber is cleaned, the above message is displayed at start-up.

» Even when the above message is not displayed, you can execute the
waste chamber cleaning by choosing "7: Maintenance” on the Select
Menu screen, then "1: Clean W. Chamber" on the Maintenance Menu

screen.
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(1) Press[1] key to select "1: Exec. Clean" on the Scheduled Maintenance Message
screen. The Clean W. Chamber screen will display the message instructing the
following operation:

| *d ean WChanber* D>
Ready ﬁ

Aspirate CELLCLEAN
It will take approx. 15 m nutes.

Cycle No. after cleaning. 2567
Date | ast serviced 31/ 12/ 97

3: Cancel

Figure 4-5-2: Clean W. Chamber Screen

NOTE: » When you press [3] key and select "3: Cancel," the start-up process
continues without cleaning the waste chamber. Until the waste
chamber is cleaned, the above message is displayed at start-up.

(2) Set CELLCLEAN to the sample probe and press the start switch in that status. While
"Aspirating” is being displayed on the screen, keep holding CELLCLEAN in the same
status.

Start Switch

\
/\

Figure 4-5-3: Pressing the Start Switch

AWARNING * Since CELLCLEAN is a strong alkaline detergent, take care not to have
it adhere to the skin or clothes. If the skin or clothes should come in
touch with it, flush it away using plenty of water. Otherwise, it can
damage the skin or clothes.
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(3) When the buzzer sounds two times - beep, beep , - informing completion of aspiration,
remove CELLCLEAN from the sample probe. After that, the waste chamber cleaning
is executed automatically.

*d ean W Chanber * [

Pl ease wait.

Figure 4-5-4. Screen during Waste Chamber Cleaning

CAUTION: » To remove CELLCLEAN, lower it straight down. Take care not to bend
the sample probe.

(4) When the waste chamber cleaning is completed, the auto rinse and background check
are executed, then the system turns to the Ready status.

(5) Check to see that no background error occurs. Should background error occur,
execute the auto rinse.

NOTE: » When this operation is completed, the waste chamber cycle counter is
automatically reset. For the confirmation of waste chamber cycle
number, refer to Chapter 4, Section 9: CONFIRMATION OF CYCLE
NUMBER.
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5.2 Clean Transducer (Rinse Seguence)

When the power is turned on, the message is displayed once a month or for every 2500
samples to instruct the scheduled maintenance.

*Schedul ed Maint. *

d ean the Transducer.
It will take approx. 7 m nutes.

Cycle No. after cleaning. 2567
Date | ast serviced 31/ 12/ 97

1: Exec. dean 3: Cancel

Figure 4-5-5: Scheduled M aintenance M essage Screen

When this message appears, press[1] key to select "1: Exec. Clean," and clean the
transducer by the following procedure:

In addition, the error message of clogging is displayed. Even when the clogging is not
removed, clean the transducer using the same procedure.

NOTE: * When you press [3] key and select "3: Cancel," the start-up process
continues without cleaning the transducer. Until the transducer is
cleaned, the above message is displayed at start-up.

» Even when the above message is not displayed, you can execute the
transducer cleaning by choosing "7: Maintenance" on the Select Menu
screen, then "2: Clean Transducer" on the Maintenance Menu screen.

« If this rinse sequence fails to remove clogging, clean with the brush.

Regarding cleaning with the brush, refer to Chapter 4, Section 7.3:
Clean WBC/RBC Transducer Aperture.
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(1) Press[1] key to select "1: Exec. Clean" on Scheduled Maintenance M essage screen.
Fluid in the transducer is drained and the Clean Transducer screen appears.

*( ean Transducer* DB>E>EE>E>>
Ready

Pour CELLCLEAN in transducer chanber
and press START switch.
It wll take approx. 7 m nutes.

Cycle No. after cleaning. 2567
Date | ast serviced 31/ 12/ 97

3: Cancel

Figure 4-5-6: Clean Transducer Screen

NOTE: » When you press [3] key and select "3: Cancel," the start-up process
continues without cleaning the transducer. Until the transducer is
cleaned, the above message is displayed at start-up.

(2)  Open thefront cover of the main unit.

(3) Open the transducer cover.

Figure 4-5-7: Opening the Transducer Cover
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(4) Using thefiller provided with the unit, pour approximately 1 mL each of
CELLCLEAN into the WBC transducer and RBC transducer.

Filler

Figure 4-5-8: Pouring CELLCLEAN

&WARMNG » Since CELLCLEAN is a strong alkaline detergent, take care not to have
it adhere to the skin or clothes. If the skin or clothes should come in
touch with it, flush it away using plenty of water. Otherwise, it can
damage the skin or clothes.

» Do not pour more than 1 mL of detergent (CELLCLEAN) into the
&CAUT'ON chamber. It may overflow, possibly causing electric shocks or leakage.

CAUTION:  Take care not to have detergent (CELLCLEAN) adhere to the chamber
side wall.

(5) Closethe transducer cover.

(6) Closethefront cover of the main unit.
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(7) Pressthe start switch. The transducer cleaning is executed.

*( ean Transducer* P>

Pl ease wait.

Figure 4-5-9: Screen during Transducer Cleaning

(8) When thetransducer cleaning is completed, the auto rinse and background check are
executed, then the system turns to the Ready status.

(9) Check to see that no background error occurs. Should background error occur,
execute the auto rinse.

NOTE: » When this operation is completed, the transducer cycle counter is
automatically reset. For the confirmation of transducer cycle number,

refer to Chapter 4, Section 9: CONFIRMATION OF CYCLE
NUMBER.
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EVERY 3-MONTH MAINTENANCE AND PROCEDURE
6.1 Clean Sample Rotor Valve (SRV)

When the power is turned on, the message is displayed once every three months or for every
7500 samples to instruct the scheduled maintenance.

*Schedul ed Maint. *

d ean the SRV.

[1] Reset the cycle counter for SRV,
and you can turn OFF the power.

[3] Continue to start up. SRV cycle
counter will not be reset.

Cycle No. after cleaning. 7567
Date | ast serviced 31/ 12/ 97

1. Exec. d ean 3: Cancel

Figure 4-6-1. Scheduled Maintenance M essage Screen

When this message appears, press [1] key to select "1: Exec. Clean,” and reset the cycle
counter. Then clean the sample rotor valve (SRV) by the following procedure:

&WARNING * When cleaning the sample rotor valve (SRV), always wear rubber
gloves. After completion of operation, wash hands with disinfectant. If
your hands are contaminated by blood, etc., infection of bacteria or the
like can occur.

» Because CELLCLEAN is a strong alkaline detergent, take care not to
have it adhere to the skin or clothes. If the skin or clothes should come
in touch with it, flush it away using plenty of water. Otherwise, it can
damage the skin or clothes.

NOTE: » When you press [3] key and select "3: Cancel," the start-up process
continues without cleaning the sample rotor valve (SRV). Until the
sample rotor valve (SRV) is cleaned, the above message is displayed
at start-up.

* When you want to clean before this message appears, or when you
selected "3: Cancel" on the Scheduled Maint. screen and executed
cleaning when the power was off, reset the cycle counter, making
reference to Chapter 4, Section 6.2: Reset SRV Cycle Counter.
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(1) Press[1] key to select "1: Exec. Clean" on the Scheduled Maintenance Message
screen. The SRV cycle counter isreset and the unit is ready to be turned off.

*Schedul ed Maint. *

SRV cycl e counter was reset.

Turn CFF the power.

Figure 4-6-2: Clean SRV Screen

CAUTION: « Before turning the power off, always select "1: Exec. Clean," making
the unit ready to be turned off.

(2) Turn off the power of the main unit and wait approximately 30 seconds.
(3 Open the front cover of the main unit.

(4) Removethe samplerotor valve (SRV) tray.

Probe Fixing Screw

Figure 4-6-3:. Removing the Tray
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» When removing the tray, take care not to loosen the probe fixing screw.
&CAUT'ON If analysis is made with the screw loosened, air can enter the system
and affect the data.

(5 Gently push down the rinse cup using both hands. Make suretherinsecupis
removed completely from the sample probe.

’ “l | | Sample Probe

Rinse Cup

Figure 4-6-4: Pushing Down the Rinse Cup

CAUTION: « If the rinse cup is not completely removed from the sample probe, there
is a possibility that the sample probe may bend when the sample rotor
valve (SRV) is removed.

(6) Removethe SRV fixing screw.

SRV Fixing Screw

Loosen

Figure 4-6-5: Removing the SRV Fixing Screw
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(7) Removethe entire samplerotor valve (SRV).

Figure 4-6-6: Removing the Entire SRV

CAUTION: » Take care not to pull out the valve excessively. This is to prevent
applying excess force to the tube connected to the valve.
» When removing the valve, take care not to bend the sample probe.

(80 Removetherotary valve.

Figure 4-6-7: Removing the Rotary Valve

C CAUTION * When removing the valve, reagent could leak from the tube. If it does,
wipe it clean using cloth. If left as it is, it can cause current leakage or
electric shocks.

NOTE: » The valve components are in close contact with one another. They
can be easily removed when you gently twist and slide each one.
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(99 Cleantherotary valve using distilled water or 1:10 dilution of CELLCLEAN detergent.
After cleaned with CELLCLEAN, adways clean it with distilled water.

(10) Clean the contact surfaces of the fixed and rotary valves using a gauze moistened with
distilled water. By using CELLCLEAN together with distilled water, stuck objects,
dirt, etc. can be removed easlly.

Figure 4-6-8: Cleaning the Contact Faces

» Take care not to inflict flaws or scratches on valve surfaces, since flaws
CAUTION h blood leak di lysi |
or scratches can cause blood leakage and incorrect analysis results.

CAUTION: » Do not use any detergent other than CELLCLEAN. Although the
sample rotor valve (SRV) is corrosion-resistant against CELLCLEAN,
wipe it off completely to prevent troubles to the unit or other
components.

(11) Make surethe valve contact surfaces are completely free from dirt or dust.

« If the device is used with dirt or dust attaching on valve contact
&CAUT'ON surfaces, blood leakage can occur and correct analysis results may not
be obtained.

(12) Indgtall one each valve at atime, and assemble the sample rotor valve (SRV) in the
reverse order to disassembly.
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CAUTION: » Mount the rotary valve with the notch facing upward and the metal
knob coming between the stoppers.

I ] Metal Knob )
O/Gwde Pin for Rotary Valve

Groove

Stopper

(View of Left Side)
Figure 4-6-9: Rotary Valve

 Confirm that the metal knob is between the stoppers. If it is not,
malfunction will occur.

(13) Mount the SRV tray to the origina position and gently push up the rinse cup to the top
using both hands.

CAUTION: * Mount the SRV tray properly as to its face/bottom and the direction.

» Make sure the rinse cup is pushed all the way up with the sample
probe inserted in the hole. If the power is turned on with the rinse cup
staying lowered, "Rinse Motor Error" will occur, making it impossible to
continue the operation.

(14) Closethe front cover of the main unit.
(15) Turn on the main unit and make sure that the background error has not occurred.

(16) Perform quality control and make sure that there is no functional problem.

NOTE: * When this operation is completed, the SRV cycle counter is
automatically reset. For confirmation of SRV cycle number, refer to
Chapter 4, Section 9: CONFIRMATION OF CYCLE NUMBER.
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6.2 Reset SRV Cycle Counter

If you have cleaned the SRV other than the time when instructed on the Scheduled
Maintenance screen, aways reset the SRV cycle counter manually.

NOTE: « If you continue using the unit without resetting the SRV cycle counter,
the message will instruct you to perform scheduled maintenance within
three months (or before analyzing 7500 samples).

» For SRV cleaning procedure, refer to Chapter 4, Section 6.1: Clean
Sample Rotor Valve (SRV).

(1) Press[SELECT] key in the Ready status. The Select Menu screen appears.
(2) Use[A] key or [¥] key, move the cursor to select "7: Maintenance.”
(3) Press[ENTER] key. The Maintenance Menu screen appears.

* MRi Nt enance*

1: d ean W Chanber

d ean Transducer
Reset SRV Count er
Drain TD Chanber
Status D spl ay

2
3
4
5

Figure 4-6-10: Maintenance M enu Screen
(4) Use[A] key or [¥] key, move the cursor to select "3: Reset SRV Counter."
(5) Press[ENTER] key. The Rest SRV Counter screen appears.

*Reset SRV Counter*

[1] SRV cycle counter will be reset.

Cycle No. after cleaning. 7567
Date | ast serviced 31/ 12/ 97

1: Reset 3: Cancel
Figure 4-6-11: Reset SRV Counter Screen
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(6) Press[1] key to select "1: Reset." "Cycle No. after cleaning” isreset to "0," the date
of the present day is entered in the "Date last serviced" column, then the Analysis
screen returns.

NOTE: * Press [3] key to select "3: Cancel." The cycle counter is not reset, and
the Analysis screen returns.
* For confirmation of SRV cycle counter, refer to Chapter 4, Section 9:
CONFIRMATION OF CYCLE NUMBER.
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7. AS-NEEDED MAINTENANCE AND PROCEDURE

When the transducer is clogged or the waste tank becomes full, perform the necessary
mai ntenance.

7.1 Auto Rinse

Execute the Auto Rinse at background check or when the unit has been left idle without
shutdown performed. The Auto Rinse cleans all the linesin the unit and drains all waste.
Background check is aso implemented to alow checking whether the unit isin normal status
or not.

(1) Press[SELECT] key inthe Ready status. The Select Menu screen appears.
(2) Using [A] key or [¥] key, move the cursor to select "5: Auto Rinse.”

* SELECT*

1: Stored Data
2:Quality Control
3:Calibration

4: Repl ace Lyse

6: Settings

7: Mai nt enance

8: Periph. Settings

00: PU Sl eep

Figure4-7-1: Select Menu Screen
(3 Press[ENTER] key. Auto Rinse and background check are performed.

NOTE: » On the Menu screen, each menu can be selected directly by entering a
numeral from the numeric keys.

*Aut o R nsex

Pl ease wai t.

Figure 4-7-2: Auto Rinse Execution Screen
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NOTE: * After Auto Rinse, background check is executed. When the background
value of any parameter exceeds tolerance, background check is
repeated a maximum of twice. In case background value still exceeds
tolerance, the message "Background Error" appears while the alarm
starts sounding. Press [HELP] key. This stops the alarm and the
Action Message screen appears. Follow the Action Message screen
and take appropriate action. (Refer to Chapter 7:
TROUBLESHOOTING).

. Background tolerance
WBC 0.3 [x10%uL] or less
RBC 0.02 [x10%uL] or less
HGB 0.1 [g/dL] or less
PLT 10 [x10%/uL] or less

Table 4-7-1. Background tolerance
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7.2 Clean Rinse Cup

When the rinse cup has any blood on it or is clogged, clean it by the following procedure:

&WARNING * When cl_eaning the ri_nse cup, always wear ru_bber gloves. After
completion of operation, wash hands with disinfectant. If your hands
are contaminated by blood, etc., infection of bacteria or the like can
occur.

(1) Turn off the power of the main unit and wait approximately 30 seconds.
(2)  Open thefront cover of the main unit.

(3) Gently push down the rinse cup using both hands. Make suretherinsecupis
removed completely from the sample probe.

l |W8ample Probe

- Rinse Cup

Figure 4-7-3: Pushing Down the Rinse Cup

(4) Removetherinsecupinthe order of 1, 2, and 3 as shown below.

Rinse Cup

Figure 4-7-4: Removing the Rinse Cup
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(5 Cleantherinse cup using tap water.

Figure 4-7-5: Cleaning the Rinse Cup
(6) Make sure no contaminant remains on the rinse cup and wipe off water.

(7)  Mount therinse cup in the reverse order of removal. Route the thin tubes around the
rear of the rinse cup.

Rinse Cup

2 oy

Figure 4-7-6; Mounting the Rinse Cup
(8) Gently push up the rinse cup to the top using both hands.

CAUTION: » Make sure the rinse cup is pushed all the way up with the sample
probe inserted in the hole. If the power is turned on with the rinse cup
staying lowered, "Rinse Motor Error" will occur, making it impossible to
continue the operation.
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7.3 Clean WBC/RBC Transducer Aperture

If the transducer aperture clogging persists, clean the transducer aperture using the brush by
the following procedure:

&WARNING * When cI_eaning the aperture, always wear rl_Jt_)ber gloves. After
completion of operation, wash hands with disinfectant. If your hands
are contaminated by blood, etc., infection of bacteria or the like can
occur.

* Since CELLCLEAN is a strong alkaline detergent, take care not to have
it adhere to the skin or clothes. If the skin or clothes should come in
touch with it, flush it away using plenty of water. Otherwise, it can
damage the skin or clothes.

1.  Preparation
(1) Press[SELECT] key in the Ready status. The Select Menu screen appears.

(2) Use[A] key or [¥] key, move the cursor to select "7: Maintenance.”
(3) Press[ENTER] key. The Maintenance Menu screen appears.

* Mai nt enance*

1: d ean W Chanber

d ean Transducer
Reset SRV Count er
Drain TD Chanber
Status Displ ay

2
3
4
5

Figure 4-7-7: Maintenance Menu Screen
(4) Use[A] key or [¥] key, movethe cursor to select "4: Drain TD Chamber."
(5) Press[ENTER] key. Reagent in the transducer chamber is automatically drained.

NOTE: » On the Menu screen, each menu can be selected directly by entering a
numeral from the numeric keys.
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(6) When reagent in the transducer chamber is drained, the message instructing turning-off
of the power is displayed, which indicates that it is ready for cleaning with the brush.

*Drain TD Chanber. *

Fluid in T.D Chanber was drai ned.
Turn power OFF and dab the aperture
with transducer brush.

See the (perator's Mnual .

3: Cancel

Figure 4-7-8: Drain TD Chamber Screen

NOTE: * When you press [3] key, cleaning with brush is canceled and the
Analysis screen returns.

2. Clean Transducer Aperture
(1) Turn off the power and wait approximately 30 seconds.

(2) Open the front cover of the main unit.

(3) Loosen the screw and open the transducer cover.
Loosen

Figure 4-7-9: Opening the Transducer Cover

&WARNING * When the power is on, never open the transducer cover. This is to
prevent possible electric shocks.
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(4) Confirm that reagent in the transducer chamber has been drained.

| / )y
WBC Transducer NS

d
N \ RBC Transducer
.“

Figure 4-7-10: Checking the WBC/RBC Transducer

(5) Remove the transducer chamber plug.

Figure 4-7-11: Removing the Plug

» A small volume of reagent occasionally remains. When reagent has
&CAUT'ON leaked, wipe it off immediately using wet cloth or the like. If left as it is, it
can cause current leakage or electric shocks.

(6) Apply CELLCLEAN on the brush provided, and dab by lightly prodding the brush
against the transducer aperture.

Figure 4-7-12: Cleaning the Aperture
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NOTE: « After using the brush, wash it in water thoroughly to remove
CELLCLEAN before storing it.

(7) Mount the transducer chamber plug.

 The transducer chamber plug should be mounted securely. Otherwise,
&CAU-“ON current leakage or electric shocks can occur.

(8) Closethetransducer cover and main unit front cover. Then turn on the power.

(99 Check to seethat background error has not occurred.
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7.4 Replace Waste Tank

When the waste tank has become full, replace it by the following procedure:

AWARNING * When replacing the waste tank, always wear rubber gloves. After

replacing, wash hands with disinfectant. If your hands are
contaminated by blood, etc., infection of bacteria or the like can occur.

1)
(2)
3)
(4)

Turn off the power of the main unit and wait approximately 30 seconds.
Make ready an empty waste container and remove the cap.
Pull the tube off the waste container.

Insert the tube in the new waste container and fix it using tape or the like.

/ Tube
/ Tape
ab

N

Figure 4-7-13: Waste Container

* When usin r n ntainer he w ntainer, mak
/_\ CAUTION en using a used reagent container as the waste container, make

sure to clearly mark it that it is the waste container.
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8. SUPPLIES REPLACEMENT

8.1 Replenish Reagent

When reagent becomes insufficient during analysis, the instrument comes to a stop, while the
screen displays the error message. Press [HELP] key to change to the replenishment

operation.
Error
Message HELP Screen Reagent to
(Analysis Replenish
Screen)
Replenish *Hel p* CELLPACK
Diluent
Repl eni sh Di | uent Cont ai ner.
[1] Reaspirating D | uent
ERR CCDE: XXXXX. X. X
1: Asp. Reag. 3: Cancel
Replenish *Hel p* STROMATOLYSER-WH
Lyse
Repl eni sh Lyse Cont ai ner.
[1] Reaspirating Lyse
ERR CCDE: 12490. 0.0
1: Asp. Reag. 3: Cancel
NOTE: * Press [3] key on the HELP screen and select "3: Cancel" to return to

the Analysis screen. Although Analysis screen displays the Not
Ready status, the processing, etc. of stored data can be performed.
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(1) Makeready anew reagent and check to see that expiration date is not passed.

&CAUTION . gELLPACK, if used just after delivery via transit, sometimes develop a
ackground error.

* In handling a reagent that may have frozen, follow the precautions
given on the Package Insert. Otherwise, correct analysis result may
not be obtained.

* Leave the reagent at room temperature (15 - 30°C) for at least 24 hours
before using.

» After unpacking, take care to prevent entry of dirt, dust, and bacteria.

CELLPACK 20 L 60 days
STROMATOLYSER-WH 500 mL 90 days

Table 4-8-1: Expiration After Opening the Seal

(2) Remove the cap from the new
reagent bottle.

(3) Remove the cap from the empty
reagent bottle and pull out the
cubitainer spout set straight up.

(4) Insert the cubitainer spout set
straight down into the new reagent
bottle and tighten the cap.

Figure 4-8-1: Pulling Out the Cubitainer
Spout Set

&CAUTION » Take care not to grasp the tube dipping into the reagent and not allow
dust, etc. to adhere to the tube. If dust, etc. adheres to the tube, wash
it away with reagent in use before mounting. Otherwise, correct
analysis results may not be obtained.

* Replace only fresh and fully bottled lyse reagent. Old or collected lyse
reagent will affect the analysis results.

» Take care not to spill reagent. If it spills, wipe it off immediately using
wet cloth, etc. to prevent the floor color fading.

* When replacing lyse, you do not need to disconnect the float switch. If
disconnected, connect it securely in prior to starting analysis. Starting
analysis with disconnected float switch will give you an error message
"No Lyse".
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(5 When reagent replenishment is over, follow the instruction on the screen and press[1]
key to select "1: Asp. Reag." Reagent is automatically aspirated, and then background

check is performed. The check is made here to see that background error has not
occurred.

(6) Enter the contents of replenishment in Reagent Replenishment Record.

NOTE: « If you replenish lyse before error message "No Reagent" appears,
execute "4: Replace Lyse" on the Select Menu screen.
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8.2 Replace Fuse

The main unit employs overcurrent protective fuses. When afuseis blown, replaceit by the
following procedure:

(1) Disconnect the power cord on the right side of the main unit.

&WARNING » Before replacing the fuse, always turn off the power and disconnect the
power cord to prevent possible electric shocks.

(2) Pressing the notch upward with aregular screwdriver, remove the fuse cap holder.

Fuse Cap Holder  Notch

Figure 4-8-2: Removing the Fuse Cap Holder
(3) Replace the fuse and mount the fuse cap holder.

Specification | Part No. Description Fuse Type
117VAC 266-5109-1 | Fuse 250V 3.15 A ST4-3.15A-N1 | TimeLag
220/240 VAC | 266-5292-6 | Fuse 250V 2 A No. 19195 Timelag

Table 4-8-2: Fuse Rating

* For continued protection against risk of fire, use the fuse of the specified
&CAU-“ON type and rating.
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8.3 Replace Printer Paper

When the "No Printer Paper" message appears on the screen, press [HELP] key and replace
printer paper by the following procedure:

* Hel| p*

No Printer Paper

[1] Restarting to print
[3] Stop printing on built-in printer

To nake built-in printer on-line,

press [ SELECT], then
[ Periph. Settings]

ERR CODE: XXXXX X X

1:Print 2: Paper Feed 3:Stop Qutput

Figure 4-8-3: "No Printer Paper" Message Screen

NOTE: » On the HELP screen, press [3] and select "3: Stop Output" to stop

printing on built-in printer. Analysis is executed as usual but printing is
not. When you want to use built-in printer again, select "8: Periph.
Settings" to set. (Refer to Chapter 10, Section 9: Peripheral Settings.)

(1) Open the front cover of the main unit.

(2) Turnthereleaselever up to free the paper.

Release Lever

Figure 4-8-4. Releasing the Lever
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(3 Removethe bare paper core and mount anew printer paper.

New Printer Paper

Figure 4-8-5: Mounting a New Printer Paper

NOTE: » When any printer paper remains, remove it together with the paper
core.

(4) Passthe printer paper as shown below, and turn the release lever down to secure.

Figure 4-8-6: Securing the Release L ever
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(5 Cut off any printer paper extending from the upper part of the printer.

Figure 4-8-7: Cutting Off Paper
(6) Closethefront cover of the main unit.

(7) Press[1] key and output any print data that is remaining on the memory.

Sysmex KX-21 Operator’s Manual -- Revised October 1998 4-39



MAINTENANCE AND SUPPLIES REPLACEMENT

8.4 Supplies List

1. ReagentsList

Product Code

Product Name

General Name

834-0161-8 CELLCLEAN (50 mL) Detergent
884-0871-1 CELLPACK (20 L) Diluent
974-0521-6 STROMATOLYSER-WH (500 mL x3) | WBC/HGB Lyse

Table 4-8-3: ReagentsList

2. Consumable List

Product Code | Product Name Chapter & Section for Reference
933-3601-9 Brush No. 1 Assembly | Chapter 4, Section 7.3: Clean WBC/RBC
Transducer Aperture.
943-1781-1 Cubitainer Spout Kit Chapter 4, Section 8.1: Replace Reagent
No. 1 (Replacement of spout kit is suggested if
background count will not drop when
diluent has been replaced.)
973-3041-7 Float Switch No. 23 Chapter 4, Section 8.1: Replace Reagent
(Replacement of float switch is
suggested if WBC/HGB background
count will not drop when lyse has been
replaced.)
266-5292-6 Fuse 250 V, 2 A No. Chapter 4, Section 8.2: Replace Fuse
19195 (220/240 VAC Spec.)
266-5109-1 Fuse 250 V, 3.15 A Chapter 4, Section 8.2: Replace Fuse
ST4-3.15A-N1 (117 VAC Spec.)
921-0351-8 Paper Thermal F1-2 Chapter 4, Section 8.3: Replace Printer
Heat-Sensitive Paper Paper
(5 rolls per pack)

Table 4-8-4: Consumable List
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9. CONFIRMATION OF CYCLE NUMBER

To let you know when to perform maintenance, this unit has the functions of cycle No.
display and automatic reset. Asto the waste chamber, transducer, and sample rotor vave
(SRV), the next maintenance period is informed in accordance with the operation cycle No.
or date, whichever comesfirst.

Cleaning of waste chamber Every 2500 cycles or every month
Cleaning of transducer Every 2500 cycles or every month
Cleaning of sample rotor valve (SRV) Every 7500 cycles or every 3 months

Table 4-9-1: Maintenance Timing
Current cycle No. of each item can be checked by the following procedure:
9.1 Operation Procedure
(1) Press[SELECT] key in the Ready status. The Select Menu screen appears.

(2) Using [A] key or [ ¥] key, move the cursor to select "7: Maintenance.”
(3) Press[ENTER] key. The Maintenance Menu screen appears.

* Mai nt enance*

1: d ean W Chanber

d ean Transducer
Reset SRV Count er
Drain TD Chanber
Status Displ ay

2
3
4
5

Figure 4-9-1: Maintenance Menu Screen
(4) Using [A] key or [ V] key, move the cursor to select "'5: Status Display.”
(5) Press[ENTER] key. The Status Display screen 1 appears.

NOTE: » On the Menu screen, each menu can be selected directly by entering a
numeral from the numeric keys.
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(6) Using [<] key or [P] key, turn over the page to display the Status Display screen 2.

* St at us* WB S>>
Ready

COUNTER 1234567 Cycle No. after cleaning waste chamber
CVASTE CRANBER T sy ||

gglfcrd? ggg% | Cycle No. after cleaning transducer

S N Cycle No. after cleaning SRV

Change screen with [<] or [DY.

Figure 4-9-2: Status Display Screen 2

NOTE: * Cycle number is the number of operations after the last maintenance.

» When the power is turn-on and the counter exceeds the predetermined
cycle number (or number of days), the message instructing the
maintenance is displayed on the screen. At this time, the cycle number
and the date of the last service are displayed.

*Schedul ed Maint . *
A ean the Waste Chanber.
It will take approx. 15 ninutes.
Cycle No. after cleaning. 2567
Date | ast serviced 31/ 12/ 97
1: Exec. d ean 3: Cancel
Figure 4-9-3: Scheduled M aintenance M essage Screen
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1. INTRODUCTION

Quiality Control checks are performed to monitor an instrument’ s performance over time.
EIGHTCHECK-3WP isthe quality control material recommended by Sysmex to monitor the
performance of the KX-21 analyzer. This product is supplied with three control levels, at
least two levels should be run every 8 hours of operation or in accordance to regulations
applicable to your laboratory. Quality control material should be run after component
replacement or after aservice call. The KX-21 hastwo quality control methods.

1.1 X Control

In X control, control blood is analyzed twice and the mean of the two is used to evaluate
analyzer performance.

1.2 Levy-Jennings Control (L-J)

The L-J control uses the data from a single control blood analysisto evauated anayzer
performance.

NOTE: » Selection of the one of the two methods can be performed using QC
method in the QC Settings program. Rrefer to "Chapter 10, Section 5:
QC Settings."
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1.3 QC Chart Screen

When the QC program is executed, the QC Chart screen appearsfirst. The QC Chart screen
displays a QC chart selected from six QC Files. Just after execution of the QC Chart
program, File No. 1 Control Chart appears. Its Menu Display Areadisplays"1: QC
Analyze" "2: Settings,” and "3: Erase All." The menu can be executed using the numeric
keys.

The QC Chart can display QC data up to the latest 60 points. When anew data comesin, the
oldest datais erased.

The control parametersindicated in the QC Chart are CBC8 parameters displayed on three
pages.

[A] key or [¥] key can be used to change over the screen.

P1. QC Chart Screen [1/3] «—> P2. QC Chart Screen [2/3] «—»/P3. QC Chart Screen [3/3]
F WBC, RBC, HGB HCT, MCV, MCH MCHC, PLT ‘—‘

Figure 5-1-1: Page Selection in QC Chart Screen

FILE No. 1
(N=30) 31/12 LIMT DATA
| (MEAN)

UL--moeemmimmcieend beoeenoenone 8.1

WBC 7.6 7.3
i ECCEEEEEEEEES 7.1( 7.8)
O S — 4.70

RBC 4.50 4.52
R SR 4.30( 4.55)
O AR it 15.5

HGB =+ 15.0 14.8
R 14.5( 15.0)

1: QC Anal yze 2: Settings 3:Erase Al

Figure 5-1-2: QC Chart Screen

The QC Chart screen displays QC data as shown below:
1) FILE No.
FILE No. of QC Chart displayed on the screen

2)  Control parameter
Analysis parameters of control data (CBC8 parameters) are displayed on three pages:
QC Chart screen [1/3]: WBC, RBC, HGB
QC Chart screen [2/3]: HCT, MCV, MCH
QC Chart screen [3/3]: MCHC, PLT

3) N
The number of control data plotted currently. In the case of X control, the average
represents a data.
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4) LIMIT (UL)
The upper control limit. Ananalysisvalue exceeding thislimitisaQC error.

5) LIMIT (LL)
Thelower control limit. An analysis value exceeding thislimitisaQC error.

6) Target value
QC Target vdue

7) DATA
The QC data of the plot specified by the vertical line cursor. In the case of X control, it
is the mean value of two consecutive analyses.

8 MEAN
The mean of QC data plotted currently

9) LineCursor
The vertical line cursor can be moved to theright or left using [ <] key or [P>] key.
The QC data of the plot shown by the line cursor, along with analysis date, are

displayed.
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2. QC ANALYSIS PROCEDURE
2.1 QC Analysis Procedure Flow Chart

(Execute QC program  p Page 5—5)

\

Select QC File » Page 5-5

YES Erase All QC Data
New QC
p Page 5-6

NO
Set TARGET Values/

~T

LIMIT Values
P Page 5-7

Execute X Control Execute L-J Control
P Page 5-9 p Page 5-18
Delete QC Data Print HC Output
P Page 5-25 P Page 5-27 P Page 5-29

v,

CExit from QC Program pPage 5-24)

Figure 5-2-1: QC Analysis Procedure Flow Chart
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2.2 Execute QC Program

(1) Press[SELECT] key in the Ready status. The Select Menu screen appears.
(2) Using [A] key or [ ¥] key, move the cursor to select "2: Quality Control."
(3) Press[ENTER] key. The QC Chart screen appears.

FILE No. 1
(N=30) 31/12 LIMT DATA
| (MEAN)

UL--omeimmmi o 8.1

WBC 7.6 7.3
i ECCEEEEEEEEES 7.1( 7.8)
O S — 4.70

RBC 4.50 4.52
R SR 4.30( 4.55)
O AR it 15.5

HGB =+ 15.0 14.8
R 14.5( 15.0)

1: QC Anal yze 2: Settings 3:Erase Al

Figure 5-2-2: QC Chart Screen
2.3 Select QC File

Thisinstrument stores six QC Files. To execute QC analysis, settings, file erasing, or HC
output, display the QC Chart screen for adesired file asfollows.

How to Select QC File
(1) Press[SAMPLE No.] key on the QC Chart screen.

This causes the FILE No. in the system status area to be reverse-displayed and ready
for entry of File No.

FrLE No.

Figure5-2-3: Entry of File No.

(2) Thecursor comesto right of the FILE No. Use the numeric keysto enter aFILE No.

NOTE: * In entering a File No. (in the status of the above screen). Press [C]
key first to clear it and enter a new FILE No.
* Pressing [C] key erases the character and causes the cursor to move
to the left.
» Numerics of 1 - 6 can be entered as a FILE No. Any other humerics
cannot be entered.
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(3 Press[ENTER] key. The QC Chart screen for the selected QC file appears.

NOTE: * When no FILE No. is present, [ENTER] key is not accepted. When
you attempt to do so, an alarm sounds.
* When you press [SAMPLE No.] key or [SELECT] key in the status of
waiting for FILE No. input, the system cancels change of QC File and
returns to the previous QC Chart screen.

FILE No. 1
(N=30) 31/ 12 LIMT DATA
| (MEAN)

U beoeenoenone 8.1

wBC 7.6 7.3
R 7.1( 7.8)
UL -omeimmmmmm e 4.70

RBC 4.50 4.52
R SR 4.30( 4.55)
U boonnennenna 15.5

HGB s 15.0 14.8
R 14.5( 15.0)

1: QC Anal yze 2: Settings 3:Erase Al

Figure5-2-4: QC Chart Screen

2.4 Erase All

To start quality control newly, the control datain the QC File hasto be erased. When a

control blood lot has changed, use the menu of "3: Erase All" to erase all control datain the
QCFile.

How to Erase All QC Data
(1) Display the QC Chart screen for the QC File you want to erase.
For how to select the QC File, refer to Section 2.3: Select QC File in this chapter.

(2) Press[3] key to select "3. Erase All." The Erase All Confirmation message appears.

K to erase all? Yes .!’

Figure 5-2-5: Erase All Confirmation M essage
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(3) Using [« key or [»] key, move the cursor to select "Yes' or "No."
[Yes]: Erasesthe plot display on the QC Chart screen and displays the second Erase
All Confirmation message.
[No]: Cancelsthe erasing of the plot display on the QC Chart screen and returnsto
the QC Chart screen.

Al are erasing. _ Execute m._l

Figure 5-2-6: Second Erase All Confirmation M essage

(4) Using [ <] key or [»] key, move the cursor to select "Execute” or "Cancel."
[Execute]: Completely erases QC data and returns to the QC Chart screen.
[Cancel]: Cancels QC data erase and returns to the QC Chart screen.

(5 Press[ENTER] key to execute the selected process.

2.5 Set TARGET/LIMIT Values

Before executing Quality Control anew, you haveto set TARGET and LIMIT vauesfor the
QC Fileusing "2: Settings' on the menu.

How to Set QC File
(1) Display the QC Chart screen for the QC File you want to set.
For how to select the QC File, refer to Section 2.3: Select QC Filein this chapter.

(2) Press[2] key to select "2: Settings.”
The QC File Setting screen appears.

FILE No. 1
TARCGET LIMT
(VB B 0.0 xI09uL
RBC 0.00 0.00 x109 pL
HGB 0.0 0.0 g/dL
HCT 0.0 0.0 %
MoV 0.0 0.0 fL
MCH 0.0 0.0 pg
MCHC 0.0 0.0 g/dL
PLT 0 0 x10% pL
Press [SELECT] to exit.

Figure5-2-7: QC File Setting Screen

(3) Using [A] key or [ ¥] key, move the cursor to select control parameters. Eight
parameters can be set.
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(4)
(5)

Using [ <] key or [»] key, move the cursor to select "TARGET" or "LIMIT."

Enter the set values using the numeric keys.

NOTE: * As a set value, up to five digits including decimal point can be entered.

» The decimal point position is linked to the Unit System established in
System Setup. For detall, refer to Chapter 10: INSTRUMENT
SETTING, Section 2: System Setup.

» Each time you press [C] key in the middle of entering, one character
disappears and the cursor moves to the left.

(6)

Press[ENTER] key.
The contents of settings are set and the cursor movesto the next item.

NOTE: « The contents of settings are also set when [A] key, [¥] key, [ 4] key,

or [P>] key is pressed after entering.

(7)

(8)

(9)

When settings are completed, press [SELECT] key. The Setting Confirmation
message appesars.

K to set? SITHEE  Set Cancel
Figure 5-2-8: Setting Confirmation Message

Using [ <] key or [»] key, move the cursor to select "Cont.," "Set,” or "Cancel."

[Cont.]: Returnsto the QC File Setting screen. And the setting operation can be
continued.

[Set]: Updates the settings and returns to the QC Chart screen.

[Cancel]: Cancelsthe changed settings and returns to the QC Chart screen.

Press [ENTER] key to execute the selected process.

NOTE: * QC chart will be drawn only if the TARGET and LIMIT values are both

entered appropriately.

5-8
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2.6 Execute X Control

The X control method for analyzing control blood is described here.

(1) Display the QC Chart screen for the QC Filein which to enter QC data. For how to
select the QC File, refer to Chapter 2.3: Sdlect QC Filein this chapter.

NOTE: » QC analysis is executed by control method (X control or L-J control)
set in QC Settings. For setting procedures, refer to Chapter 10,
Section 5: QC Settings.
« While the X Control Analysis screen is displayed, the QC File cannot
be changed.

(2) Press[1] key to select "1: QC Analyze." The X Control Analysis screen appears.

FILE No. 1 (8 oo |
Ready
X1 X2

X Judgenent

Figure 5-2-9: X Control Analysis Screen

NOTE: * QC analysis is made in the whole blood mode. When the pre-diluted
mode is selected as analysis mode, the Mode Change Sequence is
activated to change over to the whole blood mode.

(3) Confirm that "Ready" isdisplayed for QC analysis.

* In analyzing control blood, always wear rubber gloves. After
WARNING . . -
completion of work, wash the hands with disinfectant. If your hands
are contaminated by blood, etc., infection of pathogenic bacteria can
occur.
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(4) Mix control blood sufficiently.

Figure 5-2-10: Mixing the Control Blood

(5) Removethe cap whiletaking care not to alow blood to scatter.

Q

Figure 5-2-11: Removing the Cap

(6) Set the control blood container to the sample probe and press the start switch in that
status.

Start switch

Figure 5-2-12: Pressing the Start Switch

(7)  When the buzzer sounds two times - beep, beep, - and "Analyzing” is displayed on the

X Control Analysis screen, remove the control blood container. Then, automatic
analysisis executed.
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The screens from the start to the end of analysis are as shown below.

(Ready)
FILE No. 1 CHIEEEEES
Ready
(Aspirating)
FILE No. 1 | CHIEEEEES
Aspirating
(Anayzing)
FTLE No. 1 s »»»>
—— Anal yzing
(Rinsing)
FILE No. 1 [ >
— R nsi ng

Figure 5-2-13: X Control Analysis Screen

» While the screen is displaying "Aspirating,” keep holding the control
&CAU-“ON blood container in the aforementioned status. If the container is
removed during its display, correct analysis may not be obtained.

CAUTION:  Several seconds after the buzzer sounds "beep, beep" and
"Analyzing" appears on the screen, the rinse cup lowers. Remove the
control blood container by that time.

» To remove the container, lower it straight down. Take care not to bend
the sample probe.

NOTE: » The sample probe is automatically rinsed, so there is no need to wipe it
clean.
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(8 Under the"X1" column on the Analysis Result screen, the 1st time analysisresult is
displayed.
The anaysis result comprises three screens which can be changed over by pressing
[ 4] key or [»] key.

’—> P1. CBC8 Parameter Screen«—» P2. WBC Screen «—» P3. RBC/PLT Screen 4—‘

Figure 5-2-14: Page Selection in QC Analysis Result Screen

FILE No. 1 | QC]
X1 X2 X Judgenent
VBC 7.3
RBC 4.52
HEB 14.8
HCT 36.2
MV 80.1
MCH 32.7
MCHC  40.9
PLT 206
Accept Data?
1. K 2: NG 3:Print

Figure 5-2-15: P1. CBC8 Parameter Screen

FITE No. I QC
No. QU01- 1 31/12 10: 02
o ~ VBC 7. 3x10% L
LYMbo 27. 2%

VBC| |
; MXDY% 13. 4%
NEUT%  59. 4%
LYM 2. 0x10%/ L
XD 1. 0x10% pL
NEUT# 4. 3x10%/ L

W SW 56. 3f L

Accept Data? WLMW 172 4fL
1. K 2: NG 3:Print
Figure 5-2-16: P2. WBC Screen
FTLE No. 1 =
No. QC01- 1 31/12 10: 02
RBC 4. 52x10°8/ pL

ROWCV  11. 4%

RBC VoY, 80. 1f L
B . RDWSD 27.4fL

PLT
PLT 206x10°% pL
PDW 8.3fL
MV 9. 1f L
P-LCR 14. 8%

Accept Data?

1: K 2: NG 3:Print

Figure 5-2-17: P3. RBC/PLT Screen
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If the data is acceptable, press[1] key to confirm. Press[2] key to regject.
Press[3] key and select "3: Print" to print the contents of analysis result on the built-in
printer.

[No: 1-1
Date 31/12/97 10: 02
Mde QC
VBC 7.3 x10% pU
RBC 4.52 x10°/ pL
HGB 14.8 g/ dL
HCT 36.2 %
MoV 80.1 fL
MOH 32.7 Pg
MCHC 40.9 g/ dL
PLT 206 x10% L
i WBC
[f1]
LYM6 27.2 %
MXD% 13.4 %
NEUT% 59.4 %
LYMt 2.0 x10% pL
VKD 1.0 x10% pL
NEUT# 4.3 x10% pL
W SW/ 56.3 fL
W LW 172. 4 fL
M RBC
[f1]
RDW CV 11.4 %
RDW SD 27.4 fL
PLT
[f1]
PDW 8.3 fL
MPV 9.1 fL
P- LCR 14.8 %

Figure 5-2-18: Example of Analysis Result Printing

NOTE:

* Print of analysis result is valid until the data is set. If the data is set by
pressing [1] key or [2] key, analysis result cannot be printed.
* This print format cannot be changed since it is the special format for QC

analysis.
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(9)

Set the datausing [1] key or [2] key.

[1: OK]: Accepts anaysisresult asthe 1st time QC data. And the system turns to be
ready for the 2nd analysis.

[22 NG]: Cancelsthe 1t time analysisresult. And the system remainsto be ready for
another 1st time analysis.

CAUTION: * When an error occurs during QC analysis, error message is displayed

in the system status area.

Analysis data in which error occurred is masked, which cannot be
accepted as QC data. When you press [1] key to select "1: OK" in
response to the data confirmation screen, the alarm sounds and "1: OK"
is unacceptable.

Press [HELP] key and perform the error recovery process. For the error
recovery process, refer to Chapter 7: TROUBLESHOOTING.

(10)

(11)

When you press [SELECT] key before setting the 1st QC data, the QC Cancel
Confirmation message is displayed.

K to _cancel ? Yes [ No |
Figure 5-2-19: QC Cancel Confirmation M essage

Using [ <] key or [™] key, move the cursor to select "Yes' or "No."

[Yes]: Reectsanalysisresult, exits from QC program, and returnsto the Analysis
screen.

[No]: Returnsto the QC Analysis screen and allows continuous QC analysis.

Press [ENTER] key to execute the selected process.

When the 1st analysis data is accepted, the (3) - (7) procedure is repeated for the 2nd
analysis.

The 2nd analysisresult is displayed under "X2" on the Analysis Result screen, the
mean values of the 1st and the 2nd analyses under "X," and the comparison result with
control limits under the "Judgment” column.

The Analysis Result screen, asin the 1st analysis, can be changed over using [ ] key
or [] key.

The data confirmation message is displayed and you are asked to decide whether or not
to accept the analysis result as QC data.

5-14
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FILE No. 1 |QC)
X1 X2 X Judgenent
WBC 7.3 7.5 7.4
RBC 4.52 4.49 4.51
HEB 14.8 14.7 14.8
HCT 36.2 35.6 35.9
MoV 80.1 79.3 79.7
MCH 32.7 32.7 32.7
MCHC  40. 41.3 41.1
PLT 206 209 208
Accept Data?
1. K 2: NG 3: Print

Figure 5-2-20: Analysis Result Screen

A parametersin which the mean of the 1st and the 2nd analyses fell outside the control
limitsisindicated with K or ® under the "Judgment” column, while the alarm sounds

and the QC error message appears.
FILE No. 1 Y =TI |
X1 X2 X Judgerent

VBC 7.3 7.5 7.4
RBC  4.52 4.49 4.51
HGB  14.8 14.7 14.8
HCT  42.5 43.0 42.8 +
MV  94.0 95.8 94.9 +
MH  32.7 32.7 32.7
MCHC 34.8 34.1 34.5
PLT 106 109 108

Accept Data?

1: XK 2: NG 3: Print

Figure 5-2-21: QC Error Message Screen

(12) Setthedatausing[1] key or [2] key.

[1: OK]: QC datais accepted and the plot is entered to the QC Chart. This QC data

(mean)

is kept in the stored data a so.

[2: NG]: Cancelsthe 2nd analysisresult. And the system remainsto be ready for the

2nd analysis again.

CAUTION:

* When an error occurs during QC analysis, the error message appears
in the system status area. The analysis data in which the error
occurred is masked, which does not undergo mean calculation or
judgment, and is not accepted as QC data.

When you press [1] key to select "1: OK," in response to the data
confirmation screen, the alarm sounds and "1: OK" cannot be accepted.
Press [HELP] key and perform the error recovery process. For the error
recovery process, refer to Chapter 7: TROUBLESHOOTING.
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(13) When the built-in printer is specified for the output device, the set data (mean) is
printed on the built-in printer.

: Q0T
Date 31/12/97 10:02

7.4 x10°/ L
4.51 x10° pL
14.8 g/ dL
35.9 %
79.7 fL
32.7 Pg
41.1 g/dL
208 x10°%/ L

%
%
%
x10% uL
x10%/ L
x10%/ L
fL
fL
%
fL
fL
fL
%

OFRPWARADWWOODMDMN

Figure 5-2-22: Example of Printing

NOTE: * Printing in QC settings is valid only when the "Built-in Printer" is
selected. For detail, refer to Chapter 10, Section 5: QC Settings.
* This print format cannot be changed since it is the special format for QC
analysis.

(14) When the serial interface (option) isincorporated, set data (mean) is output to the host
compulte.

NOTE: » Transmission to the host is valid only when the "Host Output” is
selected. For detall, refer to Chapter 10, Section 5: QC Settings.
* As to the host output format, refer to Appendix B: Technical Information.
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When you press [SELECT] key before setting the 2nd QC data, the QC Cancel
Confirmation message appears.

CK to cancel ? Yes .!’
Figure 5-2-23: QC Cancel Confirmation M essage

Using [ <] key or [»] key, move the cursor to select "Yes' or "No."

[Yes]: Regectsanalysis result, exists from the QC program, and returns to the Analysis
screen.

[No]: Returnsto the QC Analysis screen and allows continuous QC analysis.

Press[ENTER] key to execute the selected process.
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2.7 Execute L-J Control
How to analyze control blood by L-J control is described here.

(1) Display the QC Chart screen for the QC File in which to enter QC data. For how to
select the QC File, refer to Chapter 2.3: Salect QC Filein this chapter.

NOTE:  QC analysis is executed by control method (X control or L-J control)
set in QC Settings. For setting procedures, refer to Chapter 10,
Section 5: QC Settings.
» While the L-J Control Analysis screen is displayed, the QC File cannot
be changed.

(2) Press[1] key to select "1: QC Analyze." The L-J Control Analysis screen appears.

FILE No. L | CHIEEE I
Ready

Dat a Judgenent

Figure5-2-24: L-J Control Analysis Screen

NOTE: * QC analysis is made in the whole blood mode. When the pre-diluted
mode is selected as analysis mode, the Mode Change Sequence is
activated to change over to the whole blood mode.

(3) Confirm that "Ready" isdisplayed for QC analysis.

AWARNING *In analy_zing control blood, always wear ru_bk_)er gloves. After
completion of work, wash the hands with disinfectant. If your hands
are contaminated by blood, etc., infection of pathogenic bacteria can
occur.
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(4) Mix control blood sufficiently.

Figure 5-2-25: Mixing the Control Blood

(5) Removethe cap whiletaking care not to alow blood to scatter.

Q

Figure 5-2-26: Removing the Cap

(6) Set the control blood container to the sample probe and press the start switch in that
status.

Start switch

Figure 5-2-27: Pressing the Start Switch

(7)  When the buzzer sounds two times - beep, beep, - and "Analyzing” is displayed on the
L-JControl Analysis screen, remove the control blood container. Then, automatic
analysisis executed.
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The screens from the start to the end of analysis are as shown below.

(Ready)
FILE No. 1 [fs o>
Ready
(Aspirating)
FILE No. 1 [ o>
Aspirating
(Anayzing)
FILE No. 1 s »»rCo>
——  Anal yzing
(Rinsing)
FILE No. 1 [ >
— R nsi ng

Figure 5-2-28: L-J Control Analysis Screen

C oN " While the screen is displaying "Aspirating,” keep holding the control
L i \CAUTION " pjo0d container in the aforementioned status. If the container is
removed during its display, correct analysis may not be obtained.

CAUTION: » Several seconds after the buzzer sounds "beep, beep" and
"Analyzing" appears on the screen, the rinse cup lowers. Remove the
control blood container by that time.

» To remove the container, lower it straight down. Take care not to bend
the sample probe.

NOTE: » The sample probe is automatically rinsed, so there is no need to wipe it
clean.

5-20
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(8)

Analysisresult is given under the "Data" column on the Analysis Result screen and

comparison result with QC limits under the "Judgment” column.
The analysis result comprises three screens which can be changed over by pressing
[ 4] key or [»>] key.

P1. CBC8 Parameter Screen<—»

P2. WBC Screen

—» P3. RBC/PLT Screen

-

:

Figure 5-2-29: Page Selection in QC Analysis Result Screen

FILE No. 1 | QC|
Dat a Judgenent
WBC 7.3
RBC 4.52
HEB 14.8
HCT 36.2
MoV 80.1
MCH 32.7
MCHC 40.9
PLT 206
Accept Data?
1. XK 2: NG 3:Print

Figure 5-2-30: P1. CBC8 Parameter Screen

FITE No. T | QC
No. QC01-1 31/12 10: 02
o WBC 7. 3x10°%/ pL

WBC | i W LYMo 27. 2%
MXD% 13. 4%
NEUT% 59. 4%
LYMt 2. 0x10%/ pL|
VKD# 1. 0x10% pL
NEUT# 4, 3x10°% L
W SW 56. 3f L

Accept Data? W LW 172. 4f L

1. XK 2: NG 3:Print

Figure 5-2-31: P2. WBC Screen

FICE No. 1 | QC]
No. QC01-1 31/12 10:02
. RBC 4. 52x105/ L
RBC i i oMV 80. 1f L
L i RDWSD 27.4fL
‘ ROWCV 11.4%
PLT /\/
i PLT 206x10°%/ pL|
PDW 8.3fL
MPV 9.1fL
P-LCR 14. 8%
Accept Data?
1. XK 2: NG 3:Print

Figure 5-2-32: P3. RBC/PLT Screen
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As to those parameters whose analysis fell beyond control limits, & or ® js displayed
under the "Judgment" column, while the alarm sounds with the QC error message

displayed.
ENcE R CHC Error
Dat a Judgenent

WBC 7.5
RBC 4.49
HEB 14.7
HCT 43.0 +
MV 95.6 +
MCH 32.7
MCHC 34.1
PLT 109

Accept Data?

1. K 2: NG 3:Print

Figure 5-2-33: QC Error Message Screen

If the data is acceptable, press[1] key to confirm. Press[2] key to reject.
Press[3] key and select "3: Print" to print the contents of analysis result on the built-in

prlnter.
NG. 08041
Date 31/12/97 10:02
Mbde QC
VBC 7.3 x10% pL
RBC 4.52 x10% pL
HB 14.8 g/ dL
HCT 36.2 %
MoV 80.1 fL
MCH 32.7 Py
MCHC 40.9 g/ dL
PLT 206 x10% pL
aum
[f1]
LYMo 27.2 %
MXD% 13.4 %
NEUT% 59.4 %
LYMt 2.0 x10¥ L
VKD 1.0 x10¥ pU
NEUT# 4.3 x10% L
W SW 56.3 fL
W LW 172.4 fL

VAN
[f1]

RDW CV 11.4 %
RDW SD 27.4 fL

HAL )

[f1]

PDW 8.3 fL
MPV 9.1 fL
P-LCR 14.8 %

Figure 5-2-34: Example of Analysis Result Printing
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CAUTION: * Print of analysis result is valid until the data is set. If the data is set by
pressing [1] key or [2] key, analysis result cannot be printed.
* This print format cannot be changed since it is the special format for QC
analysis.

(9) Setthedatausing[1] key or [2] key.
[1: OK]: SetsQC data, and the plot is entered to the QC Chart. This QC datais kept

in the stored data.
[2: NG]: Cancelsthe analysisresult, and the system remains to be ready for another
analysis.
CAUTION: » When an error occurs during QC analysis, error message is displayed

in the system status area.

Analysis data in which error occurred is masked, which cannot be
accepted as QC data. When you press [1] key to select "1: OK" in
response to the data confirmation message, the alarm sounds and "1:
OK" is unacceptable.

Press [HELP] key and perform the error recovery process. For the error
recovery process, refer to Chapter 7: TROUBLESHOOTING.

(10) The set datais printed.

. Q0T
Date 31/12/97 10:02

7.3 x10¥ pL
4.52 x108/ pL
14.8 g/ dL
36.2 %
80.1 fL

Pg
40.9 ¢/ dL
206 x10% pL

%
%
%
x10%/ L
x10% uL
x10% uL
fL
fL
%
fL
fL
fL
%

OFRPWhbhbhwWwwoopr~rhAN

Figure 5-2-35: Example of Printing
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NOTE: * Printing in QC settings is valid only when the "Built-in Printer” is
selected. For detail, refer to Chapter 10, Section 5: QC Settings.
* This print format cannot be changed since it is the special format for QC
analysis.

(11) When the serid interface (option) isincorporated, set datais output to the host
compulte.

NOTE: » Transmission to the host is valid only when the "Host Output" is
selected. For detail, refer to Chapter 10, Section 5: QC Settings.
* As to the host output format, refer to Appendix B: Technical Information.

When you press [SELECT] key before setting the QC data, the QC Cancel
Confirmation message appears.

K to cancel ? Yes [ No |
Figure 5-2-36: QC Cancel Confirmation M essage

Using [ <] key or [»] key, move the cursor to select "Yes' or "No."

[Yes]: Reectsanaysisresult, exist from the QC program, and returnsto the Analysis
screen.

[No]: Returnstothe QC Analysis screen and allows continuous QC analysis.

Press [ENTER] key to execute the selected process.

2.8 Exit from QC Control Program

(1) Press[SELECT] key on the QC Chart screen. The Analysis screen returns.

NOTE: » The sample No. and analysis mode on the Analysis screen return to
those displayed before execution of the QC program.
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3. DELETION

Using this menu, QC datain the line cursor position can be deleted.

How to delete QC Data
(1) Display the QC Chart screen of QC file that contains the data you want to delete.
For how to select QC file, refer to Chapter 2.3: Sdlect QC File in this chapter.

(2) Using [ 4] key or [»] key, move the line cursor to the position of the datato be
deleted.

FILE No. 1
(N=30) 31/12 LIMT DATA
| (MEAN)

UL --immme b 8.1

WBC 7.6 7.3
R 7.1( 7.8)
UL -emmmms oot 4.70

RBC 4.50 4.52
s S 4.30( 4.55)
O AreEs SRR 15.5

HGB = 15.0 14.8
T 14.5( 15.0)

1: QC Anal yze 2:Settings 3:Erase Al

Figure5-3-1: QC Chart Screen

(3) Press[ENTER] key.
The line cursor changes from dotted line to solid line, and the menu in the Menu
Display Areachangesover to "1: Delete,” "2: Print," "3: HC Output.”

NOTE: » Press [ENTER] key again, and the line cursor returns to dotted line and

the menu in the Menu Display Area change to the original status.

* The line cursor that has changed to solid line cannot be moved.

* "3: HC Output" on the menu is displayed only when the serial interface
(option) is incorporated.

FILE No. 1
(N=30) 31/ 12 LIMT DATA
(MEAN)

UL---mmmmmmmmmom e mem oo 8.1

WBC 7.6 7.3
R B 7.1( 7.8)
UL- - mmmm e 4.70

RBC 4.50 4.52
R B 4.30( 4.55)
O RCLCCTErt (EEEREEPIRRERE 15.5

HEB 15.0 14.8
R 14.5( 15.0)

1:Delete 2: Print 3: HC Qut put

Figure 5-3-2: Deletion Menu Screen
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(4) Press[1] key to select "1: Delete.”
The Deletion confirmation message appears.

K to Delete? Yes .!’

Figure 5-3-3: Deletion Confirmation M essage

(5) Using [ 4] key or [»] key, move the cursor to select "Yes' or "No."
[Yes]: Deletes QC data of the plot shown by the line cursor and returns the line cursor
to the dotted line.
[No]: Cancelsdeletion of QC data and returns the line cursor to the dotted line.

(6) Press[ENTER] key to execute the selected process.
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4. PRINT

Using this menu, QC data in the line cursor position can be printed out from the built-in

printer.

How to print QC Data

(1) Display the QC Chart screen of QC file that contains the data you want to print.
For how to select QC file, refer to Chapter 2.3: Sdlect QC File in this chapter.

(2) Using [ 4] key or [»] key, move the line cursor to the position of the datato be

printed.

FILE No. 1
(N=30) 31/ 12 LIMT DATA
(MEAN)

L SRRTCEEE SETERTSELERR 8.1

WBC 7.6 7.3
T 7.1( 7.8)
UL--eemmmme o 4.70

RBC 4.50 4.52
[ 4.30( 4.55)
L 15.5

HEB 15.0 14.8
L 14.5( 15.0)

1: QC Anal yze 2:Settings 3:Erase Al

Figure 5-4-1: QC Chart Screen

(3) Press[ENTER] key.
The line cursor changes from dotted line to solid line, and the menu in the Menu
Display Areachanges over to "1: Delete,” "2: Print," "3: HC Output.”

NOTE:

» Press [ENTER] key again, and the line cursor returns to dotted line and
the menu in the Menu Display Area change to the original status.

» The line cursor that has changed to solid line cannot be moved.

¢ "3: HC Output" on the menu is displayed only when the serial interface
(option) is incorporated.

FILE No. 1
(N=30) 31/ 12 LIMT DATA
(MEAN)

UL -oommmmemmm e 8.1

WBC 7.6 7.3
LL-mmmmmmmmmmeme oo 7.1( 7.8)
UL -oommmmemmm e 4.70

RBC 4.50 4.52
I ERCRLRCEEED IELEELEEEEER 4.30( 4.55)
L 15.5

HEB 15.0 14.8
[ 14.5( 15.0)

1:Del ete 2: Print 3: HC Qut put

Figure 5-4-2: Print Menu Screen
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(4) Press[2] key to sdlect "2: Print."
The Built-in Printer prints QC data of the plot shown by the line cursor.

Contents of Print

Q00T —- File No.
10: 02— Date/Time Analyzed
Analysis Mode

x10%/ L
x10%/ pL
o/ dL
%

fL

Pg
g/ dL
x10%/ pL

Figure 5-4-3: Contents of Print

1) File No.
File No. of QC fileis printed.

2) Analysis Mode
In the case of QC data, "QC" is printed.

3) Date/Time Analyzed
Printed is the date and time when analysis result was obtai ned.

NOTE: * Printout from the stored QC Chart is only CBC8 parameters. “
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5. HC OUTPUT (OPTION)

Using this menu, QC datain the line cursor position can be output to the host computer
(option).

How to output QC Datato HC

(1) Display the QC Chart screen of QC file that contains the data you want to output to the
host computer.

For how to select QC file, refer to Chapter 2.3: Sdlect QC File in this chapter.

(2) Using [ 4] key or [»] key, move the line cursor to the position of the data you want
to output to HC.

FILE No. 1
(N=30) 31/12 LIMT DATA
| (MEAN)

UL --eemmmmememniies  RREGEEEt 8.1

WBC 7.6 7.3
R 7.1( 7.8)
UL -emmmms oot 4.70

RBC 4.50 4.52
s S 4.30( 4.55)
O R 15.5

HGB -+ 15.0 14.8
T 14.5( 15.0)

1: QC Anal yze 2:Settings 3:Erase Al

Figure 5-5-1: QC Chart Screen

(3) Press[ENTER] key.
The line cursor changes from dotted line to solid line, and the menu in the Menu
Display Areachanges over to "1: Delete," "2: Print," "3: HC Output.”

NOTE: * Press [ENTER] key again, and the line cursor returns to dotted line and
the menu in the Menu Display Area change to the original status.
 The line cursor that has changed to solid line cannot be moved.
« "3: HC Output" on the menu is displayed only when the serial interface
(option) is incorporated.
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FILE No. 1
(N=30) 31/ 12 LIMT DATA
(MEAN)

UL--omeimmmemmmm b 8.1

wBC 7.6 7.3
R 7.1( 7.8)
UL--ommemmmmmin b 4.70

RBC 4.50 4.52
e R 4.30( 4.55)
U e TSRS 15.5

HGB 15.0 14.8
R 14.5( 15.0)

1:Delete 2: Print 3: HC Qut put

Figure 5-5-2: HC Output Menu Screen

(4) Press[3] key to select "3: HC Output.”
QC data of the plot shown by the line cursor is output to the host computer.

NOTE: » Data that can be output from the QC Chart are only data of CBC8

parameters. All other data are output with "[10000."
For the output format, refer to Appendix B: Technical Information.
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1. INTRODUCTION

Calibration is performed to compensate for any inaccuracies of the pneumatic, hydraulic, and
electric systems which will affect analysisresults. Thisis very important in maintaining the
system accuracy.

Cadlibrationis carried out by entering calibration valuesinto the unit. Y our Sysmex service
representative will perform initial calibration of your unit at installation. After installation,
the operator should make periodical calibration and proper quality control to maintain the
accuracy. This chapter describes calibration procedure.

1.1 Calibration Execution Timing

Calibration need not be performed in specified intervals, but when QC data varies with time,
HGB and HCT should be calibrated. When abnormal QC data occur as aresult of
instrument problem, reagent degradation, or deterioration of control blood, however, do not
perform calibration.

1.2 Samples Used for Calibration

For calibration, use five or more samples of fresh normal blood that meets the following
conditions:

» Blood of ahealthy person who is not taking any medicine
» Blood added with appropriate anticoagul ant

* Per-sample whole blood volume to exceed 2 mL

» HGB valueto exceed 10.0 g/dL

* HCT valueto be within 35.5% - 55.5%

NOTE: * For calibration, do not use EIGHTCHECK-3WP, which was not
prepared for calibration but for the use as control blood.

1.3 Reference Values

Five or more normal blood samples prepared for calibration of HGB and HCT should be
accurately analyzed three times each in accordance with the reference method. The
measurements thus obtained are used as reference values.

HGB vaues: Cyanmethemogl obin method

HCT values. Microhematocrit method

(Five samples are used for automatic calibration.)
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1.4 Calibration Flow Chart

C HGB/HCT calibration start

<

Analyze samples by the reference method to determine

reference value (target value).
Automatic calibration: 5 samples

Manual calibration:  Over 5 samples P Page 6-1
Automatic Manual
calibration calibratioﬂ
Select automatic calibration Analyze in whole blood
program. p Page 6-3 mode. p Page 6-9
Select calibration parameter.
1: HGB Calculate calibration value. » Page 6-9
2: HGB and HCT P 4
3: HCT P Page &-
\/[ Select manual calibration >
Enter target val program. Page 6-10
nter target value. D Page 65
Analyze in whole blood Enter calibration value. P Page 6-11
mode. P Page 6-6
Update calibration value. p Page 6-8 Update calibration value. P Page 6-12

C Completion of HGB/HCT calibration )

6-2
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2. AUTOMATIC CALIBRATION

In automatic calibration, five or more fresh, normal blood samples are used for automatic
calibration of HGB and HCT values.

2.1 Executing Automatic Calibration Program

(1) Press[SELECT] key in the Ready status. The Select Menu screen appears.
(2) Using [A] or [¥] key, move the cursor to select "3: Calibration.”
(3) Press[ENTER] key. The Calibration Menu screen appears.

*Cal i bration*

1: Auto Cal.
2: Manual Cal.

Figure 6-2-1: Calibration Menu Screen
(4) Using [A] or [¥] key, move the cursor to select "1: Auto Cal.”

(5 Press[ENTER] key. The Automatic Calibration Menu screen appears.
*Auto Cal . *

2: H&®/ HCT
3. HCT

Figure 6-2-2: Automatic Calibration Menu Screen

On the Automatic Calibration Menu screen, an automatic calibration parameter can be selected
from among "1: HGB," "2: HGB/HCT," and "3: HCT."

NOTE: » Each menu can be selected directly by entering a numeral from the
numeric keys.
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2.2 Automatic Calibration Procedure

1.  Selecting Automatic Calibration Parameter

(1) Using [A] or [¥] key, move the cursor to select an automatic calibration parameter on
the Automatic Calibration Menu Screen:

[1: HGB]: Calibrates HGB alone.
[2: HGB/HCT]: Calibratestwo parameters of HGB and HCT at the same time.
[3: HCTY: Calibrates HCT alone.

NOTE: » Each menu can be selected directly by entering a numeral from the

numeric keys.

(2) Press[ENTER] key.
The Automatic Calibration screen for the selected parameter appears.

*Auto Cal . *
Tar get Dat a Conpensati on
HCB HEB HEB

1 -

2

3

4

5

Qurrent Cal. (% 100.0
New Cal . (9%

Press [ SELECT] to Set.

Figure 6-2-3: HGB Automatic Calibration Screen

*Auto Cal . *

Tar get Dat a Conpensat i on
HB HCT HEB HCT HEB HCT

GahwWNEF

Current Cal.(%100.0 100.0
New Cal . (%

Press [ SELECT] to Set.

Figure 6-2-4: HGB/HCT Automatic Calibration Screen
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*Auto Cal . *
Tar get Dat a Conpensat i on
HCT HCT HCT

1 -

2

3

4

5

Current Cal. (% 100.0
New Cal . (%9

Press [ SELECT] to Set.

Figure 6-2-5: HCT Automatic Calibration Screen

2.  Entering Target Values

(1) Using the numeric keys, enter the HGB or HCT reference values obtained by the
reference method in the target column.

NOTE: * Press [C] key to delete one letter at a time. “

(2) Press[ENTER] key to fix the entered value and move the reverse display to the next
target column.

Tar get Dat a Conpensat i on
HEB HCT HEB HCT HEB HCT
[

Qurrent Cal.(% 100.0 100.0
New Cal . (%

Press [ SELECT] to Set.

Figure 6-2-6: Entering Target Values

NOTE: * After entering the 5th target value, pressing [ENTER] key does not
move the reverse display to the next target column.
« An entered value can be set also by pressing [A] or [¥] key after
entering the target value.
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(3 Whenadl target values have been entered, press[SELECT] key.
The Target Vaue Setting Confirmation message appears.

K to set? BTl Set  Cancel
Figure 6-2-7: Target Value Setting Confirmation M essage

(4) Using [« or [™] key, move the cursor to select "Cont.," "Set," or "Cancel."
[Cont.]:  Returnsto the status for entering target values. And the setting operation
can be continued.
[Set]: Setstarget values and charges to the Sample Analysis Waiting status.
[Cancel]: Cancelsautomatic calibration and returns to the Analysis screen.

(5 Press[ENTER] key to execute the selected process.

3. Analysisfor Automatic Calibration

(1) When thetarget values are set, the system turns to the Ready status for automatic
calibration analysis.

NOTE: » Automatic calibration analysis is performed in the whole blood mode.
When the analysis mode is set in the pre-diluted mode, the mode
changeover sequence is activated to switch to the whole blood mode.

*Auto Cal . * WB >
Ready

Tar get Dat a Conpensat i on
HEB HT HEB HT HEB HCT
1 12.5 50.0
2 13.0 45.2
3 13.5 51.5
4 11.0 40.8
5 15.0 52.5

Qurrent Cal.(% 100.0 100.0
New Cal . (99

Figure 6-2-8: Automatic Calibration Screen (Before Analysis)

(2) Analyzethe samples used for determining the standard value.
The sample being analyzed is indicated by the underline cursor.
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(3) After completion of analysis, analysis result appears in the data column and
compensation rate in the compensation column, then the underline cursor movesto the
next sample. Upon completion of more than one sample, average compensation rate is
automatically calculated and displayed at the bottom of the compensation column.

*Auto Cal . * B o
Ready

Tar get Dat a Conpensat i on
HB HCT HEB HCT HB  HCT
12.5 50.0 13.0 48.0 96.2 104.2
13.0 45.2 13.7 43.9 94.9 103.0
13.5 51.5 14.1 50.0 95.7 103.0
11.0 40.8
15.0 52.5

G WN -

95.6 103.4
Qurrent Cal. (% 100.0 100.0
New Cal . (9

Figure 6-2-9: Automatic Calibration Screen (After Analysis)

CAUTION: * When an error occurs during automatic calibration analysis, the error
message appears in the system status display area. The result of
analysis in which an error has occurred is masked with "---.-," which is
not calculated for compensation rate and not used for average
compensation rate calculation, either.

« If "0" is input to the target value, compensation rate for the sample is
not calculated and the analysis result is not used for average
compensation rate calculation, either.
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4.  Updating Calibration Value

(1) Whenal analyses are finished, press [SELECT] key.
New compensation values will be calculated and the Calibration Vaue Change
Confirmation message will appear.

Change? Yes .!’

Figure 6-2-10: Calibration Value Change Confirmation M essage

NOTE: » The new compensation value is calculated as follows:

New compensation _ Current compensation value (%) x Average compensation rate (%)
value (%) 100

* When the compensation rate exceeds the following range, "Calibration
Error" is displayed and the Calibration Value Change Confirmation
message does not appeatr.

Average compensation rate > 105%
Average compensation rate < 95%
New compensation value > 120%
New compensation value < 80%

*Auto Cal . * Calibration Error

Figure 6-2-11: Calibration Error Message

About calibration errors, refer to Chapter 7: TROUBLESHOOTING.

(2) Using [« or [™], move the cursor to select "YES' or "NO."
[YES]:  Updatesthe calibration value and returnsto the Analysis screen.
[NO] : Does not update the calibration value and returns to the Analysis screen.

(3 Press[ENTER] key to execute the selected process.

6-8 Sysmex KX-21 Operator’s Manual -- Revised October 1998



CALIBRATION

3. MANUAL CALIBRATION

In manual calibration, calculated calibration value can be entered using the numeric keys.

3.1 Calculating Calibration Value

(1) Anayze more than five samples, each three times, by the reference method and average
HGB and HCT values.

(2) Gently mix the same samples sufficiently and analyze them in the whole blood mode.
(3) Whenthereisadifference between data gained by analysis with thisinstrument and the

reference value gained by the reference method, use the following formulato calculate
the new calibration value:

Average of values gained
New calibration — Previous . by reference method
value calibration value Average of values gained

by this instrument

[Example]

Average of HGB values gained by the reference method = 15.6 g/dL
Average of HGB values gained by thisinstrument = 15.5 g/dL
Previous calibration value of HGB = 100.0%

15.6 .
—=-=100.65 = 100.7%
100.0 x 155 00.65 = 100.7%

Therefore, the new calibration value of HGB needs to be set at 100.7%. This means
that the calibration value increased 0.7%.
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3.2 Manual Calibration Procedure

(1) Press[SELECT] key in the Ready status. The Select Menu screen appears.
(2) Using [A] or [¥] key, move the cursor to select "3: Calibration.”

(3) Press[ENTER] key. The Calibration Menu screen appears.

*Cal i bration*

1: Auto Cal.
2: Manual Cal.

Figure 6-3-1: Calibration Menu Screen
(4) Using [A] or [¥] key, move the cursor to select "2: Manual Cal."
(5) Press[ENTER] key. The Manual Calibration screen appears.

*Manual Cal . *

HGB| 100. 0
HCT 1

Press [SELECT] to exit.

Figure 6-3-2: Manual Calibration Screen

NOTE: » Each menu can be selected directly by entering a numeral from the
numeric keys.
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1. Entering Calibration Value
(1) Using [A] or [¥] key, move the cursor to select "HGB" or "HCT."

(2) Using the numeric keys, enter the calibration value obtained by calculation.

NOTE: * Press [C] key to delete one letter at a time. “

(3 Press[ENTER] key to set the entered value and move the reverse display to the next
parameter.

*Manual Cal . *

HGB 100. 7
100. 0

Press [SELECT] to exit.

Figure 6-3-3: Entering Calibration Value

NOTE: « An entered value can be set also by pressing [A] or [V] key after
entering the calibration value.
« If no input is made or a space is input, it cannot be set.
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2. Updating Calibration Value

(1) Whenall calibration values are entered, press [SELECT] key.
The Calibration Vaue Change Confirmation message appears.

Change? Yes .!’

Figure 6-3-4. Calibration Value Change Confirmation Message

NOTE:

* When there is no calibration value changed, the Calibration Value Change
Confirmation message is not displayed and the system returns to the
Analysis screen.

* When the compensation rate exceeds the following range, "Calibration
Error" is displayed and the Calibration Value Change Confirmation
message does not appear.

Average of values gained by reference method
Average of values gained by this instrument

Compensation rate > 105%
Compensation rate < 95%

New compensation value > 120%
New compensation value < 80%

*Manual Cal . * Calibration Error

Compensation rate = X 100

Figure 6-3-5: Calibration Error Message

About calibration errors, refer to Chapter 7: TROUBLESHOOTING.

(2) Using [« or [™], move the cursor to select "YES' or "NO."
[YES]: Updatesthe calibration value and returnsto the Analysis screen.

[NOJ:

Does not update the calibration value and returns to the Analysis screen.

(3 Press[ENTER] key to execute the selected process.
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TROUBLESHOOTING

1. INTRODUCTION

If the running instrument devel ops any symptom that you suspect to be atrouble, check it
making reference to "2. WHEN YOU SUSPECT A TROUBLE" which begins from the next
page. When there is not any item that confirms to the trouble in question or if "Action"” fails
to eliminate the symptom, contact your Sysmex service representative for assistance.

When atrouble occurs, the instrument displays an error message on the LCD screen. When
there occurs an error unigque to a sample analyzed, analysis datais displayed with aflag.
This chapter describes the cause of atrouble on which an error message is displayed, along
with actions that the customer can take in checking and repairing.

HELP Function

When atrouble has occurred, the warning alarm sounds and an error message is displayed
on the screen. By pressing [HEL P] key on the panel keyboard, you can stop the alarm and
change over to the HEL P screen that shows what action to take against the error.
Supplementary explanation for that function is given here.

In the event multiple errors occur at the sametime, press [HELP] key. The errors that have
occurred are listed in the order from higher priority.

* Hel p*

Mil tiple errors occurred.

Pressure/ Vac Error
R nse Motor Error
Waste Not Draining
Sanpling Error
Room Tenp. H gh

Press[HELP] for nore infornation.

Figure 7-1-1: Help Screen (Error List)

Press[HELP] key again. The screen changes to the HEL P screen for the error listed at top.

NOTE: * When you contact your Sysmex service representative, inform him of
"ERR CODE" given on the HELP screen. By doing so, you can inform
him of the instrument's status easier and more correctly.

AWARNING « When you repair in accordance with TROUBLESHOOTING, be sure
to turn the power OFF except when you have to confirm displays and
instructions on the screen.

If you repair with the power turned ON, you have a risk of electric
shock hazard and you may give a permanent damage to electric parts.
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2.

WHEN YOU SUSPECT A TROUBLE

. Turning the power ON does not start the

unit.

* Is the power cord connected securely?
* Isn't the fuse blown?

Refer to Chapter 4, Section 8.2: Replace Fuse.
* |Is the power supplied to AC outlet?

. When the power is ON, nothing is

displayed and "beep" keeps sounding.

e There is a possibility that memory error has occurred.
Turn OFF the power, and turn it ON again 1 - 2
minutes later.

. The screen displays nothing.

 Isn't LCD brightness properly adjusted?
Refer to Chapter 1, Section 8.3: LCD Brightness
Adjustment.

. The screen displays "PU Sleeping"

message and no key entry is accepted.

e Timer mode turned OFF the pneumatic unit power.
To return the instrument to the ready status, press
the [SELECT] key to return to the analysis result
screen, and then the [Start] switch.

Fluid leaks from the unit.

e Turn OFF the power and wipe off leaking fluid. If fluid
leakage persists after turning ON the power, contact
your Sysmex service representative.

&WARMNG * When operatin_g, al_vv_ays wear rubber gloves. After completion of work,
wash hands with disinfectant. If your hands are contaminated by
blood, etc., infection of bacteria can result.

Data has error.

¢ Check QC data of control blood.

» Referring to Chapter 4: INSTRUMENT
MAINTENANCE AND SUPPLIES
REPLACEMENT, conduct the maintenance
below:

Chapter 4, Section 5.2: Clean Transducer
Chapter 4, Section 6.1: Clean SRV

. An error occurs.

Search the following message lists for an error in
guestion and refer to the corresponding pages in
TROUBLESHOOTING:
1) Message List
To search the pages, the error messages are
listed in "Alphabetical" and "Functional" orders.
2) TROUBLESHOOTING
Cause and action for each trouble are
described for respective error message.
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2.1 Alphabetical List of Error Messages Displayed on Analysis

Screen
[A]
F N = o] S {0 7-21
[B]
e (e [0 g o 0 7-17
[C]
Calibration ErrOr--------=m e e e oo e e 7-26
Clean SRV . —-m e e 7-27
Clean TranSdUCES -=-=========mmmm = 7-29
Clean Waste Chamber. --------=-=-=--=-=------ = 7-28
[H]
[ B e o 7-20
Host Comm. Error (when seria interface isincorporated)-------=-=-=-==========-=emememmu-- 7-33
[M]
Y L= 400 S o 7-23
[N]
NO Print€l' Paper------=-r=rmmmmmemee e oo oo e e 7-31
[P]
Pressure/Vac Error --=-=--=-=-=s=seemmemee e e oo --7-7,7-8, 7-9
L S (0 7-30
] S o 7-32
[Q]
Q€ 0N - === mmm e o oo o e e e 7-25
[R]
RBC Aperture Clog --------=-==mmm o m oo o e 7-15
Replenish Diluent--------=--=-==-m oo oo 7-11
Replenish Ly Se -------mmmm oo oo 7-12
RIiNSE MO0 ErTOr ---=-=-mmm o m e e oo oo 7-13, 7-14
Room Temp. High ---------mm e oo 7-16
ROOM T M. L OW === == m o e oo 7-16
[S]
Sampling Error —----------m-m oo 7-18, 7-19
Set VAU ErTOr —---mmmmm e 7-23
[W] .
Waste NOt DralNing =-====-========smm e oo oo 7-10
WBC Aperture Clog --=-==========m=mmmmm e e e e e 7-15
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2.2 Alphabetical List of Error Messages Displayed on HELP

Screen

0.5 KQ/CM? PreSSUNE EITOr=-==========mm = oo 7-7
0.5 kg/cm?® Pressure Error @ COUNE----=============n=mmmmm oo oo 7-9
250 mmHQg Vacuum Error---=--==-==-mmm oo oo 7-8
[A]

Abnormal detection SENSItiVity ---------=--=-m oo 7-22
[B]

Background count exceeds tol €ranCe.---------=-======m - m oo 7-17
[C]

Calibration value is out of range. ----- -- mememmmemmmeeeees 7-26
Clean the SRV ., =-=-=-=mmmmemee e oo e oo 7-27
Clean the TransduCeS.  =-----m-mmmmmmm oo e 7-29
Clean the Waste Chamber. ------ - - - - memmmmemmmmeme e eeeae- 7-28
Clog in the aperture (RBC)-------=-=--=-=-=mmmemmm oo memmememmmamee- ---7-15
Clog in the aperture (WBC) --------==mmmmmmmm oo oo 7-15
[E]

Error has occurred during counting (PLT). --------=-=-=-=-m-mememuoem e -7-18
Error has occurred during counting (RBC). ------=========mmmmmmmmm oo 7-18
Error has occurred during counting (WBC).--=-=-=-=-=-=-=nmmmmmm oo 7-18
Error occurred during HGB @nalySiS. —-----=-=-=-=nmmmmmmmm oo oo 7-20
Error on Built-in Printer (Print Error)------ -7-30
Error on Built-in Printer (Printer Error) --------=-=-=----mmmmmommm oo 7-32
Error 0N RiNSE CUP ----m-m=mmmmmmm oo e oo oo oo oo oo 7-13
[H]

Host Output Error (When serial interface isincorporated) -------------=-=-====-=-==mmemnmum-- 7-33
[M]

Memory error occurred. (Repairing) -- m-mmmmmmemnmeeeee 7-23
Memory error occurred. (Turn OFF then ON the power.) --- -7-23
Momentary power failure OCCUrTed.--=-==========mmmm oo 7-24
[N]

NO Printer Paper---------m o m o m o oo 7-31
[Q]

QC datafalls out of control limits. ---------==-=-=-=--mmmmmmmmm- 7-25
[R]

Replenish Diluent ContaiNgr. -=-=-=-=-======mmm oo 7-11
Replenish Lyse ContaiNer. -----=-=-=-mmmmmemm oo oo oo o e e e e oo 7-12
Room Temp. Brror ------r-m==mmmmmmem e e 7-16
[S]

Sampling Error has 0CCurred. ------=-===nmmmmmm oo oo 7-19
[W]

Waste NOt DraiNed ------=-==-==m o m oo oo 7-10
WBC/HGB ANalysiS Error-------m-nmmmm oo oo 7-21
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2.3 Functional List of Error Messages

NOTE: * [ ]indicates error naming that is displayed on the Analysis screen. “

1. Pressure/Vacuum Errors

0.5 kg/cny? Pressure Error [Pressure/\V ac Error] =--------=--====mnmmmmmmmmmmm oo 7-7

250 mmH9 Vacuum Error [Pressure/Vac Error] ------------------------- ---7-8

0.5 kg/lcm” Pressure Error at Count [Pressure/Vac Error] ----- R EEEEEy
2. Chamber Errors

Waste Not Drained [Waste Not Draining] ------------=-=======mmmmmmmmm oo 7-10

Replenish Diluent Container. [Replenish Diluent]------------=-====-mmsmmmmmmmmmeeen 7-11

Replenish Lyse Container. [Replenish Lysg] -----------=-==mmmmmmmmmm oo 7-12
3.  Motor Errors

Error on Rinse Cup [Rinse MoOtor Error] -----=-======nmnmmmmmmm oo 7-13
4,  ApertureErrors

Clog in the gperture (WBC) [WBC Aperture Clog] -------------==-========mmmmmmmmn 7-15

Clog in the aperture (RBC) [RBC Aperture Clog] ----- -- 7-15
5.  TemperatureErrors

Room Temp. Error [Room Temp. High]--------==-===mmmm oo oo 7-16

Room Temp. Error [Room Temp. LOW] ------=-==mmnmmmmm oo 7-16
6. AnalysisErrors

Background count exceeds tolerance. [Background Error] - -- -- 7-17

Error has occurred during counting. (PLT) [Sampling Error] 7-18

Error has occurred during counting. (RBC) [Sampling Error] ----------------------- 7-18

Error has occurred during counting. (WBC) [Sampling Error]----------------------- 7-18

Sampling Error has occurred. [Sampling Error]--------- --7-19

Error occurred during HGB analysis. [HGB Error] --------------=--=--ocememcmme oo 7-20

WBC/HGB Anaysis Error [Analysis Error]-- oo 7-21

Abnormal detection sengitivity [Analysis Error] -------------==-===m-mmcmmmmmmm oo 7-22
7. Memory Errors

Memory error occurred. (Turn OFF then ON the power.) [Memory Error]-------- 7-23

Memory error occurred. (Repairing) "Set Vaue Error]---- ----7-23

Memory error occurred. (Turn OFF then ON the power.) [Set Value Error] ------ 7-24

Momentary power failure occurred. [-]----------==-m-mmmmmm oo 7-24
8. Others

QC datafalls out of control limits. [QC Error] -- 7-25

Cdlibration value isout of range. [Calibration Error] 7-26
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9. MaintenanceErrors
Clean the SRV. [Clean SRV .] ------mmmmmmm oo 7-27
Clean the Waste Chamber. [Clean Waste Chamber.] -----------------=-=-o e cem - 7-28
Clean the Transducer. [Clean Transducer.] ------- -- 7-29
10. Built-in Printer Errors
Error on Built-in Printer [Print Error]---------------=---=----------- 7-30
No Printer Paper [NO Printer Paper] --------==-===-mmm oo 7-31
Error on Built-in Printer [Printer Error] --------------m-=mmmmmm oo 7-32
11. External Option Errors (When serial interfaceisincor porated)
Host Output Error [Host Comm. Error] -------=-==-==mmmmmm oo 7-33
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3. TROUBLESHOOTING GUIDE

3.1 Pressure/Vacuum Errors

Error Message Meaning of Message
"Pressure/Vac Error" 0.5 kg/cm? is out of the monitor range in Ready
*Hel p* status.
0.5kg/ cn2 Pressure Error Monitor range: 0.40 - 0.60 kg/cm?

0.35 [0.40 - 0.60]
Adj ust 0. 5kg/ cn® Pressure.

[1] Restarting to nmonitor the pressure

ERR QCDE: XXXXX. X, X

1: End of Adj

Cause 1) 0.5 kg/cm? pressure adjustment error
2) Pneumatic unit pressure error
3) Air leakage from pressure line

Action 1) Adjust Pressure to 0.5 kg/cm?.
The HELP screen displays pressure value in real time.
Adjust pressure referring to Chapter 8, Section 2.3: Adjusting
Pressure to 0.5 kg/cm?.
2) Check Pressure Line
Check the pressure line for loosened nipple or tube, or breakage.
If any abnormality is noted, reconnect or replace.
After adjustment or check, press [1] key to return to the original
screen.

Analysis after error Not Ready until the error is resolved.
occurrence
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Error Message Meaning of Message

"Pressure/Vac Error"

250 mmHg vacuum is out of the monitor range

* Hel p*

in Ready status.

250 mmHg Vacuum Error

215 [230 - 270]
Adj ust 250mmHg Vacuum

[1] Restarting to nonitor the vacuum

ERR OCDE: XXXXX. X X

Monitor range: 230 - 270 mmHg

1: End of Adj
Cause 1) 250 mmHg vacuum adjustment error
2) Fluid back-flows into the trap chamber.
3) Pneumatic unit vacuum error
4) Air leakage from vacuum line
Action 1) Adjust Vacuum to 250 mmHg

The HELP screen displays vacuum value in real time.
Adjust vacuum referring to Chapter 8, Section 2.4: Adjusting
Vacuum to 250 mmHg.
2) Discard fluid in Trap Chamber
Discard fluid if collected. Refer to Chapter 4, Section 3.2: Check
Trap Chamber Level and Discard.
3) Check Vacuum Line
Check the vacuum line for loosened nipple or tube, or breakage. If
any abnormality is noted, reconnect or replace.
After adjustment or check, press [1] key to return to the original
screen.

Analysis after error
occurrence

Not Ready until the error is resolved.
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Error Message Meaning of Message
"Pressure/Vac Error" 0.5 kg/cm? pressure is out of the monitor range
*Fel p* during analysis.
0. 5kg/ cn? Pressure Error at count Monitor range: 0.30 - 0.70

Turn OFF then ON the power.

ERR GCDE: XXXXX. X. X

3: Ana. Scr een

Cause 1) 0.5 kg/cm? pressure adjustment error
2) Pneumatic unit pressure error
3) Air leakage from pressure line
Action 1) Adjust Pressure to 0.5 kg/cm?

Turn the power OFF, and turned it ON again. Then adjust pressure
referring to Chapter 8, Section 2.3: Adjust 0.5 kg/cn’Pressure.
2) Check Pressure Line

Check the pressure line for loosened nipple or tubing, or
breakage. If any abnormality is noted, reconnect or replace.
After adjustment or check, press [1] key to return to the original
screen.

Analysis after error The power needs to be turned OFF then ON again.
occurrence

NOTE: « Press [3] key to return to the Analysis screen. The status is not
ready for analysis, but the processing, etc. of stored data in Select
Menu can be performed.
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3.2 Chamber Errors

Error Message Meaning of Message

"Waste Not Draining" Waste in the waste chamber can not be drained

* Hel p*

within the prescribed draining time.

[

Waste Not Drained
Check ki nked or bl ocked tubings.

Retrying to drain the waste

ERR GCDE: XXXXX. X. X

1: Drai ni ng 3: Cancel
Cause 1) Breakage or clogging of waste chamber or waste line tube
2) Pneumatic unit pressure error
3) Air leakage from pressure line
4) Float switch malfunction
5) Faulty operation of solenoid or master valve
Action 1) Check Waste Line Tube
Check the waste drain line for breakage, clogging, etc. If any
abnormality is present, clean or replace the tube. Specially check
for contaminant or clogging near the drain outlet nipple.
2) Check Pressure Line
Check the pressure line for loosened nipple or tubing, or
breakage. If any abnormality is noted, reconnect or replace.
After adjustment or check, press [1] key to return to the original
screen.
Analysis after error Not Ready until the error is resolved.
occurrence
NOTE: <« Press [3] key to return to the Analysis screen. The status is not ready for

analysis, but the processing, etc. of stored data in Select Menu can be
performed.
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Error Message Meaning of Message

"Replenish Diluent"

Diluent (CELLPACK) can not be aspirated

* Hel p*

within the prescribed diluent aspiration time.

Repl eni sh Di | uent Cont ai ner.

[1] Reaspirating Dl uent

ERR OCDE: XXXXX. X X

1: Asp. Reag.

3: Cancel

Cause

1) Lack of diluent (CELLPACK)

2) Diluent aspiration line error

3) Air leakage from vacuum line

4) Float switch malfunction

5) Faulty operation of solenoid valve or master valve

Action

1) Replenish Diluent (CELLPACK)
If there is no diluent, replenish with a new diluent container.
2) Check Tube

Check the diluent line tubing for breakage and the nipple for
looseness. If any abnormality is noted, reconnect or replace.

After replenishment or check, press [1] to return to the original
screen.

3) Check Vacuum Line
Check the vacuum line for breakage and loosened nipple or
tubing.

Analysis after error
occurrence

Not Ready until the error is resolved.

NOTE: -« Press [3] key to return to the Analysis screen. The status is not ready for
analysis, but the processing, etc. of stored data in Select Menu can be
performed.
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Error Message Meaning of Message

"Replenish Lyse" No lyse remains.

* Hel p*

Repl eni sh Lyse Contai ner.

[1] Reaspirating Lyse

ERR OCDE: XXXXX. X X

1: Asp. Reag. 3: Cancel
Cause 1) Lack of lyse (STROMATOLYSER-WH)
2) Float switch malfunction
Action 1) Replenish Lyse (STROMATOLYSER-WH)

When no lyse is left, replenish with a new lyse container.

After replenishment or check, press [1] key to return to the original
screen.

Analysis after error Not Ready until the error is resolved.
occurrence

NOTE: =« Press [3] key to return to the Analysis screen. The status is not ready for
analysis, but the processing, etc. of stored data in Select Menu can be
performed.
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3.3 Motor Errors

Error Message Meaning of Message
"Rinse Motor Error" The rinse cup is at lower position at start-up
*Fel p* (This happens only when the power is ON.)

Error on R nse Qup
Turn OFF then ON the power.

If Rinse Qup is out of position,
Turn power OFF and correct manual ly.

ERR GCDE: XXXXX. X. X

3: Ana. Screen
Cause 1) Rinse cup drive motor malfunction
2) The power was turned ON with the rinse cup remaining lowered.
Action 1) Turn OFF the power, manually raise the rinse cup with both hands
to the original top position, then turn ON the power.
Analysis after error The power needs to be turned OFF then ON again.
occurrence

NOTE: =« Press [3] key to return to the Analysis screen. The status is not ready for
analysis, but the processing, etc. of stored data in Select Menu can be
performed.
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Error Message Meaning of Message

"Rinse Motor Error" The rinse cup is not operating normally.

* Hel p*

Error on R nse Qup
Turn OFF then ON the power.

ERR OCDE: XXXXX. X X

3: Ana. Scr een

Cause 1) Rinse cup drive motor malfunction
2) Error of the rinse cup drive motor controller
Faulty operation of CPU due to sudden noise interference, etc.
Action 1) Turn OFF the power and check to see that tubing, etc. are not in
contact with the top or bottom of rinse cup.
2) Turn OFF the power and clean the rinse cup.
Refer to Chapter 4, Section 7.2: Clean Rinse Cup.
Analysis after error The power needs to be turned OFF then ON again.
occurrence
NOTE: <« Press [3] key to return to the Analysis screen. The status is not ready for

analysis, but the processing, etc. of stored data in Select Menu can be
performed.
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3.4 Transducer Errors

Error Message Meaning of Message
"WBC Aperture Clog" The monitor value for aperture clog is out of the
"RBC Aperture Clog" prescribed range.

* Hel p*

dog in the aperture
Paraneter: WBC

Execute cl og renoval sequence.
I'f clog persists,
press[ SELECT], t hen
[ Mai nt enance] - >[ A ean Transducer]
or dab with brush after [SELECT],
[ Mai nt enance] - >[ Drai n TD Chanber ]

ERR OCDE: XXXXX. X X

1: d og Renove 3: Cancel
Cause 1) Transducer aperture clogging
Action 1) Remove Aperture Clogging.

Press [1] key to execute automatic clog removal sequence.
2) Transducer Rinse Sequence

Pour 1 mL each of CELLCLEAN in the transducer chamber to
perform auto rinse sequence.

Refer to Chapter 4, Section 5.2: Clean Transducer.
3) Clean the Transducer with Brush
Clean the aperture with brush.

Refer to Chapter 4, Section 7.3: Clean WBC/RBC Transducer
Aperture.

Analysis after error Ready for analysis (although the next sample could be affected)
occurrence

NOTE: <« Press [3] key to return to the Analysis screen. Although the system is
ready for analysis, the error may occur in the next analysis.
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3.5 Temperature Errors

Error Message Meaning of Message
"Room Temp. High" Temperature in the unit (around the transducer)
"Room Temp. Low" is out of the monitor range.

Monitor range: 10.0 - 40.0°C

* Hel p*

Room Tenp. Error
41.5°C [10.0 - 40.0]

Anal ysis data has lower reliability.
Check the roomtenperature.

ERR OCDE: XXXXX. X. X

3: Return
Cause 1) Temperature in the transducer is high (or low.)
Action 1) Check the Ambient Temperature
Check to see that the ambient temperature is between 15°C -
30°C.
Analysis after error Ready for analysis (although the next sample could be affected)
occurrence

NOTE: =« Press [3] key to return to the Analysis screen. Although the system is
ready for analysis, the error may occur in the next analysis.
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3.6 Analysis Errors

Error Message Meaning of Message
"Background Error" In Auto Rinse, background check reveals that
*Fel p* the background count of any parameter
exceeds the tolerance.

Backgr ound count exceeds tol erance.

WBC 0.1 [<=0.3] (x10% uL) Tolerance: WBC 0.3x10%pL or less

= %1086,

R P e RBC 0.02x10°uL or less

PLT 12 [<=10]  (x10%u) HGB 0.1g/dL or less
Suspected a dirty aperture or SRV. PLT 10x103/u|_ or less

[1] Execute an Auto R nse.
ERR OODE: XXXXX. X. X

1. Auto R nse 3: Cancel

Cause 1) Dirty aperture

2) Dirty HGB flow cell
3) Bubbles mixing
4) Faulty reagent

Action 1) Auto Rinse
Press [1] key to perform Auto Rinse.
2) Clean Transducer
Refer to Chapter 4, Section 5.2: Clean Transducer or Chapter 4,
Section 7.3: Clean WBC/RBC Transducer Aperture.
3) Clean SRV
Refer to Chapter 4, Section 6.1: Clean Sampling Valve (SRV).
4) Replenish Reagent
Faulty lyse will affect background for WBC or HGB. In case diluent
is faulty, it will affect all parameters, notably PLT background count.

Analysis after error Ready for analysis (although the next sample could be affected)
occurrence

NOTE: =« Press [3] key to return to the Analysis screen. Although the system is
ready for analysis, the error may occur in the next analysis.
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Error Message Meaning of Message
"Sampling Error" Sampling data falls into disorder.
*Hel p* Sampling data refers to the count taken every

Error has occurred during counting. 0.5 seconds during counting. The system

Paraneter: WBC PLT monitors the counts.
Suspected a cl ogged aperture.

[1] Execute clog renoval sequence.
If clog persists,
press[ SELECT], then
[ Mai nt enance] - >[ A ean Transducer]
or dab with brush after [SELECT]
[ Mai nt enance] ->[ Drai n T. D. Chanber]
ERR OCDE: XXXXX. X. X

1: d og Renove 3: Cancel
Cause 1) Dirty aperture
2) Effect of external noise interference
Action 1) Clean Transducer

1. Remove Aperture Clogging
Press [1] key to execute automatic clog removal sequence.

2. Transducer Rinse Sequence
Pour 1 mL each of CELLCLEAN in the transducer chamber to
perform auto rinse sequence. Refer to Chapter 4, Section 5.2:
Clean Transducer.

3. Clean the Transducer with Brush
Clean the aperture using brush. Refer to Chapter 4, Section
7.3: Clean WBC/RBC Transducer Aperture.

2) Remove Source of External Noise
Move the noise source away from the unit.

Analysis after error Ready for analysis (although the next sample could be affected)
occurrence

NOTE: =« Press [3] key to return to the Analysis screen. Although the system is
ready for analysis, the error may occur in the next analysis.
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Error Message

Meaning of Message

"Sampling Error"

* Hel p*

Sanpling Error has occurred.

ERR OCDE: XXXXX. X X

3: Ret uen

Sampling data falls into disorder.

Sampling data refers to the count taken every
0.5 seconds during counting. The system
monitors the counts taken.

Cause

1) CPU malfunction due to sudden noise interference, etc.

Action

1) Turn OFF then ON the power again.

If the error persists after turning ON the power again, contact your
Sysmex service representative.

Analysis after error
occurrence

Ready for analysis (although the next sample could be affected)

NOTE:

Press [3] key to return to the Analysis screen. Although the system is
ready for analysis, the error may occur in the next analysis.
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Error Message Meaning of Message

"HGB Error"

HGB converted value is out of the prescribed

* Hel p*

range.

Error occurred during H@® anal ysis.
Flow Cell nay be dirty.
[1] dean TD Chanber will be perforned.

(It will take approx. 7 mnutes.)

ERR OCDE: XXXXX. X, X

1. Blank value is out of the range.
2. Blank value exceeds sample value.

1. Exec. dean

3: Cancel

Cause 1) Dirty HGB flow cell
2) Bubbles mixed in HGB sample line
3) Dirty WBC TD chamber

Action 1) Clean Transducer

Press [1] key to execute the transducer rinse sequence.
Refer to Chapter 4, Section 5.2: Clean Transducer.

Analysis after error
occurrence

Ready for analysis (although the next sample could be affected)

NOTE: -« Press [3] key to return to the Analysis screen. Although the system is
ready for analysis, the error may occur in the next analysis.
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Error Message Meaning of Message

"Analysis Error" WBC (including HGB) analysis error is
“Fel pr continuing.

WBC/ HE®B Anal ysis Error

ERR OCDE: XXXXX. X X

3: Return
Cause 1) Faulty lyse (STROMATOLYSER-WH)
Action 1) Replenish Lyse

After replenishing lyse, always execute "4: Replace Reagent” in
the Select Menu, making reference to Chapter 4, Section 8.1:
Replenish Reagent. After replenishment and checking, analyze
the control blood and confirm that there is no abnormality.

Analysis after error Ready for analysis (although the next sample could be affected)
occurrence

NOTE: =« Press [3] key to return to the Analysis screen. Although the system is
ready for analysis, the error may occur in the next analysis.
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Error Message

Meaning of Message

"Analysis Error"

Sensitivity in the transducer exceeds the

* Hel p*

prescribed range.

Abnormal detection sensitivity

ERR OCDE: XXXXX. X X

3: Return

Cause

1) Faulty diluent (CELLPACK)

Action

1) Replenish Diluent

After replenishing diluent, execute "5: Auto Rinse" in the Select
Menu, and perform background check. In addition, analyze the
control blood to see that there is no abnormality.

Analysis after error

occurrence

Ready for analysis (although the next sample could be affected)

NOTE: -

Press [3] key to return to the Analysis screen. Although the system is
ready for analysis, the error may occur in the next analysis.
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3.7 Memory Errors

Error Message

Meaning of Message

"Memory Error"

Error occurs on the Read Only Memory (ROM)

* Hel p*

or Random Access Memory (RAM). The alarm

Memory error occurred.

Turn OFF then ON the power.

ERR OCDE: XXXXX. X X

keeps sounding.

Cause 1) Momentary power failure, sudden noise interference, etc. causes
CPU malfunction.

Action 1) Turn OFF then ON the power again.

Analysis after error Inoperative (The power could be turned OFF.)

occurrence

Error Message

Meaning of Message

"Set Value Error"

Errors occur in the set values of the following:

* Hel p*

* Stored data

Stored data, and
QC data

[1] will be repaired.

[2]

Memory error occurred. .

Repairing may end inconpl ete.
Deleting files and initializing.

ERR OCDE: XXXXX. X X

Quality Control data
* Customer-set values

1:Repairing 2:Initialize

Cause 1) Momentary power failure, sudden noise interference, etc. causes
analysis value errors.
Action 1) Repair
Press [1] key to execute repairing.
2) Initializing

If execution of "1: Repairing" fails to correct the error, initialize
using [2] key. Initializing deletes all stored data and QC data, and
set values return to initial values.
After completion of initializing, perform all settings referring to Chapter
10: INSTRUMENT SETUP.

Analysis after error
occurrence

Not Ready until the error is resolved.
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Error Message Meaning of Message
"Set Value Error" Errors occur in the set values of the following:
*Hel p e Stored data
Mermory error occurred. e Quality Control data
Turn CFF then ON the power. » Customer-set values

« Factory-set values

ERR OCDE: XXXXX. X. X

Cause 1) Momentary power failure or sudden noise interference causes set
value errors.
Action 1) Turn OFF then ON the power again.

If the error persists even after the power is turned OFF then ON,
contact your Sysmex service representative for assistance.

Analysis after error Inoperative (The power could be turned OFF.)
occurrence
Error Message Meaning of Message
Momentary Power Failure The program had not been normally quitted the

last time the power was turned off.

Monent ary power failure occurred, or

[ SHUT DOM] has not been perforned
inthe last time.

Perfornf SHUT DOM]in prior to
turning OFF the power.

[1] Continue to start up.

1: Conti nue

Cause 1) Momentary power failure, etc. caused the unit to stop temporarily.

2) Shutdown had not been performed the last time the unit was
turned OFF.

Action Press [1] key to start up the unit. Perform SHUTDOWN before turning
OFF the power.

Analysis after error Ready for analysis (This error occurs at starting.)

occurrence
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3.8 Others
Error Message Meaning of Message
"QC Error" This error occurs only when executing Quality
el pr Control.
QC data falls out of control linits. Analysis data is out of QC limits.

ERR OCDE: XXXXX. X X

3: Return

Cause 1) Control blood aspiration error

2) Control blood insufficient mixing

3) Faulty control blood

4) Instrument failure

Action 1) Reanalyze Control Blood
Press [3] key to return to the QC screen and perform reanalysis.

2) Analyze using New Vial.

3) Maintenance Service of Unit
When the above 1) and 2) steps fail to resolve the error, a hardware
problem may be suspected. Refer to Chapter 4: INSTRUMENT
MAINTENANCE AND SUPPLIES REPLACEMENT and clean the
transducer, SRV, etc.

Analysis after error Ready for analysis
occurrence
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Error Message Meaning of Message

"Calibration Error" The set calibration value does not meet the

*Hel p* conditions:

« Difference from the last calibration must not
exceed 5%.

If error persists,

>=5%di fference fromthe last calib. + Calibration value must be in the range of
Calib. factor is out of 80% 120% 80% - 120%.

Calibration value is out of range.

ERR OCDE: XXXXX. X. X

3:Return
Cause 1) Input error of target or calibration values
2) Instrument failure caused data to shift.
Action 1) Checking Entered Values

Press [3] key to return to the Calibration screen and check the

target or calibration value.

» In case of input error of target value in automatic calibration
Select "No" on the Update screen for calibration value and
execute Auto Calibration again from the beginning.

» In case of input error of calibration value in manual calibration
Select "No" on the Update screen for calibration value and enter
calibration value again.

2) Maintenance of Instrument

Check QC data, and if data is found to have shifted, a hardware

problem is conceivable. Referring to Chapter 4: INSTRUMENT

MAINTENANCE AND SUPPLIES REPLACEMENT, clean the

transducer, SRV, etc.

Analysis after error Not Ready until calibration value is fixed.
occurrence
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3.9 Maintenance Errors

Error Message Meaning of Message
It is time to clean the SRV.
*Schedul ed Mai nt . * Three months have passed from the previous
cleaning.
Qean the SRV. 7500 samples have been analyzed from the

[1] Reset the cycle counter for SRV, previous cleaning.

and you can turn OFF the power.

[3] Continue to start up. SRV cycle
counter will not be reset.

Cycle No. after cleaning. 7567

Date | ast serviced 31/ 12/ 97
1: Exec. d ean 3: Cancel
Cause
Action Press [1] key. Following the instructions on the screen, turn OFF the

power and clean the sample rotor valve (SRV). (Refer to Chapter 4:

Section 6.1: Clean Sample Rotor Valve (SRV)).

If you perform cleaning later, press [3] key. This activates the usual

startup sequence and makes the system Ready.

0 The same message will appear the next time you start the unit; it will
be displayed at each startup until the cleaning is performed.

Analysis after error Ready for analysis
occurrence

NOTE: « When you clean SRV without pressing [1] key, execute "7: Maintenance,"
and then "3: Reset Counter" in the Select Menu.
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Error Message Meaning of Message
*Schedul ed Mai nt * It is time to clean the waste chamber.
One month has passed from the previous
cleaning.

Qean the Wste Chanber . 2500 samples have been analyzed from the
It will take approx. 7 ninutes. previous cleaning.

Cycle No. after cleaning. 2567

Date | ast serviced 31/ 12/ 97
1: Exec. d ean 3: Cancel
Cause
Action Press [1] key. Following the instructions on the screen, clean the
waste chamber. (Refer to Chapter 4, Section 5.1: Clean Waste
Chamber ).

If you perform cleaning later, press [3] key. This activates the usual

startup sequence and makes the system Ready.

O The same message will appear the next time you start the unit; it will
be displayed at each startup until the cleaning is performed.

Analysis after error Ready for analysis
occurrence

NOTE: « When the waste chamber rinse sequence has been completed, the cycle
counter is automatically reset.

7-28

Sysmex KX-21 Operator’s Manual -- Revised October 1998




TROUBLESHOOTING

Error Message Meaning of Message

It is time to clean the transducer.

*Schedul ed Mai nt *

One month has passed from the previous

d ean the Transducer.
It will take approx.

Cycle No. after cleaning. 2567

cleaning.

2500 samples have been analyzed from the
previous cleaning.

7 mnutes.

Date | ast serviced 31/ 12/ 97
1. Exec. d ean 3: Cancel
Cause
Action Press [1] key. Following the instructions on the screen, clean the

transducer (Refer to Chapter 4, Section 5.2: Clean Transducer).

If you perform cleaning later, press [3] key. This activates the usual

startup sequence and makes the system Ready.

0 The same message will appear the next time you start the unit; it will
be displayed at each startup until the cleaning is performed.

Analysis after error
occurrence

Ready for analysis

NOTE: « When the transducer rinse sequence has been completed, the cycle
counter is automatically reset.
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3.10 Built-in Printer Errors

Error Message Meaning of Message

"Print Error" Error is found in the memory used for the built-
*Fel pr in printer.

Error on Built-in Printer

[1] Press[1]to return the screen,
and print again.

[3] Stop printing on built-in printer

To nmake built-in printer on-1line,
pr ess[ SELECT], t hen
[ Periph. Settings]

ERR CODE: XXXXX. X. X

1: Return 3: Stop Qut put
Cause 1) Printer memory error occurs due to momentary power failure,
sudden noise interference, etc.
Action 1) Clear the Printer Memory

Press [1] key to initialize the printer memory.
OIn this case, manually print the same sample again from the
Analysis screen.

2) Make the Built-in Printer Off-line
Press [3] key to make the built-in printer off-line. The main unit
becomes Ready but cannot print. When you want to try printing
again, refer to Chapter 10: INSTRUMENT SETUP and make
settings for connecting the built-in printer.

Analysis after error Not Ready until the error is resolved.
occurrence
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Error Message Meaning of Message

"No Printer Paper" Paper found empty
* Hel p*

No Printer Paper

[1] Restarting to print
[3] Stop printing on built-in printer

To make built-in printer on-line,

press[ SELECT], then
[ Periph. Settings]

ERR OCDE: XXXXX. X. X

1: Print 2: Paper Feed 3:Stop Qutput

Cause 1) No printer paper in the built-in printer

Action 1) Replace Print Paper
Refer to Chapter 4, Section 8.3: Replace Printer Paper. After
replacing, press [1] key to print the data that has not yet printed.

2) Make the Built-in Printer Off-line
When you press [3], the built-in printer is made off-line. The main
unit becomes Ready but cannot print. When you want to try
printing, refer to Chapter 10: INSTRUMENT SETUP and make
settings for connecting the built-in printer.

Analysis after error Not Ready until the error is resolved.
occurrence

NOTE: <« When you press [2] key, paper is fed.
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Error Message

Meaning of Message

"Printer Error"

* Hel p*

Error on Built-in Printer
Press the paper guide | ever down.

[1] Restarting to print
[3] Stop printing on built-in printer

To make built-in printer on-line,

The built in printer has an error.

press[ SELECT], t hen
[ Periph. Settings]

ERR OCDE: XXXXX. X X

1. Print 2: Paper Feed 3:Stop Qutput
Cause 1) The paper release lever is not in the secured position.
Action 1) Confirming the Printer

Press the paper release lever down. Pressing [1] key resumes
printing.

2) Make the Printer Off-line
When [3] key is pressed, the built-in printer is made off-line. The
main unit becomes Ready but cannot print. When you want to try
printing, refer to Chapter 10: INSTRUMENT SETUP and make
settings for connecting the built-in printer.

Analysis after error

occurrence

Not Ready until the error is resolved.

NOTE: -

When you press [2] key, paper is fed.
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3.11 External Device Errors (When this option is incorporated)

Error Message Meaning of Message
"Host Comm. Error" Communications cannot be made with the host
~Fel pr computer. There are four cases:
¢ Host Off-line

Host Qutput Error
*Host ACK Time Qut Error* i

Check Host Gondition ¢ Host ACK Time Out Error

) ) ¢ Host NAK Retry Error
[1] Retries to transnit to Host T i
[3] Stop transmitting to Host ¢ Host Transmission Time Out Error
To make Host Conputer on-line,
press[ SELECT], then

[ Periph. Setti ngs]
ERR CCDE: XXXXX. X. X

1: Re- sendi ng 3: Stop Qut put

Cause 1) Computer connecting cable failure
2) Computer is not turned ON or not ready for communication.
3) Host computer serial interface error

Action 1) Inspect Host Computer Cable
2) Inspect Connection Cable

When you press [1] key after inspection, data transmission is
resumed.

3) Disconnecting Host Computer

When you press [3] key, transmission to the host computer is
canceled and the host is off-lined in the main unit. The main unit is
now Ready but cannot output to the host computer.

To resume transmission to the host computer, refer to Chapter 10:
INSTRUMENT SETUP and make settings for connecting the host
computer.

Analysis after error Not Ready until the error is resolved.
occurrence
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4. STATUS DISPLAY
The unit has the Status Display screen by which you can confirm the status of the instrument.
The Status Display screen displaysin real time a currently-running sequence,
pressure/vacuum readings, sensor status, and solenoid valve operating status. Y ou can also
confirm on the screen HGB Converted value, cycle Nos. after performing the last
maintenance, and currently-registered cycle No.
(1) Press[SELECT] key onthe Analysis screen. The Select Menu screen appears.
(2) Using [A] key or [ ¥] key, move the cursor to select "7: Maintenance.”

(3) Press[ENTER] key. The Maintenance Menu screen appears.

*Mai nt enance*

d ean Transducer
Reset SRV Count er
Drain TD Chanber
St

2
3
4
5: Status D spl ay

Figure 7-4-1:. Maintenance Menu Screen
(4) Using [A] key or [¥] key, move the cursor to select "5: Status Display.”
(5) Press[ENTER] key. The Status Display screen appears.

NOTE: » On the Menu screen, each menu can be selected directly by entering a
numeral from the numeric keys.

The Status Display screen comprises two pages; you can turn over the pages using
[ 4] key or [»] key.

P1. Status Display — P2. Status Display
Screen 1 Screen 2

Figure 7-4-2: Page Selection in Status Display Screen
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| 250 mmHg Vacuum
550 ; L— HGB Converted Value

Sensor status

Solenoid valve operating status

Change screen with [<] or [}

Figure 7-4-3: P1. Status Display Screen 1

|*St at us* wB S>> |
Ready Cycle No.

1234567 ] ,—Cycle No. after cleaning waste chamber

'W@ﬁi"'C%EBIIIIIIIIIII |
| Cycle No. after cleaning transducer
g L——Cycle No. after cleaning SRV

Change screen with [<]] or [

Figure 7-4-4: P2. Status Display Screen 2
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1. INTRODUCTION

The adjustment procedures described here are important in maintaining accuracy of this
instrument. Y our Sysmex service representative will perform initial adjustment. Should it
require any adjustment subsequently, follow the procedures given below.

The following adjustment procedures are explained in this chapter.

» Pressure: 0.5 kg/cm?
* Vacuum: 250 mmHg
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2. ADJUSTMENT OF PRESSURE AND VACUUM

Pressure and vacuum from the built-in Pneumatic Unit are regulated to 0.5 kg/cm?® and 250
mmHg. The pressure and vacuum are always monitored by pressure sensors. When an
error occurs, an error message is displayed.

If the pressure or vacuum error message is displayed, check tubing connections or the like

for any air leakage. If thereisno such error, display the Status Display screen and adjust
pressure or vacuum as required.

2.1 Location of Control Knobs

250 mmHg Bellows Unit

0.5 kg/cm2 Regulator

Figure 8-2-1: Location of Control Knobs

NOTE: » When an error has occurred, press [HELP] key to check pressure or
vacuum value on the Help screen.
(Refer to Chapter 7: TROUBLESHOOTING.)

* Hel p*

0. 5kg/ cn? Pressure Error
0.35 [0.40 - 0.60]
Adj ust 0. 5kg/cn2 Pressure

[1] Restarting to nonitor the pressure

ERR CODE: XXXX X X

1: End of Adj

Figure 8-2-2: Help Screen
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2.2 Pressure and Vacuum Display

(1) Press[SELECT] key when the statusis "Ready.” The Select Menu screen appears.
(2) Movethecursor using [A] key or [ V] key, and select "'7: Maintenance."

(3) Press[ENTER] key.
The Maintenance Menu screen appears.

* MRl Nt enance*

1: d ean W Chanber

2: d ean Transducer
3: Reset SRV Count er
4:Drain TD Chanber
5: Status D spl ay

Figure 8-2-3: Maintenance Menu Screen
(4) Movethecursor using [A] key or [ V] key, and select "5: Status Display.”
(5 Press[ENTER] key.

The Status Display screen appears.
|*St at us* VB o> |
Ready
SEQ No. 12
PRESSURE 0.52
VACUM 240
HGB OONVERT 550

SENSCR AB34567

sv [P 3456890
2 456@890
1234

Change screen with [<] or [D]

Figure 8-2-4: Status Display Screen

NOTE: » Each menu can be selected directly on the Menu screen by entering a
numeral from the numeric keys.
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NOTE: » The Status Display screen shows current pressure and vacuum.
|*St at us* VB o> |
SEQ No. Ready | Pressure: 0.5 kg/cm?
CPRESSURE UZ:_S:Z:. (displaying 0.52 kg/cm?)
EVACOOM 240
HEB CONVERT L_&en Vacuum: 250 mmHg
SENSOR 34567 (displaying 240 mmHg)
sv l 56890
| 4 56mM890

Change screen with [<] or [

Figure 8-2-5: Status Display Screen

(6) Adjust the pressure and vacuum by following the procedures given on the next page
and later.
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2.3 Adjusting Pressure to 0.5 kg/cm?

(1) Using the procedure of "2.2 Pressure and vacuum Display,” display the Status Display
screen.

(2) Loosen the 0.5 kg/cm? regulator locking nut on the left side of the unit.
(3 Whilewatching the pressure and vacuum indication on the Status Display screen, turn

the adjusting knob to regulate pressure and vacuum. Turn the adjusting knob
clockwise to increase pressure and vacuum.

Adjustment range: 0.5+0.1 kg/cm?

Locking nut

q Adjusting knob

Figure 8-2-6: Adjusting the Pressure

CAUTION: » Always adjust pressure and vacuum so as to increase to the
predetermined levels. Should any of them be too high, lower it to
below that level once, then raise it to the set level. Unless adjustment
is properly conducted, accurate adjustment may not be possible.

(49 When adjustment is finished, tighten the locking nut while taking care not to allow the
adjusting knab to rotate.

(5 Press[SELECT] key to return to the Ready status.
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2.4 Adjusting Vacuum to 250 mmHg

(1) Using the procedure of "2.2 Pressure and Vacuum Display,” display the Status
Display screen.

(2) By turning counterclockwise, loosen the locking nut for the bellows unit on the left
side of the unit.

(3) Whilewatching the pressure and vacuum indication on the Status Display screen, turn
the adjusting knob to regulate pressure and vacuum. Turn the adjusting knob
clockwise to increase pressure and vacuum.

Adjustment range: 250+10 mmHg

Adjusting knob

Locking nut

Figure 8-2-7: Adjusting the Vacuum

CAUTION:  Always adjust pressure and vacuum so as to increase to the
predetermined levels. Should any of them be too high, lower it to
below that level once, then raise it to the set level. Unless adjustment
is properly conducted, accurate adjustment may not be possible.

(4) When adjustment isfinished, tighten the locking nut while taking care not to alow the
adjusting knab to rotate.

(5) Press[SELECT] key to return to the Ready status.
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FUNCTIONAL DESCRIPTION

1. INTRODUCTION

This chapter describes blood cell count detection principle and analysis method used in this
instrument, and flow of individual analysis. Also the hardware elements are explained.

» Detection Principle: Principle each of DC detection method and non-cyanide
hemoglobin analysis method is described.
* Flow of Analysis: Flow of each analysis parameter on the main unit and

analysis method for particle distribution are described.

* Function of Measuring Unit:  Names and functions of the measuring unit's el ements
are briefly described.
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2.

DETECTION PRINCIPLE

Thisinstrument performs blood cell count by DC detection method.
2.1 DC Detection Method

Blood sample is aspirated, measured to a predetermined volume, diluted at the specified
ratio, then fed into each transducer. The transducer chamber has a minute hole called the
aperture. On both side of the aperture, there are the electrodes between which flows direct
current. Blood cells suspended in the diluted sample pass through the aperture, causing
direct current resistance to change between the electrodes. Asdirect current resistance
changes, the blood cell sizeis detected as electric pulses.

Blood cell count is calculated by counting the pulses, and a histogram of blood cell sizesis
plotted by determining the pulse sizes. Also, analyzing a histogram makesit possible to
obtain various analysis data.

] DC Supply
Transducer Chamber

External Electrode + Resistance

Blood Cell Suspension

Aperture Internal Electrode -

Figure 9-2-1: DC Detection Method
2.2 Non-Cyanide Hemoglobin Analysis Method

To anayze hemoglobin by automated methods, the Cyanmethemoglobin method or
Oxyhemoglobin method have so far been the main stream.

Cyanmethemoglobin method was recommended as the international standard method in 1966
by ICSH (International Committee for Standardization in Haematology). This method,
however, is so low in hemoglobin conversion rate that it cannot be said an appropriate
method in the automated process in which multi-sample processing is the pre-condition. In
addition, this method uses the reagent of cyanide compound which is a poisonous substance
and requires waste processing; thus, it can hardly be called an environmentally favorable
method.

At present, this method cannot be said suitable for a fully-automated instrument which is
required to handle alarge amount of waste.
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The Oxyhemoglobin method, on the other hand, is faster in hemoglobin conversion rate; in
fact, blood hemoglobin is converted instantaneously into oxyhemoglobin. Also, it does not
contain poisonous substance as cyanmethemogl obin method, making the method suitable for
automation. This method, however, is unable to convert methemoglobin into
oxyhemoglobin. Consequently, when a great amount of methemoglobin is contained asin
control blood, lower-than-real values result, although usual human blood poses no
problems.

Non-cyanide hemoglobin analysis method utilizes the advantages of both of the above
methods. Non-cyanide hemoglobin analysis method rapidly converts blood hemoglobin as
the Oxyhemoglobin method and contains no poisonous substance, making it suitable for
automated method.

Being capable of anayzing methemoglobin, this method can accurately analyze control
blood, etc. which contain methemoglobin.
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3. MEASURING UNIT HYDRAULIC SYSTEM BLOCK DIAGRAM

<Whole Blood M ode>

1.960 mL
: - RBC
Diluent 1.996 mL »| TD Chamber
~| Mixing Chamber 40 pL (1:25000)
40pL  (1:500) _‘
1.994 mL
> WBC
WBC/HGB Lyse LOMLl 15 Chamber
< 6 uL (1:500)
o -
S
>l ss Y
o
7))
@™ HGB Flow Cell
£
3 (1:500)

*

Whole Blood Sample (50 uL)

Figure 9-3-1: Hydraulic System in Whole Blood M ode

<Pre-diluted M ode>

1.99792 m

RBC
TD Chamber

Mixing Chamber 2.08 uL (1:25000)

Diluent

1.0 mL WBC
WBC/HGB Lyse > TD Chamber

78 uL (1:1000)

\/

AHS) HGB Flow Cell

(1:1000)

AAJBA 1010y mduuesr

1:26 Diluted Sample (200 pL)

Figure 9-3-2: Hydraulic System in Pre-diluted Mode

9-4 Sysmex KX-21 Operator’s Manual -- Revised October 1998



FUNCTIONAL DESCRIPTION

4.

CBC ANALYSIS

4.1 WBC/HGB Analysis Flow

In WBC and HGB analysis, the volume of WBC and hemoglobin in the blood are measured.

The flow of WBC/HGB analysis is described below:

Diluent; 2.0 mL WBC/HGB Lyse:
Whole Blood Mode 1.0 mL

Pre-diluted Mode 1.0 mL

Sample Rotor Valve

®

HGB Flow Cell

Whole Blood Mode : Diluent 1.994 mL
Whole Blood 6 pL

Pre-diluted Mode : Diluent 1.922 mL
1:26 Diluted Sample 78 uL

WBC Transducer
Tube or Microtube

Whole Blood Mode: 50 pL
Pre-diluted Mode: 1:26 Diluted Sample 200 pL

Figure 9-4-1: WBC/HGB Analysis Flow

®* Whole Blood Mode
(1) Blood isaspirated from the sample probe into the sample rotor valve.

(2) 6L of blood measured by the samplerotor valve istransferred to the WBC

\ Whole Blood Mode 1 mL
Pre-diluted Mode 1 mL

transducer chamber along with 1.994 mL of diluent. At the sametime, 1.0 mL of

WBC/HGB lyseis added to prepare 1:500 dilution sample.

When the solution is made to react in this status for approximately 10 seconds,
hemolyzed and platel ets shrink, with WBC membrane held asthey are. At the
time, hemoglobin is converted into red colored methemoglobin.

RBCis
same

(3) Of the diluted/hemolyzed sample in the WBC transducer chamber, approximately 1 mL

istransferred to the HGB flow cell.
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(4)

(5)

500 pL of samplein the WBC transducer is aspirated through the aperture. The pulses
of the blood cells when passing through the aperture are counted by the DC detection
method.

In the HGB flow cell, 555 nm wavel ength beam irradiated from the light emitting
diode (LED) is applied to the sample in the HGB flow cell. Concentration of this
sample is measured as absorbance. This absorbance is compared with that of the
diluent alone that was measured before addition of the sample, thereby calculating
HGB (hemoglobin value).

* Pre-diluted Mode

)

2

3)

(4)

()

Blood sample that was diluted beforehand to 1:26 dilution using CELLPACK. This
sample is aspirated from the sample probe into the sample rotor valve.

78 uL of diluted blood measured by the sample rotor vaveistransferred to the WBC
transducer chamber along with 1.922 mL of diluent. At thistime, 1.0 mL of
WBC/HGB lyseis added to prepare 1:1000 dilution sample.

When the solution is made to react in this status for approximately 10 seconds, RBC is
hemolyzed and platelets shrink, with WBC membrane held asthey are. At the same
time, hemoglobin is converted into red colored methemoglobin.

Of the diluted/hemolyzed sample in the WBC transducer chamber, approximately 1 mL
istransferred to the HGB flow cell.

500 pL of samplein the WBC transducer chamber is aspirated through the aperture.
The pulses of the blood cells when passing through the aperture are counted by the DC
detection method.

In the HGB flow cell, 555 nm wavel ength beam irradiated from the light emitting
diode (LED) is applied to the samplein the HGB flow cell. Concentration of this
sample is measured as absorbance. This absorbance is compared with that of the
diluent alone that was measured before addition of the sample, thereby calculating
HGB (hemoglobin value).

9-6
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4.2 RBC/PLT Analysis Flow

In RBC/PLT anaysis, RBC and platelet count in the blood are measured. The flow of
RBC/PLT analysisis described below:

* \Whole Blood Mode

Diluent: 2.0 mL Diluent 1.996 mL
Whole Blood 4 uL

Sample Rotor Valve CDiluent 1.960 mL)

1:500 Diluted Sample 40 puL

N
Q\SZJ
=

<«

@ RBC/PLT Transducer
(1:500 Diluted Sample: 40 L) ]
Tube . | —
(Whole Blood: 50 pL) Mixing Chamber

Figure 9-4-2: RBC/PLT Analysis Flow in Whole Blood M ode
(1) Bloodisaspirated from the sample probe into the sample rotor valve.

(2) 4.0 uL of blood measured by the sample rotor valveis diluted into 1:500 with 1.996
mL of diluent and brought to the mixing chamber as diluted sample. (1st step dilution)

(3 Out of the 1:500 dilution sample, 40 pL is measured by the sample rotor valve, diluted
into 1:25000 with 1.960 mL of diluent, then transferred to the RBC/PLT transducer
chamber. (2nd step dilution)

(4) 250 pL of the sampleinthe RBC/PLT transducer chamber is aspirated through the
aperture. Atthistime, RBC and PLT are counted by the DC detection method.
At the sametime, HCT (hematocrit value) is caculated by RBC pulse height detection
method.
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®* Pre-diluted Mode

Diluent - 2.0 mL CDiIuent 1.99792 mL)

1:26 Diluted Sample 2.08 pL

Sample Rotor Valve

Microtube RBC/PLT Transducer
(1:26 Diluted Sample: 200 pL)

Figure 9-4-3: RBC/PLT Analysis Flow in Pre-diluted M ode

(1) Blood sample that was diluted beforehand to 1:26 dilution using CELLPACK. This
sample is aspirated from the sample probe into the sample rotor valve.

(2) 2.08 pL of diluted blood measured by the sample rotor valve istransferred in 1.99792
mL of diluent to the RBC/PLT transducer chamber, and is made into 1:25000 dilution

sample.

(3) Of thesampleinthe RBC/PLT transducer chamber, 250 pL is aspirated through the
aperture. Atthistime, RBC and PLT are calculated by the DC detection method. At
the sametime, HCT (hematocrit value) is calculated by RBC pulse height detection
method.
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4.3 Calculation of RBC Constant

RBC constant (mean RBC volume, mean RBC hemoglobin, mean RBC hemoglobin
concentration) is calculated from RBC, HGB, and HCT.

1. MeanRBCVolume(MCV)
Calculation is made from RBC and HCT by the formula below:
HCT (%)

RBC (x10%/pL)

MCV (fL) =

2.  Mean RBC Hemoglobin (MCH)
Calculation is made from RBC and HGB by the formula below:
HGB (g/dL)

RBC (x10%/pL)

MCH (pg) =

3.  Mean RBC Hemoglobin Concentration (MCHC)
Calculation is made from HCT and HGB by the formula below:

HGB (g/dL)
MCHC (g/dL) = ——————— x100
HCT (%)
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BLOOD CELL DISCRIMINATION CIRCUIT

WBC, RBC, and PLT are discriminated and calculated by the following blood cell
discriminator.

5.1 WBC Discriminator

Asto WBC LOWER discriminator, the optimum position in 30 - 60 fL is automatically
determined by the microcomputer. WBC is calculated from the particle counts more than this
LOWER discriminator.

5.2 RBC Discriminator

Asto RBC LOWER discriminator and UPPER discriminator, the optimum positionin 25 -
75 fL and 200 - 250 fL, respectively, are automatically determined by the microcomputer.
RBC is calculated from the particle counts between this LOWER discriminator and UPPER
discriminator.

5.3 PLT Discriminator

Asto PLT LOWER discriminator and UPPER discriminator, the optimum positionin 2 - 6
fL and 12 - 30 fL, respectively, are automatically determined by the microcomputer. PLT
count is calculated from the particle counts between this LOWER discriminator and UPPER
discriminator.

9-10
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6. ANALYSIS OF HISTOGRAM

Analysis of histogram allows use of the flagging system that suggests sample error or
instrument error.

Histograms of WBC, RBC, and PLT can be cal cul ated respectively within the ranges given
below.

WBC: Approx. 30 - 300 fL (particle after lyse dripping)
RBC: Approx. 25 - 250 fL
PLT: Approx.2-30fL

6.1 Analysis of WBC Histogram

1.  WBC Histogram
The WBC histogram is discriminated into small, middle, and large WBC by 3-part
differential method using 4 discriminators. The LOWER discriminator (LD) is
automatically determined at an optimum position between 30 and 60 fL. The UPPER
discriminator (UD) isfixed at 300 fL, which is used as the monitor for histogram
error. The WBC histogram troughs in the (L D)-to-(UD) range are determined; the 1st
oneisdefined TROUGH Discriminator 1 (T1) and the 2nd one TROUGH
Discriminator 2 (T2).

* WBC Histogram

LD T1 T2 ub
WBC : : : :

00 1 N . N
[ 1po 200 300 [fL]
Lymphocytes  Mixed cells  Neutrophils

Figure 9-6-1: WBC Histogram

1) LYM#[W-SCC (WBC-Small Cell Count) ]
Lymphocytes between discriminator (LD) and (T1), which is considered highly
correlated with lymphocyte count.

2) MXD#[W-MCC (WBC-Middle Cell Count) ]
Mixed cells between discriminator (T1) and (T2), which is considered highly
correlated with the sum of monocytes, basophils, and eosinophils.

3) NEUT#[W-LCC (WBC-Large Cell Count)]
Neutrophils more than discriminator (T2), which is considered highly correlated
with neutrophils.
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4) LYM% [W-SCR (WBC-Small Cell Ratio) ]
Ratio of lymphocytesto whole WBC

5) MXD% [W-MCR (WBC-Middle Cell Ratio) ]
Ratio of mixed cédllsto whole WBC

6) NEUT% [W-LCR (WBC-Large Cell Ratio) ]
Ratio of neutrophilsto whole WBC
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2. WBC Histogram Error Flag
When the WBC histogram is normal with three peaks, there are alower trough (T1)
and a higher trough (T2) between LOWER discriminator (LD) and UPPER
discriminator (UD).

® Qutput Example of Normal WBC Three-Peak Histogram

b T T2 ub WBC 6.7 [x10%uL]
WBC i LYM% 28.3 [%]
MXD% 17.4 [%]
NEUT% 54.3 [%]

T | LYM# 1.9 [x10%uL]

Too 200 30 MXD# 1.2 [x10%/uL]

NEUT# 3.6 [x10%/pL]

Figure 9-6-2: Normal WBC Three-Peak Histogram

When TROUGH Discriminator (T1) or (T2) cannot be set or when frequency for a set
discriminator position is higher than the range, it is flagged as WBC histogram error.
Those histogram error flags are listed below in the order of higher priority. If more
than one flag are applied, the flag of the highest priority is taken.

WL: Relative frequency for LOWER discriminator (LD) exceedsthe range. Probable
causeisinclusion of numerous platel et agglutinations, large platelets, and etc.

T1. Lower TROUGH Discriminator, that distinguishes lymphocytes and mixed cells,
cannot be not determined.

T2: Higher TROUGH Discriminator, that distinguishes mixed cells and neutrophils,
cannot be not determined.

F1. Small cell histogram error. Relative frequency for T1 exceeds the range.
F2: Middlecdl histogram error. Relative frequency for T1 or T2 exceeds the range.
F3: Largecell histogram error. Relative frequency for T2 exceeds the range.

WU: Relative frequency for UPPER discriminator (UD) exceeds the range.
Applicable cases are those in which hemolysisisinsufficient (for instance,
samples whose RBC membrane has extremely strong resistance against lyse) or
in which numerous abnormal blood cells are present.

AG: The particle count equal to or lessthan the LD exceeds a prescribed range.
Probable causeis platelet agglutination, which does not alter WBC count but
may result in decreased platelet count. Therefore, thisflag is added to the PLT
parameter.
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* WBC and Calculation Parameters versus Analysis Vaue Error Flags

WBC Histogram Error Flag Output
(1] (2]
(N:Z‘se LD | TL | T2 | UD |WBC |LYM% | MXD% [NEUT%| LYM# | MXD# |NEUT# | HOST
1 High WL WL WL WL WL WL WL 1
2A (@) X (@] T1 T1 T1 T1 T1 T1 5
2B (@) X High | WU T1 T1 T1 T1 T1 T1 5
3A O High X (@] F1 T2 T2 F1 T2 T2 6
3B (@] High X High | WU F1 T2 T2 F1 T2 T2 6
3C (@) (@) X (@) T2 T2 T2 T2 6
3D (@) (@) X High | WU T2 T2 T2 T2 6
4A (@) High (@) (@) F1 F2 F1 F2 7
4B (@) High (@) High | WU F1 F2 F1 F2 7
4C O | High | High | ©O F1 F2 F3 F1 F2 F3 7
4D O High | High | High | WU F1 F2 F3 F1 F2 F3 7
5A (@) @) High @] F2 F3 F2 F3 8
5B (@) O | High | High | WU F2 F3 F2 F3 8
6 @) (o) o) High | WU 2
(The particle count equal to PLT parameter is flagged with AG. 2
or less than LD is higher than
the range)
[1] : Output flag to LCD screen, built-in printer.
[2] : Output flag to serial interface (if incorporated as option).
O : Analysis result of each discriminator is normal
High : Frequency for each discriminator is higher than the range.
x 1 Atrough is not clear and cannot be detected.
1 : Anyof"O,""x," and "High" is applicable.

Table 9-6-1: WBC Histogram Error Flags

NOTE: » When analyzing in the pre-diluted mode, since CBC8 parameters only
are output, flagging is limited to a WBC parameter.
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1) 1A Histogram having high LD frequency with troughs T1 and T2
WL flag is added to al WBC parameters (WBC, LY M%, MXD%, NEUT%,
LYM#, MXD#, NEUTH#).

* WBC Histogram Error-WL (1A)

I ub WBC WL 8.5 [x10%uL]
LYM% WL 39.3 [%]
MXD% WL 17.6 [%]
NEUT% WL 43.1[%]
T | LYM# WL 3.4 [x10%pL]
100200 300 1] MXD# WL 1.5 [x10%uL]
NEUT# WL 3.6 [x10%pL]

Figure 9-6-3: WBC Histogram Error-WL (1A)

2) 1B Histogram with high LD and trough T1 but without T2
WL flag isadded to al analysisresultsfor WBC, LYM% and LY M#. WL flag
is added to mixed cell and neutrophil parameters (MXD%, NEUT%, MXD#,
NEUT#) and their data are not output. ([---.-])

* WBC Histogram Error-WL (1B)

Wee ,,LsD Tl UP WBC WL 2.8 [x10%uL]
SN 1 LYM% WL 45.9 [%)]
MXD% WL .- [%]
NEUT% WL --.-[%]

: : LYM# WL 1.3 [x10%/uL]

100 200 300 L] MXD# WL .- [x10%pL]

NEUT# WL ---.- [x10%/uL]
Figure 9-6-4: WBC Histogram Error-WL (1B)
3) 1C Histogram with high LD but without T1
WL flag is added to WBC and other parameters are not output. Note [+] on

WBC numeric datain the example below. This WBC value exceeds the upper
Patient Mark Limits mentioned earlier.

* WBC Histogram Error-WL (1C)

wee | P e WBC WL +16.4 [x10%/pL]
iy 1 LYM% WL ---.-[%)]
MXD% WL --.-[%]
NEUT% WL -—-.-[%]

: LYM# WL .- [x10%/uL]

100 200 300 [fL] MXD# WL .- [x10%/uL]

NEUT# WL .- [x10%/uL]

Figure 9-6-5: WBC Histogram Error-WL (1C)
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4)  2A Histogram without T1
Although the histogram error flag is not added to WBC, al other parameters are
flagged with T1 and their data are not output. Note that WBC in the graph
exceeds the upper Patient Mark Limits.

® WBC Histogram Error-T1 (2A)

LD ub WBC +15.4 [x10%/uL]
WBC ; :
| LYM% Tl  ---.-[%]
MXD% — T1  --[%]
NEUT% Tl  ---.-[%]
: LYM# T1 - [x10%uL]
100 200 300 [fL] MXD# Tl - [x10%pL]
NEUT# Tl - [x10%uL]

Figure 9-6-6: WBC Histogram Error-T1 (2A)

5) 2B Histogram having high UD but without T1
WBC isflagged with WU. All other parameters are flagged with T1 and their
data are not output.

6) 3A Histogram with high T1 but without T2
WBC isnot flagged. F1 flagisadded to lymphocyte parameters (LY M%,
LYM#). Mixed cell and neutrophil parameters (MXD%, NEUT%, MXD#,
NEUT#) are flagged with T2 and their data are not output.

* WBC Histogram Error-T2 (3A)

b T o WBC 5.2 [x10¥L]
WBC N 3
LYM%  F1 207 [%]
MXD% T2 - [%]
NEUT% T2 —--[%]
| | LYM# F1I  1.5[x10%uL]
100 200 300 [fL] MXD# T2 - [x10%uL]
NEUT# T2 - [x109yL]

Figure 9-6-7: WBC Histogram Error-T2 (3A)

7) 3B Histogram with high T1 but without T2, and high in UD frequency
WBC isflagged with WU and lymphocyte parameters (LY M%, LY M#) are
flagged with F1. Mixed cell and neutrophil parameters (MXD%, NEUT%,
MXD#, NEUT#) are flagged with T2 and their data are not outpui.
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8) 3C Histogram with T1 but without T2
WBC and lymphocyte parameters (LY M%, LY M#) are not flagged asthe
histogram error. Mixed cell and neutrophil parameters (MXD%, NEUT%,
MXD#, NEUT#) are flagged with T2 and data are not output.
WBC shown below exceeds the upper Patient Mark Limits.

* WBC Histogram Error-T2 (3C)

LDT1 ub WBC +15.2 [x10%/pL]
weC| | | ‘
LYM% 12.9 [%]
MXD% T2 - [%]
NEUT% T2 ---[%]
1 LYM# 1.6 [x10%/pL]
100 200 300 [fL] MXD# T2 == [x10%L]
NEUT# T2 - [x10%uL]

Figure 9-6-8: WBC Histogram Error-T2 (3C)

9) 3D Histogram with high T1 but no T2, and with high UD
WBC isflagged with WU. Lymphocyte parameters (LY M%, LY M#) are not
flagged. Mixed cell and neutrophil parameters (MXD%, NEUT%, MXD#,
NEUT#) are flagged with T2 and their data are not outpuit.

10) 4A Histogram with high T1
WBC and neutrophil parameters (NEUT%, NEUT#) are not flagged.
Lymphocyte parameters (LY M%, LY M#) are flagged with F1 and mixed cell
parameters (MXD%, MXD#) are flagged with F2.

* WBC Histogram Error - F1 (4A)

e LED T}l T2 up WBC 6.7 [x10%L]
LYM% F128.3 [%]
MXD% F217.4 [%]
NEUT% 54.3 [%]

o | LYM# F1 1.9 [x10%pL]

To0 200 300 [ MXD# F2 1.2 [x10%pL]

NEUT# 3.6 [x10%/pL]

Figure 9-6-9: WBC Histogram Error - F1 (4A)

11) 4B Histogram with high T1 and UD
WABC isflagged with WU, lymphocyte parameters (LY M%, LY M#) are flagged
with F1, and mixed cell parameters (MXD%, MXD#) with F2. Neutrophil
parameters (NEUT%, NEUT#) are not flagged.
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12) 4C Histogram with high T1 and high T2

WBC isnot flagged. Lymphocyte parameters (LY M%, LY M#) are flagged with
F1, mixed cell parameters (MXD%, MXD#) with F2, and neutrophil parameters
(NEUT%, NEUT#) with F3.

* WBC Histogram Error - F1 (4C)

13)

14)

LD TL T2 ub WBC 10.7 [x10%/uL]

LYM% F1 20.8 [%)]
MXD% F2 11.2 [%)]
NEUT%  F3 68.0[%]
L | LYM# F1 2.2 [x10%uL]
To0 200 300 [f] MXD# F2 1.2 [x10%uL]
NEUT# F3  7.3[x10%uL]
Figure 9-6-10: WBC Histogram Error - F1 (4C)

WBC

4D Histogram highinall T1, T2, and UD

WBC data are output with WU flag, lymphocyte parameters (LY M%, LY M#)
with F1 flag, mixed cell parameters (MXD%, MXD#) with F2 flag, and
neutrophil parameters (NEUT%, NEUT#) with F3 flag.

5A Histogram with high T2

Histogram error flag is not added to WBC and lymphocyte parameters (LY M%,
LYM#). Mixed cell parameters (MXD%, MXD#) are flagged with F2, and
neutrophil parameters (NEUT%, NEUT#) with F3 flag. WBC and MXD%
exceed the upper Patient Mark Limits.

* WBC Histogram Error - F2 (5A)

15)

wee| i i P WBC +18.5 [x10%L]
LYMY% 9.5 [%]
MXD%  F2 +23.7 [%]
NEUT%  F3 66.8 [%]

< : LYM# 1.1 [x10%/L]

— 0 200 300 [fL] MXD# F2 2.7 [x10%uL]

NEUT# F3 7.7 [x10%uL]
Figure 9-6-11: WBC Histogram Error - F2 (5A)

5B Histogram with high T2 and high UD

WABC isflagged with WU and lymphocyte parameters (LY M%, LY M#) are not
flagged. Mixed cell parameters (MXD%, MXD#) are flagged with F2, and
neutrophil parameters (NEUT%, NEUT#) with F3.

9-18
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16) 6 Histogram with high UD

WBC isflagged with WU and other parameters are not flagged. WBC in this
instance exceeds the upper Patient Mark Limits.

* WBC Histogram Error - WU (6)

Wee b Tz ub WBC WU+ 15.4 [x10%/pL]
LYM% 24.5 [%]
MXD% 7.5[%]
NEUT% 68 [%]

o | LYM# 3.3 [x10%pL]

00 200 300 L] MXD# 1.0 [x10%/uL]

NEUT# 8.1 [x10%/pL]

Figure 9-6-12: WBC Histogram Error - WU (6)

17) 7 Theparticle count equal to or lessthan LD ishigher than therange.
PLT isflagged with AG and other parameters are not flagged.
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6.2 Analysis of RBC/PLT Histogram

1

RBC Histogram

As mentioned earlier, RBC are determined as particle counts between two
discriminators (LD) and (UD) which are automatically counted in the ranges of 25 - 75
fL and 200 - 250 fL, respectively.

Asto histogram, check is made for relative frequency errors on respective
discriminator levels, for more than one peak, and for distribution width error.

In addition, thisinstrument is capable of expressing RBC distribution width (RDW) by
two methods below:

RDW-CV (RBC Distribution Width - Coefficient of Variation) is calculated by the
formula below, after determining points L1 and L2 for 68.26% of the entire particle
area

® Cadculation of RDW-CV

L2- L1

RDW-CV (%) = x100

2+t L

/}— 68.26% of Entire Distribution Area

L1 L2
Figure 9-6-13: Calculation of RDW-CV

RDW-SD (RBC Distribution Width - Standard Deviation) is set on 20% frequency
level with the peak taken as 100%.

® Definition of RDW-SD

100%

A

RDW-SD

Figure 9-6-14: Definition of RDW-SD

9-20
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2.  PLT Histogram
Platelet histogram is analyzed using three discriminators. two discriminators (LD) and

(UD) - determined automatically between 2 - 6 fL and between 12 - 30 fL, respectively
-and the fixed discriminator at 12 fL. Regarding PLT histogram, check is made to see
that there are no relative frequency errors at discriminators (LD) and (UD), distribution
width error, and there is a single peak.

1) PDW (PLT Distribution Width)
PDW isthe distribution width on 20% frequency level with the peak taken as
100%. The unit appliedisfL (femto=10"L).

® Definitions of PDW and P-LCR

100%

(LD) (12L) (UD)
PDW

Figure 9-6-15: Definitions of PDW and P-LCR

2) MPV (Mean Platelet Volume)
MPV iscalculated by the following formula:

MPV (fL) = PeT (of’) x1000
PLT (x10*/uL)

Where PCT (%) represents the value weighted with PLT frequency and is called
platelet-crit or platelet volumeratio. The analysis method used isthe same as

mentioned in HCT analysis principle 4.2 RBC/PLT Analysis Flow in this chapter.

3) P-LCR (LargePlatelet Ratio)
Thisistheratio of large platel ets exceeding 12 fL discriminator and is cal culated
asthe ratio of the particle count between the 12-fL fixed discriminator and Upper
discriminator (UD) to the particle count between Lower discriminator (LD) and

Upper discriminator (UD).
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3. RBC Histogram Error Flag

When RBC histogram is not normal, a histogram error flag is added to the

corresponding parameter of the analysis value. Those histogram error flags are listed

in the order of higher priority. When two or more flags are applicable to a parameter,

the highest-priority flag is used.

RL: Relative frequency for LOWER discriminator (LD) exceedsthe range. Probable
causeisthe effect of noise, RBC morphological change, platelet coagulation, or
thelike.

RU: Réative frequency for UPPER discriminator (UD) exceeds the range. Probable
causeisthe effect of noise.

MP: Two or more peaksin histogram.
DW: Particle distribution width error for 20% frequency with the peak taken as 100%.

When the 20% frequency does not cross the histogram two times, thisflag is
attached.

® Matching of eight kinds of RBC histogram error flags

RBC Histogram Error Flag Output
(1] (2
Case RDW | RDW
No. LD ub DW MP RBC | HCT | MCV | MCH |MCHC| PLT SD -cV HOST
1A High O o RL RL RL RL RL RL RL RL 1
1B High X O RL RL RL RL RL RL DW RL 1
1C High X RL RL RL RL RL RL MP MP 1
2A (@) High O O RU RU RU RU RU RU RU RU 2
2B o High X (@) RU RU RU RU RU RU DW RU 2
2C o High x RU RU RU RU RU RU MP MP 2
3 o (@) X (@) DW 3
4 o ) x MP MP 4
[1]: Output flag to LCD screen, built-in printer.
[2]: Output flag to serial interface (if incorporated as option).
O: +When analysis results of LD and UD are normal
* In the case of DW, when RDW-SD could be analyzed
« In the case of MP, when RBC histogram has a single peak
High: Frequencies of LD and UD are higher than the range
x: e« Inthe case of DW, when RDW-SD could not be analyzed
« In the case of MP, when RBC histogram has two or more peaks
L1 Anyof "O ,""x," and "High" is applicable.
Table 9-6-2: RBC Histogram Error Flags
NOTE:  Since CBC8 parameters only are output in the pre-diluted mode, a flag

is not output to RDW-SD or RDW-CV.
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1) 1A Histogram with high frequency for LD
RBC, HCT, MCV, MCH, MCHC, PLT, and particle distribution width data
parameters are flagged with RL. MCV and RDW-SD exceed the upper Patient
Mark Limits, and MCHC falls below the lower Patient Mark Limits.

® RBC Histogram Error - RL (1A)

RBC : 1 RBC RL 3.57 [x10%/uL]
‘ ‘ HGB 11.5 [g/dL]
HCT RL 41.8 [%]
MCV RL  +117.1[fL]
MCH RL 32.2 [pg]
: ‘ i MCHC RL -27.5 [g/dL]
100 200 250 [fL]
RDW-SD  RL +91.7 [fL]
PLT RL 185 [x10%pL]

Figure 9-6-16: RBC Histogram Error - RL (1A)

2) 1B High frequency for LD with 20% particle distribution width error
RBC, HCT, MCV, MCH, MCHC, and PLT parameters are flagged with RL.
Of the particle distribution width data, RDW-CV isflagged with RL and its data
are output. RDW-SD parameter is flagged with DW and its data are not outpui.

3) 1C High LD with two or more peaks
RBC, HCT, MCV, MCH, MCHC, and PLT parameters are flagged with RL.
RDW-CV isflagged with MP and its data are output, while RDW-SD is flagged
with MP but its data are not output.

4)  2A Frequency high for UD
RBC, HCT, MCV, MCH, MCHC, PLT, and particle distribution width data
parameters are flagged with RU. In thisinstance, flagsto indicate that their data
are out of Patient Mark Limits are added to MCV, MCHC, and RDW-SD.

® RBC Histogram Error - RU (2A)

RBC RU 3.57 [x10%/uL]
RBC HGB 11.5 [g/dL]

HCT RU  41.8[%]

MCV RU  +117.1fL]

MCH RU 32.2 [pg]

MCHC RU  -27.5[g/dL]

100 200 250 [fL] RDW-SD RU  +91.7 [fL]

PLT RU 185 [x10%/pL]

Figure 9-6-17: RBC Histogram Error - RU (2A)
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5 2B High UD with 20%-frequency distribution width error
RBC, HCT, MCV, MCH, MCHC, and PLT parameters are flagged. Out of the
particle distribution width data, RDW-CV isflagged with RU and its data are
output.
RDW-SD isflagged with DW and its data are not output. In thisinstance, MCV
and MCHC are out of Patient Mark Limits.

* RBC Histogram Error - RU, DW (2B)

RBC RU  3.57 [x10%uL]
RBC HGB 11.5 [g/dL]
HCT RU  52.9[%]
MCV RU +148.2 [fL]
MCH RU  32.2[pg]
‘ ‘ ‘ 1 MCHC RU  -21.7 [g/dL]
100 200 250 [fL] ROW-SD DW - [fL]
PLT RU  185[x10%/uL]

Figure 9-6-18: RBC Histogram Error - RU, DW (2B)

6) 2C High UD with two or more peaks
RBC, HCT, MCV, MCH, MCHC, and PLT parameters are flagged with RU.
Asto particle distribution width data, RDW-CV isflagged with MP and its data
are output, while RDW-SD is also flagged with MP but its data are not output.

7) 3 20%-frequency particledistribution width error
RBC, HCT, MCV, MCH, MCHC, and PLT parameters are not flagged. Asto
the particle distribution width data, RDW-CV data are output without flagging,
while RDW-SD data are flagged with DW and their data are not output.

8) 4 Twoor more peaks
RBC, HCT, MCV, MCH, MCHC, and PLT parameters are not flagged. Asto
the particle distribution width data, RDW-CV data are output with MP flag.
RDW-SD isflagged with MP and its data are not output. In thisinstance, RDW-
CV isout of Patient Mark Limits.

® RBC Histogram Error - MP (4)

RBC RBC 4.80 [x10°/uL]
HGB 14.2 [g/dL]
HCT 41.5 [%]
MCV 86.5 [fL]
MCH 29.6 [pg]
N | MCHC -34.2 [g/dL]
100 200 250 [fL] RDW-CV  MP  +33.3 [%)]
PLT 216 [x10°/pL]

Figure 9-6-19: RBC Histogram Error - MP (4)
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4.  Platelet Histogram Error Flag
When the platelet histogram is not normal, a histogram error flag is added to the
corresponding parameter of the analysis value. Those histogram error flags - used
with the particle distribution analysis unit mounted, are listed in the order of higher
priority.

When two or more flags are applicable to a parameter, the highest priority flag is used.

PL: Réativefrequency for LOWER discriminator (LD) exceedsthe range. Probable
causeisthe effect of noise and etc.

PU: Réative frequency for UPPER discriminator (UD) exceedsthe range. Probable
causeisthe effect of platelet agglutination, noise interference, and etc.

MP: Two or more peaksin histogram
DW: Particle distribution width error for 20% frequency with the peak taken as 100%.

When the 20% frequency does not cross the histogram two times, thisflag is
attached.

® Matching of eight kinds of platelet histogram error flags

Platelet Histogram Error Flag Output
[1] [2]

ﬁﬁ?e LD | UD | DW | MP | PLT |PDW | MPV |P-LCR|HOST
1A | High o | o | P | P | P | P | 1
1B | High x o | PL |DW | PL | P | 1
1C | High x | PL | MP | PL | PL | 1
2A | o |Hgh| o | o [ Pu|Pu|PUu|PUu| 2
2B | O |High| x o |Pu |DW | PU | PU | 2
2C | o | High x | PU | MP | PU | PU | 2
3 o | o x o DW | DW | DW | 3
4 o | o x MP | MP | MP | 4

[1]: Output flag to LCD screen, built-in printer.
[2]: Output flag to serial interface (if incorporated as option).
O: «When analysis results of LD and UD are normal
* In the case of DW, when PDW could be analyzed
« In the case of MP, when PLT histogram has a single peak
High: Frequencies of LD and UD are higher than the range.
x: * In the case of DW, when PDW could not be analyzed
« In the case of MP, when PLT histogram has two or more peaks
L Anyof"O,""x," and "High" is applicable.

Table 9-6-3: Platelet Histogram Error Flags
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NOTE: » Since CBC8 parameters only are output in the pre-diluted mode, flag
output is limited to a PLT parameter.
1) 1A High frequency for LD

PLT, PDW, MPV, and P-LCR parameters are flagged with PL.

* Platelet Histogram Error - PL (1A)

2)

3)

4)

5)

PLT | .

PLT PL 211 [x10%/uL]
PDW PL  12.5]fL]
MPV PL 9.3 [fL]

PLCR PL  -22.6[%]

10 0 a0 I
Figure 9-6-20: Platelet Histogram Error - PL (1A)

1B High LD with 20%-frequency distribution width error

PLT parameter isflagged with PL. Particle distribution width (PDW) isflagged
with DW and its data are not outpui.

MPV and P-LCR are flagged with PL and their data are not outpui.

1C High LD with two or more peaks

PLT parameter isflagged with PL. Particle distribution width (PDW) is flagged
with MP and its data are not outpui.

MPV and P-LCR are flagged with PL and their data are not output.

2A High UD
PLT, PDW, MPV, and P-LCR parameters are flagged with PU.

2B High UD with 20%-frequency particle distribution width error

PLT parameter isflagged with PU. Particle distribution width (PDW) is flagged
with DW and its data are not outpui.

MPV and P-LCR are flagged with PU and their data are not output.

* Platelet Histogram Error - PU (2B)

PLT | !
PLT PU 171 [x10%/uL]

PDW DW ---.-[fL]

""" MPV PU ---[fL]

P-LCR  PU --.-[%]

10 20 30 [

Figure 9-6-21: Platelet Histogram Error - PU (2B)
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6) 2C High UD with two or more peaks
PLT parameter isflagged with PU. Particle distribution width (PDW) is flagged
with MP and its data are not outpui.
MPV and P-LCR are flagged with PU and their data are not output.

7) 3 20%-frequency particledistribution width error
PLT isnot flagged. PDW, MPV, and P-LCR are flagged with DW and their
data are not output.

* Platelet Histogram Error - DW (3)

PLT |

PLT 91 [x10%uL]
PDW DW - [fL]
MPV DW - [fL]

PLCR  DW .- [%]

10 20 0 [
Figure 9-6-22: Platelet Histogram Error - DW (3)

8) 4 Twoor more peaks
PLT isnot flagged. Other parameters are flagged with MP and their data are not
output.

* Platelet Histogram Error - MP (4)

PLT, .
‘ PLT 155 [x10%/uL]
PDW MP - -[fL]
MPV MP - .-[fL]
P-LCR MP - - [%)]

10 20 30 [

Figure 9-6-23: Platelet Histogram Error - MP (4)
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7. ELECTRIC SYSTEM

The microprocessor in the main unit controls the hydraulic system's solenoid valves and
master valves, thus regulating the flow of samples, reagents, and waste in the hydraulic
system.

Electric signals received from various transducers go through the analogue circuit for
electrical waveform-processing, and to the microcomputer. The microcomputer converts the
analogue signalsinto digital signalsfor the calculation.

The WBC, RBC, and PLT cell signals are sent to the respective waveform-processing
circuitsin the analogue circuit, where the noise in signalsis eliminated to acquire the required
cell signalsonly. The microcomputer converts the A/D-converted cell signalsinto particle
distribution data, and outputs them to the built-in printer or to the host computer (optional).

To calculate HGB, absorbance of only the diluent (background) is deducted from samples
absorbance. The beam that has passed through the fluid is detected by the photo diode. And
the signals is photoelectrically converted, A/D converted, and then sent to the HGB counting
circuit for the calculation of the absorbance.
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Electric Diagram
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Figure 9-7-1: Electric Diagram
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8. NAMES AND FUNCTIONS OF INSTRUMENTS

8.1 Front Pane€l

4) Graphic Screen
?‘
Sysmex /
1) Front Cover —
5) Panel Keyboard
C [ —]
TN e [}
2) Sample Probe : }%/
o0BEH=2
M O—-c—o
3) START switch Uﬁ
1|
L/ L/

1)

2)

3)

4)

5)

Figure 9-8-1: Front Panel

Front Cover
The front cover can be opened to the right by your hands. It is opened to replace lyse
containers, check or clean the interior of measuring unit.

Sample Probe
The sample probeis used to aspirate sample in the whole blood and pre-diluted modes.

START Switch
This switch starts whole blood mode analysis and pre-diluted mode analysis.

Graphic Screen
This displays Sample Nos., analysis results, instrument status, error messages, etc.

For detail, refer to Chapter 1, Section 8: GRAPHIC SCREEN.

Panel Keyboard
This keyboard allows basic operations such as entry of Sample No. and selection of

analysis parameters. For detail, refer to Chapter 1, Section 7: PANEL KEYBOARD.
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8.2 Front Interior

2) Sample Rotor Valve (SRV)

1) Detector Block

]

l_l.I .//

3) Rinse Cup Ty EI %

4) WBC/HGB Lyse ! ® D%:'% 5) Built-in Printer
(STROMATOLYSER-WH) e —— R

1)

2)

3)

4)

5)

| | e

Figure 9-8-2: Front Interior

Detector Block
Incorporates RBC transducer, WBC transducer, and HGB flow cell.

Sample Rotor Valve (SRV)
Makes volumetric measurement of aspirated blood.

Rinse Cup
Cleans the sample probe.

WBC/HGB Lyse (STROMATOLYSER-WH)
Reagent to measure WBC/HGB

Built-in Printer
Prints analysis data, error messages, €tc.
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8.3 Right Side Panel

1) Fuse

2) Power Supply Switch

3) Power Supply Connector

n:

Figure 9-8-3: Right Side Panel

1) Fuse
Replace with provided time-lag type fuse. The rating will be different depending on
the instrument specification.

Specification Part No. Description Fuse Type
117VAC 266-5109-1 | Fuse 250V 3.15 A ST4-3.15A-N1 | TimelLag
220/240 VAC 266-5292-6 | Fuse 250V 2 A No. 19195 TimelLag

&WARNING » To avoid risk of electrical shock, disconnect the power cord before
replacing the fuses.

* For continued protection against risk of fire, use the fuse of specified
&CAUT'ON type and rating.

2) Power Supply Switch
Turns on and off the main unit power supply.

CAUTION: * Avoid turning this switch ON and OFF continuously in short duration.
This will overload the fuse and may cause fuse blown.

3) Power Supply Connector
Using the furnished power supply cord, this connector supplies power from the outlet.
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8.4 Left Side Panel

1) Trap Chamber

4) Alir filter | \I 2) 0.5 kglcm? Regulator
=
N (8

@

3) 250 mmHg Bellows Unit | —

[

© 7
L/

Figure 9-8-4: L eft Side Panel

1) Trap Chamber
Prevents reagent, etc. from flowing into the vacuum pump of the compressor when an
error occurs with the instrument.

2) 0.5 kg/cm?® Regulator
Regulates pressure to 0.5 kg/cm?.

3) 250 mmHg Bellows Unit
Regulates vacuum to 250 mmHg vacuum.

4)  Air Filter
Prevents dirt and dust from entering the bellows.
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8.5 Left Side Interior

1) Waste Chamber

2) Pneumatic Unit

O e J

Figure 9-8-5: Left SideInterior

1) Waste Chamber
Collects wastes from transducers and mixing chambers.

2)  Pneumatic Unit
Supplies pressure and vacuum.

CAUTION: » Do no open the left face unless your Sysmex service representative

asks you to.
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8.6 Rear Panel

1) Serial Interface (Option)

2) Drain Outlet Nipple

3) Diluent Inlet Nipple
(CELLPACK)

s [ |
L/

Figure 9-8-6: Rear Panel

1) Serial Interface (Option)
Connector for communicating with the host computer

2) Drain Outlet Nipple
This nipple drains waste. It connects with the drain sewer or waste tank.

3) Diluent Inlet Nipple (CELLPACK)
This nipple aspirates diluent. 1t connects with the diluent container.
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INSTRUMENT SETUP

1. INTRODUCTION

Y our Sysmex service representative performs the settings of the instrument at time of
installation. The settings can be changed by using this program.
This chapter describes how to use this setting program.

System Setup
Sets up the instrument system status.

Date/Time
Sets date/time of the built-in clock.

Patient Limit
Sets upper and lower Patient Mark Limitsto check for error in analysis data.

QC Settings
Selects between X control and L-J control as the QC method, and sets the output method of
QC data.

Host Settings (when the optional serial interface is incorporated)
Sets the interface conditions for transferring data to the host computer.

Printer Settings
Sets the output selection and output conditions of the built-in printer.

Print Set Values
Prints all the contents of the settings by the built-in printer.

Peripheral Setting
Sets whether to Use or Not Use of the built-in printer or the host computer (option) output.

CAUTION:  The setting program can be run only when the instrument is ready. “

NOTE: » Menu selection method

(1) Cursor selection (explained in this Manual)
Using [A] or [¥] key, move the cursor to a desired program and
press [ENTER] key to set.

(2) Direct key selection
Using the numeric keys, enter a menu number of the program you
want to set, thus selecting the menu.
The menu number is displayed on the Menu screen.

» Change set values and move the cursor to the next parameter using
[A] or [¥] key ([<] or [P™] key also can be used in Patient Limit setting)
or press [ENTER] key. This sets the settings.
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2. SYSTEM SETUP

This program is used to set unit system, display language, WBC analysis parameters, and
RDW calculation method.

How to Setup System Status
(1) Press[SELECT] key onthe Analysis screen. The Select Menu screen appears.

(2) Using [A] or [¥] key, move the cursor to select "6: Settings.”
(3) Press[ENTER] key. The Setting Menu screen appears.

*Settings*

1: Syst em Set up
Da

tel Ti me
Patient Limt
QC Settings
Host Settings
Printer Settings

2
3
4
5
6
7:Print Set Val ues

Figure 10-2-1: Setting Menu Screen

NOTE:  "5: Host Settings” is displayed only when the optional serial interface is
incorporated.

(4) Using [A] or [¥] key, move the cursor to select "1: System Setup.”
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(5 Press[ENTER] key. The current setting status is displayed on the System Setup

screen.

*Syst em Set up*

Language
Par anet er Nami ng
RDW

o

LYMA
RDW SD

Press [SELECT] to exit.

Figure 10-2-2: System Setup Screen

(6) Using [A] or [¥] key, move the cursor to select the desired set parameter.
For System Setup, four parameters can be set.

(7) Using [« or [™] key, select the content of settings. Each time you press the key, the
content of settings changes.

(8) Press[ENTER] key. The content of settingsis set and the cursor moves to the next set

parameter.

NOTE: * The settings can also be set when you press [A] or [V¥] key after
changing the content of settings.

1) Unit Setting

Sets the unit system for displaying analysisdata. The unit can be selected from
the following six kinds:

Settings Unit System Settings Unit System
Type 1 For Japan Type 4 Dutch Sl
Type 2 For General Export || Type 5 Standard S
Type 3 Canada SI Type 6 Hong Kong Sl

Table 10-2-1: Unit Setting

For the detail of unit system, refer to the following table:

Sysmex KX-21 Operator’s Manual --

Revised October 1998
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For Japan For General Export Canada SI
Item Decimal Unit Decimal Unit Decimal Unit
point point point

WBC #Hit#H# x10%/uL #itH # x10%/uL #it# H# x10°%/L
RBC #HH#H# x10%/uL #t ## x10°%/uL #H#H#H | x10%/L
HGB Hit# # g/dL Hit# # g/dL Hit# g/L
HCT #Hi# # % #Hi# H# % #. 444 | L/IL
MCV #it# # fL #iti # fL HitH # fL
MCH #HH#H H# pg #HHH # pg #HHH . # pg
MCHC #it# # g/dL #itH # g/dL #H#H# g/L
PLT #itH # x10%/uL #HH#H# x10%/uL #H## x10°%/L
LYM% #Hi# # % Hi# # % #.H#H#H
MXD% #Hi# # % #Hi# H# % #.H7HH
NEUT% #it# # % #iti # % # #H#t#
LYM# #Hit#H# x10%/uL #it# # x10%/uL #Hit# H# x10°%/L
MXD# #Hit#H# x10%/uL #itH # x103%/uL #it# H# x10°%/L
NEUT# #HH#H# x10%/uL #itH # x10%/uL it H# x10°%/L
RDW-SD #Hi# # fL Hi# # fL Hit# H# fL
RDW-CV #Hi# # % #Hi# H# % #.H7HH
MPV #it# # fL #iti # fL HitH H# fL
PDW #it# # fL #it# # fL #Hit# H# fL
P-LCR #it# # % #HitH # % iidiaid

Dutch SI Standard Sl Hong Kong SI

Item Decimal Unit Decimal Unit Decimal Unit
point point point

WBC #it# # x10°/L #it# # x10°%/L it # x10°%/L
RBC #i##H | x10%/L #it ## x10%%/L ##H## | x10%/L
HGB #itH # mmol/L #HH#H# g/L it H# g/dL
HCT #.##4# | L/IL # . #iH #.H#HHH
MCV #Hi# # fL #Hi# H# fL Hit# H# fL
MCH HHHH amol #HH# # pg HHH.# pg
MCHC #it# # mmol/L #H#H# g/L it # g/dL
PLT #Hit#H# x10°/L #HH#H# x10°%/L #H## x10°%/L
LYM% #.##H# #.#H#HH it H# %
MXD% # . #HHH # . #iH Hit# H# %
NEUT% #.#HH #. #HH Hit# H# %
LYM# #it# # x10°/L #iti # x10%/L H#itH H# x10°/L
MXD# #it# # x10°/L #it# # x10°%/L it # x10°%/L
NEUT# #it# # x10°/L #itH # x10°%/L #it# # x10°%/L
RDW-SD #itH # fL #itH # fL it H# fL
RDW-CV # . #HHH # . #iH Hit# H# %
MPV #Hi# # fL #Hi# H# fL Hit# H# fL
PDW #it# # fL #iti # fL H#itH H# fL
P-LCR #.##H# #.##H# idiaid %

Table 10-2-2: Details of Unit System
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2) Language Setting
Set the language for displaying on the screen. The language can be selected from
the three kinds listed below:

Settings Display language
Japanese Japanese
English English
Chinese Chinese

Table 10-2-3: Language Setting

3) Parameter Name Setting
Set WBC analysis parameter names. The parameter can be selected from the
following two kinds:

Settings Analysis Parameter Name
W-SCR W-SCR
W-MCR
W-LCR
W-SCC
W-MCC
W-LCC
LYM% LYM%
MXD%
NEUT%
LYM#
MXD#
NEUT#

Table 10-2-4: Parameter Name Setting

4) RDW Setting
Set the RDW calculation method. The RDW cal culation method can be selected
from the following two kinds:

Settings RDW Calculation Method
RDW-SD RDW-SD
RDW-CV RDW-CV

Table 10-2-5: RDW Setting

NOTE:  The settings of system setup become valid from the next time you turn
ON the instrument power.
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(9) When the setting of each parameter is completed, press [SELECT] key. The Setting
Change Confirmation message appears.

Change? Set __ Cancel
Figure 10-2-3: Setting Change Confirmation M essage

(10) Using[ <] or [™] key, move the cursor to select "Cont.," "Set," or "Cancel."

[Cont.]: Returnsto the System Setup screen. And the setting operation can be
continued.
[Set]: Updates the settings and returns to the Analysis screen.

[Canéd] : Cancels the changed settings and returns to the Analysis screen.
(11) Press[ENTER] to execute the selected process.

NOTE: * When you change the system setup, always turn OFF then ON the
power. Until you do this, the changed contents of the settings will not
be reflected.

10-6
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3. DATE/TIME SETTINGS

Thisinstrument displays date/time on analysis data, using the built-in clock.
This program is used to set the date/time for the built-in clock and date format.

How to Set Date/Time
(1) Press[SELECT] key onthe Analysis screen. The Select Menu screen appears.

(2) Using [A] or [¥] key, move the cursor to select "6: Settings.”
(3) Press[ENTER] key. The Setting Menu screen appears.

*Settings*

1: Syst em Set up
Da

tel Ti me
Patient Limt
QC Settings
Host Settings
Printer Settings

2
3
4
5
6
7:Print Set Val ues

Figure 10-3-1: Setting Menu Screen

NOTE:  "5: Host Settings” is displayed only when the optional serial interface is
incorporated.

(4) Using [A] or [¥] key, move the cursor to select "2: Date/Time."
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(5 Press[ENTER] key. The current setting statusis displayed on the Date/Time screen.

*Dat e/ Ti mex
dd/ rmi
vy 1997
mm 12
dd 31
hh 23
mm 59

Press [SELECT] to exit.

Figure 10-3-2: Date/Time Screen
(6) Using [A] or [¥] key, move the cursor to select the desired set parameter.
(7) Using [«], [»™], or the numeric keys, set each parameter.
In setting the date format, use [ ] or [P] key. Year, month, day, hour, and minute
are entered using the numeric keys.

(8) Press[ENTER] key. The content of the settingsis set and the cursor moves to the
next set parameter.

NOTE: « The settings can also be set when you press [A] or [¥] key after
changing the content of settings.

1) DateFormat Setting
Using [ 4] or [ ] key, select the date format.
The date format can be selected from the following three types. It changes each
time you press the key.

Settings Example of display
yy/mm/dd 97/12/31
mm/dd/yy 12/31/97
dd/mm/yy 31/12/97

Table 10-3-1: Date Format Setting

2) Year Setting
Enter in the dominical year using the numeric keys.

3) Month Setting
Enter using 1 - 12 from the numeric keys.

10-8
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4)  Day Setting
Enter using O - 31 from the numeric keys.

5 Hour Setting
Enter in the 24-hour system using O - 23 from the numeric keys.

6) Minute Setting
Enter using 0 - 59 from the numeric keys.

(99 When the setting of each parameter is completed, press [SELECT] key.
The date entered is checked and when there is no setting error, the Setting Change
Confirmation message is displayed.
If there is any setting error, the alarm sounds and the Setting Change Confirmation
message is not displayed.

NOTE:  About the date setting, the following items are checked:
Leap year check: whether 2/29 is set in non-leap year
Month/day check: whether 4/31, e.g., is set

Change? Il St Cancel
Figure 10-3-3: Setting Change Confirmation M essage

(10) Using [« or [™] key, move the cursor to select "Cont.," "Set," or "Cancel."

[Cont.]: Returnsto the Date/Time screen. And the setting operation can be
continued.
[Set]: Updates the settings and returns to the Analysis screen.

[Canéel] . Cancelsthe changed settings and returns to the Analysis screen.
(11) Press[ENTER] key to execute the selected process.
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4. PATIENT LIMIT

For Patient Limit, you can set Mark Limits.

The Mark Limits are the values set to determine whether analysis values are within the

normal range or not. This program can be used to set the upper and lower Mark Limitsfor
each analysis parameter.

When analysis data exceeds the upper Mark Limit, it is flagged with [+] mark, and when it
exceedsthe lower Mark Limit, it isflagged with [-] mark. Analysis data output to the built-in
printer or the host computer is also attached with either marks.

How to Set Mark Limits
(1) Press[SELECT] key onthe Analysis screen. The Select Menu screen appears.

(2) Using [A] or [¥] key, move the cursor to select "6: Settings.”
(3) Press[ENTER] key. The Setting Menu screen appears.

*Settings*

1: Syst em Set up
Da

tel Ti me
Patient Limt
QC Settings
Host Settings
Printer Settings

2
3
4
5
6
7:Print Set Val ues

Figure 10-4-1: Setting Menu Screen

NOTE: » "5: Host Settings” is displayed only when the optional serial interface is
incorporated.

(4) Using [A] or [¥] key, move the cursor to select "3: Patient Limit."
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(5 Press[ENTER] key. The current setting status is displayed on the Patient Limit

screen.
*Patient Limtx
LL UL

(VBC 15. 0 x10% uL
RBC 2.50 5.50 x10% pL
HGB 8.0 17.0 g/dL
HCT 26.0 50.0 %
MoV 86.0 110.0 fL
MCH 26.0 38.0 pg
MCHC 31.0 37.0 g/dL
PLT 50 400 x10% pL
LYMA 5.0 55.0 %
MXD% 1.0 20.0 %

Press [SELECT] to exit.

Figure 10-4-2: Patient Limit Screen

(6) Using [A] or [ V] key, move the cursor to select the desired set parameter.

NOTE: * Total 19 setting parameters of Patient Limit are displayed. But not all of
them can be displayed in one screen at a time. Therefore, scroll the
screen using [A] or [V] key.

*Patient Limt~*
LL UL
MXD% 1.0 20.0 %
NEUT% 45.0 95.0 %
LYM# 0 0 x10% uL
MXD# 0 0 x10% pL
NEUT# 0 0 x10% pL
RDWSD 37.0 54.0 fL
RDWCV 11.0 16.0 %
PDW 9.0 17.0 %
VPV 9.0 13.0 fL
P-LCR 43.0 %
Press [ SELECT] to exit.

Figure 10-4-3: Scrolling the Screen

(7) Using [« or [™] key, move the cursor to select LL (Lower Limit) or UL (Upper

Limit).

(8) Enter the settings using the numeric keys.
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(9)

Press[ENTER] key. The content of settingsis set and the cursor moves to the next set
parameter.

NOTE: * When [A], [V], [], or [™] key is pressed after entering, the contents

of settings are also set.

* When both the upper and lower limits are set at "0," the judgment on
patient limit is not executed.

(10) When the setting of each parameter is completed, press [SELECT] key.

When the set values are checked and there is no setting error, the Setting Change
Confirmation message is displayed.

In case Upper Limit < Lower Limit is set, the alarm sounds and the Setting Change
Confirmation message is not displayed.

Change? Set __ Cancel

Figure 10-4-4: Setting Change Confirmation M essage

(11) Using [ <] or [™] key, move the cursor to select "Cont.," "Set," or "Cancel."
[Cont.]: Returnsto the Patient Limit screen. And the setting operation can be
continued.
[Set]: Updates the settings and returns to the Analysis screen.
[Cancel]:  Cancelsthe changed settings and returnsto the Analysis screen.
(12) Press[ENTER] key to execute the selected process.
10-12
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5. QC SETTINGS

This program is used to set QC method and output method of QC data. Two kinds of QC

methods are available with thisinstrument: X control and L-J control. Select either of them
that suits your purpose.

X Control: Control blood is subjected to two consecutive analyses and the mean of
them isused asthe QC data. This method causes little influence on
reproducibility in analysis.

L-J Control: This control uses the datafrom asingle analysis of control blood as QC

data. The control width in the L-J control is proneto influencein
reproducibility in analysis, so that the control width iswider than in the

case of X control.

How to Set QC Settings
(1) Press[SELECT] key onthe Analysis screen. The Select Menu screen appears.

(2) Using [A] or [¥] key, move the cursor to select "6: Settings.”
(3 Press[ENTER] key. The Setting Menu screen appears.

*Set ti ngs*

2: Date/ Ti me
3:Patient Limt
4: QC Settings
5: Host Settings
6:Printer Settings
7:Print Set Val ues

Figure 10-5-1: Setting Menu Screen

NOTE: * "5: Host Settings" is displayed only when the optional serial interface is
incorporated.

(4) Using [A] or [ Y] key, move the cursor to select "4: QC Settings."
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()

(6)

Press[ENTER] key. The current setting status is displayed on the QC Settings screen.

*QC Settings*
QC Met hod |
Dat a Qut put Print

Press [SELECT] to exit.

Figure 10-5-2: QC Settings Screen

Using [A] or [ ¥] key, move the cursor to select the set parameter. QC settings can be
made on two parameters.

(7) Using [« or [™] key, select the content of settings.
The content of settings changes each time you press the key.
(8) Press[ENTER] key. The content of setting is set and the cursor moves to the next
analysis parameter.
NOTE: » The settings can also be set when you press [A] or [¥] key after
changing the content of settings.
1) QC Method Setting
Set the QC method. The QC method can be selected from the following two
kinds: 17
Settings QC Method
X X Control
L-J L-J Control
Table 10-5-1: QC Method Setting
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2) Data Output Setting
Set the QC data output method. The QC data output can be selected from the
following four kinds:

Settings QC data output
None Not output
Print Print on built-in printer
Host Output to host computer
Print, Host Print on built-in printer and output to host computer

Table 10-5-2: Data Output Setting

NOTE: * QOutput to the host computer is valid only when the option is

incorporated.

* For print format to the built-in printer, refer to Chapter 5, Section 2.6:
Execute X Control or Chapter 5, Section 2.7: Execute L-J Control.

* For output format to the host computer, refer to Appendix B: Technical
Information.

* The data output format for quality control differs from the format for usual
analysis.

(90 When the setting for each parameter is completed, press [SELECT] key. The Setting
Change Confirmation message appears.

Change? BTl st Cancel
Figure 10-5-3: Setting Change Confirmation M essage

(10) Using [ <] or [™] key, move the cursor to select "Cont.," "Set," or "Cancel."
[Cont.]: Returnsto the QC Settings screen. And the setting operation can be
continued.
[Set]: Updates the settings and returns to the Analysis screen.
[Cancdl]: Cancels the changed settings and returns to the Analysis screen.

(11) Press[ENTER] key to execute the selected process.
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6. HOST SETTINGS (OPTION)

This program is used to set the interface conditions for transferring data to the host compuiter.

NOTE: * "Host Settings" is displayed only when the optional serial interface is
incorporated.

How to Set Host Output
(1) Press[SELECT] key on the Analysis screen. The Select Menu screen appears.

(2) Using [A] or [ Y] key, move the cursor to select "6: Settings.”
(3) Press[ENTER] key. The Setting Menu screen appears.

*Set ti ngs*

[N

:Date/ Ti me
cPatient Limt

: QC Settings
:Host Settings
:Printer Settings
:Print Set Val ues

~NOUIAWN

Figure 10-6-1: Setting Menu Screen

NOTE: « "5: Host Settings" is displayed only when the optional serial interface is
incorporated.

(4) Using [A] or [¥] key, move the cursor to select "5: Host Settings.”
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(5 Press[ENTER] key. The current setting statusis displayed on the Host Settings

screen.

*Host Setti ngs*
[
Qut put For nat K- 1000
Aut o Qut put n
Baud Rate 2400
Data Length Thits
Stop Bit 2bit
Parity Check Even
Pr ot ocol dass A
I nt erval 2
RTS/ CTS I gnore

Press [SELECT] to exit.

Figure 10-6-2: Host Settings Screen

(6) Using [A] or [ V] key, move the cursor to select the desired set parameter. For Host
Settings, eight parameters can be set.

(7) Using [«] or [™] key, select the condition. The condition changes each time you

press the key.

(8) Press[ENTER] key. The content of settingsis set and the cursor moves to the next set
parameter.

NOTE: « The settings can also be set when you press [A] or [V¥] key after

changing the content of settings.

1) Connect Settings
Set whether to connect the host computer or not.

Settings Connection
Use Connect
Not Use Not Connect

Table 10-6-1: Host Output Settings
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2) Output Format Settings
Set output format of analysis data to the host computer. This can be selected
from the following two kinds:

Settings Output Format

K-1000 ASCII data is output in the published format.
Refer to Appendix B: Technical Information.

K-DPS Binary data is output for connecting with K-DPS.
Data format is not published.

Table 10-6-2: Output Format Settings

3) Auto Output Settings
Set whether to make auto output to the host computer or not.

Settings Auto Output
On Auto Output
Off Not Auto Output

Table 10-6-3: Auto Output Settings

4) Baud Rate Settings
Set the baud rate. This can be selected from the following four kinds:

Settings Baud Rate
1200 1200 bps
2400 2400 bps
4800 4800 bps
9600 9600 bps

Table 10-6-4: Baud Rate Settings

5) DataLength Settings
Set the data length. This can be selected from the following two kinds:

Settings Data Length
7 bits 7 bits
8 bits 8 bits

Table 10-6-5: Data L ength Settings
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6) Stop Bit Settings
Set the stop bit. This can be set selected from the following two kinds:

Settings Stop Bit
1 bit 1 bit
2 bits 2 bits

Table 10-6-6: Stop Bit Settings

7) Parity Check Settings
Set the parity check method. This can be set selected from the following three

kinds:
Settings Parity Check
None None
Odd Odd
Even Even

Table 10-6-7: Parity Check Settings

8) Protocol Settings
Set the protocol. This can be set selected from the following two kinds:

Settings Protocol
Class A Class A
Class B Class B

Table 10-6-8: Protocol Settings

9) Transmission interval Settings
Select atransmission interval from the following:

Settings Interval
0 0 second
2 2 seconds
3 3 seconds
5
7

5 seconds
7 seconds
10 10 seconds
15 15 seconds

Table 10-6-9: Transmission Interval
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(9)

10) RTS/CTScontrol Settings
Specify whether or not the RTS/CTS flow control takes place.

Settings RTS/CTS control
Refer Allowed
Ignore Not allowed

Table 10-6-10: RTS/CTS control

When the setting of each parameter is completed, press [SELECT] key. The Setting
Change Confirmation message appears.

Change? Il St Cancel
Figure 10-6-3: Setting Change Confirmation M essage

(10) Using [« or [™] key, move the cursor to select "Cont.," "Set," or "Cancel."

[Cont.]: Returnsto the Host Settings screen. And the setti ng operation can be
continued.
[Set]: Updates the settings and returns to the Analysis screen.

[Cancel]:  Cancelsthe changed settings and returnsto the Analysis screen.

(11) Press[ENTER] key to execute the selected process.

10-20
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7. PRINTER SETTINGS

This program is used to set the output selection and output conditions for the built-in printer.

How to Set Printer Output
(1) Press[SELECT] key onthe Analysis screen. The Select Menu screen appears.

(2) Using [A] or [¥] key, move the cursor to select "6: Settings.”
(3) Press[ENTER] key. The Setting Menu screen appears.

*Set ti ngs*

[=Y

:Date/ Tine

:Patient Linit

: QC Settings

: Host Settings
:Printer Settings
:Print Set Val ues

~NO O WN

Figure 10-7-1: Setting Menu Screen

NOTE:  "5: Host Settings” is displayed only when the optional serial interface is
incorporated.

(4) Using [A] or [¥] key, move the cursor to select "6: Printer Settings.”

(5) Press[ENTER] key. The current setting status is displayed on the Printer Settings
screen.

*Printer Settings*

Use |
Print Condition Al Data
Print Fornat Typel

Press [ SELECT] to exit.

Figure 10-7-2: Printer Settings Screen
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(6) Using [A] or [¥] key, move the cursor to select the set parameter. Printer settings can
be made on three parameters.

(7) Using [ 4] or [™] key, select the condition.
The condition changes each time you press the key.

(8) Press[ENTER] key. The content of settingsis set and the cursor moves to the next set
parameter.

NOTE: * The settings can also be set when you press [A] or [V¥] key after
changing the content of settings.

1) Connect Settings
Set whether to connect the built-in printer or not.

Settings Connection
Use Connect
Not Use Not Connect

Table 10-7-1: Built-in Printer Settings

2)  Print Condition Settings
Set the auto print condition for the built-in printer. This can be selected from the
following three kinds:

Settings Auto Print Conditions
All Data Print All Samples
Abnormal Data Print Abnormal Data Only
None Not Auto Print

Table 10-7-2: Print Condition Settings

NOTE: - Data printed as abnormal data:
« Data in which analysis error occurred
- Data in which noise error occurred
- Data with flags other than Mark Limits
« Data with histogram flag
« Data out of the linearity limit
« For print conditions of QC data, refer to Chapter 10, Section 5: QC
Settings.
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3) Print Format Settings
Set the print format for the built-in printer. This can be selected from the
following three kinds:

Settings Print Format
Type 1 Print 18 parameters + histograms.
Type 2 Print 18 parameters.
Type 3 Print 8 parameters.

Table 10-7-3: Print Format Settings

NOTE: * For print format, refer to Chapter 2, Section 5.2 Printing of Analysis
Result.
« For print format for quality control, refer to Chapter 5, Section 2.6:
Execute X Control or Chapter 5, Section 2.7: Execute L-J Control.

(90 When the setting of each parameter is completed, press [SELECT] key. The Setting
Change Confirmation message appears.

Change? Il St Cancel
Figure 10-7-3: Setting Change Confirmation M essage

(10) Using [« or [™] key, move the cursor to select "Cont.," "Set," or "Cancel."

[Cont.]: Returnsto the Printer Settings screen. And the setting operation can be
continued.
[Set]: Updates the settings and returns to the Analysis screen.

[Cancel]:  Cancelsthe changed settings and returnsto the Analysis screen.
(11) Press[ENTER] key to execute the selected process.
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8. PRINT SET VALUES
To backup the set values, al the contents of the settings can be printed by the built-in printer.

How to Print Set Values
(1) Press[SELECT] key onthe Analysis screen. The Select Menu screen appears.

(2) Using [A] or [¥] key, move the cursor to select "6: Settings.”
(3) Press[ENTER] key. The Setting Menu screen appears.

*Set ti ngs*

1: Syst em Set up

2: Date/ Ti me
3:Patient Limt

4: QC Settings

5: Host Settings
6:Printer Settings
7:

Pr
Print Set Val ues

Figure 10-8-1: Setting Menu Screen

NOTE: * "5: Host Settings" is displayed only when the optional serial interface is
incorporated.

(4) Using [A] or [ V] key, move the cursor to select "7: Print Set Vaues."
(5) Press[ENTER] key. The built-in printer starts printing al the set values.

NOTE: « If any faulty operation occurs, contact your Sysmex service
representative. Keep the printed contents of the settings in good
condition because the service representative may have to confirm the
contents of settings.
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9. PERIPHERAL SETTINGS

When you want to temporarily cancel external output due to error occurrence, use this
program to set "Use" or "Not use" of the built-in printer or optional host computer output.

NOTE: * "Host Output” is displayed only when the optional serial interface is
incorporated.
* For peripheral settings, refer to "5: "Host Settings" and "6: Printer
Settings" which carry description of similar settings.

How to Set Peripheral Connection
(1) Press[SELECT] key onthe Analysis screen. The Select Menu screen appears.

* SELECT*

=

:Quality Control
:Calibration

: Repl ace Lyse
:Auto R nse
:Settings

: Mai nt enance
:Periph. Settings

CO~NOUITAWN

o
o

:PU Sl eep

Figure 10-9-1: Select Menu Screen
(2) Using [A] or [ V] key, move the cursor to select "8: Periph. Settings.”

(3) Press[ENTER] key. Thisdisplays connection status of external devices on the
Peripheral Settings screen.

*Peri ph. Settings*

Built-in Printer [ Use |
Host Qut put Not Use

Press [SELECT] to exit.

Figure 10-9-2: Peripheral Settings Screen
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(4) Using [A] or ['¥] key, move the cursor to select the desired external device.

(5 Using [« or [»] key, select "Use" or "Not Use". "Use" and "Not Use" change over
each time you press the key.

(6) Press[ENTER] key. The content of the settingsis set and moves the cursor to the
next set parameter.

NOTE: * The settings can also be set when you press [A] or [V¥] key after
changing the content of settings.

(7) Press[SELECT] key. The Setting Change Confirmation message appears.

Change? Set __ Cancel
Figure 10-9-3: Setting Change Confirmation M essage

(8) Using [ <] or [™] key, move the cursor to select "Cont.," "Set," or "Cancel."

[Cont.]: Returnsto the Periphera Settings screen. And the setting operation can
be continued.
[Set]: Updates the settings and returns to the Analysis screen.

[Canéel] :  Cancelsthe changed settings and returns to the Analysis screen.
(9) Press[ENTER] key to execute the selected process.
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10.

FACTORY SETTINGS

The settings made at the factory are listed below:

System Settings
Units

Language
Parameter Naming
RDW

Date/Time
Date Format

Patient Limits
WBC
RBC
HGB
HCT
MCV
MCH
MCHC
PLT
W-SCR
W-MCR
W-LCR
W-SCC
W-MCC
W-LCC
RDW-SD
RDW-CV
PDW
MPV
P-LCR

QC Settings
QC Method
Data Output

Printer Settings
Built-in Printer
Print Condition
Print Format

Host Settings
Host Output
Output format
Auto Output
Baud Rate
Data Length
Stop Bit
Parity Check
Protocol
Interval
RTS/ICTS

Type?2

English

LYM%

RDW-SD

dd/mm/yy

LL UL

3.0 15.0
2.50 5.50

8.0 17.0
26.0 50.0
86.0 110.0
26.0 38.0
31.0 37.0

50 400

5.0 55.0

1.0 20.0
45.0 95.0

0.0 0.0

0.0 0.0

0.0 0.0
37.0 54.0
11.0 16.0

9.0 17.0

9.0 13.0
13.0 43.0

X

Print

Use

All Data

Typel

Not use

K-1000

Off

2400 bps

7 bits

2 bits

Even

ClassA

2

Ignore
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APPENDIX A: INSTALLATION

1. INTRODUGCTION ..ttt e e A-1
2. CHECK BEFORE INSTALLATION ...oiiiiiiiii e A-2
3. INSTALLATION SPACE ... e e A-3
4. REMOVE SHIPPING CLAMPS ..o A-4
B, CONNECT TUBE ...t e A-6
5.1 Prepare REAEN ... A-6
5.2 ConNECt CELLPACK . ... A-6
5.3 Connect STROMATOLYSER-WH.....ooviiiiii e A-8
5.4 CONNECELWASIELING. ..ot A-9
6. SETPRINTERPAPER.....ccooiieii A-10
7. CONNECTPOWER CORD ..ot A-12
8. TURNPOWER ON ...ttt A-12
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INTRODUCTION

Thisproduct isaclinical test instrument. Sysmex representative is responsible for
unpacking, installing, and initial setup of the product to ensure its proper and safe operation.
The next several pages will give some essential information on this instrument.

NOTE: » When the optional serial interface function is intended to incorporate to
this instrument, following optional part should be ordered in prior to the
installation so that Sysmex service representative could install at once.

973-4531-1 OUTPUT UNIT NO. 1 KX-21

Sysmex KX-21 Operator’s Manual -- Revised January 2000 A-1



INSTALLATION

2. CHECK BEFORE INSTALLATION
Make sure the KX-21 is free from external damages and check the quantities of the
aCCessories.
Q'ty
No. Part No. Description 117V 220V | 240V
1 | 461-2263-8 Operator's Manual KX-21 (North American) 1 0 0
1 | 461-2261-1 Operator's Manual KX-21 (English) 0 1 1
2 | 923-8092-8 Power Cord No. 15 (C-2/N. Amer) 1 - -
2 | 265-4719-0 Power Cord 4622-007-0092 (Europe) - 1 -
2 | 265-4728-3 Power Cord No. 7650 (U.K.) - - 1
3 | 943-1781-1 Cubitainer Spout Kit No. 1 1 1 1
4 | 973-3041-7 Float Switch No. 23 1 1 1
5 | 367-1051-9 Tray No. 20 1 1 1
6 | 442-5338-7 Tube Polyurethane 4 mm ID x 6 mm OD 3m 3m 3m
7 | 442-5340-5 Tube Polyurethane 6 mm ID x 9 mm OD 6m 6m 6m
8 | 423-1776-2 Mini Pipette No. 10 (1 mL) 2 2 2
9 | 933-3601-9 Brush No. 1 Assy 1 1 1
10 | 266-5109-1 Fuse 250V 3.15A ST4-3.15A-N1 2 - -
10 | 266-5292-6 Fuse 250V 2A No. 19195 (Europe) - 2 2
11 | 266-6743-4 Clamp LWS-8S-2.5W 1 1 1
12 | 369-8234-6 Caution Mark No.170 1 1 1
Table A-2-1: KX-21 Unpacking Checklist
NOTE: e Item No. 4 (973-3041-7 Float Switch No. 23) is pre-installed in the
Main Unit Front Interior at the factory.
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3. INSTALLATION SPACE

To ensure that the instrument performsto its full extent, it should be installed at an
appropriate place.

» Select aplace where the power supply islocated close.

» Secure a space for maintenance and service. Giving consideration to heat radiation by the

instrument, provide at least 50 cm clearance between the wall and the instrument's side

rear, and top panels.
Each dimension of the instrument is shown below. The power cord is 1.8 m long.

Width (mm) Depth (mm) Height (mm) Weight (kg)
Main Unit 420 355 480 28

—

480

/

Figure A-3-1: Instrument Dimensions
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4. REMOVE SHIPPING CLAMPS
(1) Ped off the fixing tape of the outer cover gently.

Figure A-4-1: Removing the Tape
(2) Open the front cover of the main unit.

(3) Removethe protection sheets of the sampling valve.
1) Removethe SRV fixing screw.
2)  Withthefixed and rotary valves separated sufficiently, remove the protection
sheets.
3) Returnthevavesand the SRV fixing screw to their original positions.
4)  Set the provided samplerotor vavetray.

SN n

Tray No. 20 %

Protection Sheets

Figure A-4-2: Removing the Protection Sheets
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(4) Remove the pneumatic unit fixing screws (2 pcs). Keep these screws for future use.

Fixing Screws
Figure A-4-3: Removing the Screws

(5 Removethe rubber caps of the reagent connection nipples. Keep these rubber caps for
future use.

& @/
0 /,/ %
o %@ Rubber Caps
7 — 7

Figure A-4-4: Removing the Rubber Caps
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5. CONNECT TUBE
5.1 Prepare Reagent

Prepare the reagents and connection kits shown below.

Reagent Part No. Type Part Name Connection Kit
884-0871-1 PK-30L CELLPACK Cubitainer spout kit No. 1 (for 20L)
974-0521-6 SWH-200A | STROMATOLYSER-WH | Float switch No. 23

5.2 Connect CELLPACK

(1) Preparethefollowing reagent tube.
Tube Polyurethane 4 mmID x 6 mmOD : 1 pc

NOTE: * Cut the tube to an appropriate length, and connect it. “

(2) Connect the diluent (CELLPACK) inlet aspiration nipple behind the unit and the nipple
of the cubitainer spout kit No. 1 with the tube polyurethane 4 mmiD x 6 mmQOD.

(3) Set the cubitainer spout kit No. 1 to the CELLPACK container.

—

—  —Cap

/ Cubitainer Spout Kit No. 1

Figure A-5-1: Setting the Cubitainer Spout Kit
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Diluent Inlet Nipple

[j Tube Polyurethane 4 mmID x 6 mmOD
£k Cubitainer Spout Kit No. 1
I—
— CELLPACK
/

Figure A-5-2: Connecting the CELLPACK

* Take care not to spill a reagent on to the instrument. If it spills, wipe it
&CAUTlON off immediately using a wet cloth or the like.
« If it happens to adhere to your skin, wash it off using plenty of water.
* If a reagent happens to enter your eye, wash it off immediately using
plenty of water, and take medical treatment at once.
* After unpacking, be sure not to allow dust or dirt to come into the
instrument. Use up CELLPACK within 60 days from the unpacking
date, and STROMATOLYSER-WH within 90 days.

CAUTION: * When the diluent (CELLPACK) tube is more than 2 m long, it may be
impossible to have reagent aspirated. Avoid setting CELLPACK at a
level higher than the instrument; otherwise, reagent may flow into the
vacuum line, possibly damaging the instrument.

CAUTION: » After connecting the tube, do not pull it by force for reagent
replacement.
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5.3 Connect STROMATOLYSER-WH
(1) Gently remove the provided float switch No. 23 from the dust-protection bag.
(2) Install thefloat switch No. 23 to STROMATOLY SER-WH. Then, set it to the table.

Figure A-5-4: Installing the STROMATOL Y SER-WH
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5.4 Connect Waste Line

(1) Preparethefollowing waste line tube.
Tube Polyurethane 6 mmID x 9 mmOD : 1 pc

(2) Connect an end of the tube polyurethane 6 mmID x 9 mmOD to the drain outlet nipple
behind the unit. Connect the other end of the tube to the waste sewer in the lab.
If the waste sewer is not available, connect it to awaste tank.
The maximum waste line length is6 m.

NOTE: * Cut the tube to an appropriate length, and connect it.

* Since waste is removed from the system by pressurized air, the waste
tank may be located at the same height as, or lower than, the drain
outlet nipple. Otherwise the waste may be flown back into the
system, which will result of a malfunction.

(3) Arrange and tie the diluent and waste line tubings as shown in the figure using the

provided clamp.
Diluent Inlet Nipple
Drain Outlet Nipple
0 Tube Polyurethane 6 mmID x 9 mmOD
——
:
[ ]
| ]
s \Waste Sewer
or
7 I Ry w— Waste Tank

Clamp

Figure A-5-5: Connecting the Waste Line and Clamping Tubings
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6. SET PRINTER PAPER
(1) Open the front cover of the main unit.

(2) Turnthereleaselever up to free the paper.

Release Lever

Figure A-6-1. Releasing the Lever

(3 Mount aprinter paper.

Printer Paper

Figure A-6-2: Mounting a Printer Paper
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(4) Passthe printer paper as shown below, and turn the release lever down to secure.

Figure A-6-3: Securing the Release L ever

(5) Cut off any printer paper extending from the upper part of the printer.

Figure A-6-4. Cutting Off Paper

(6) Closethefront cover of the main unit.
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7. CONNECT POWER CORD

Connect the provided power cord to the power supply outlet.

@ Power Cord
/
Ml —|
©
/

Connect to the Power Supply Outlet

Figure A-7-1: Connecting the Power Cord

8. TURN POWER ON

It is necessary to run the service sequence at theinitial start-up.
Your Sysmex service representative is responsible for the operation.
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APPENDIX B: TECHNICAL INFORMATION

1. OUTPUT FORMAT FOR HOST COMPUTER (OPTION).......cccvivieennne, B-1
L1 HalrOWare. .o e B-1
1.2 SO WA . oo B-3
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1. OUTPUT FORMAT FOR HOST COMPUTER (OPTION)

The bit seria voltage type, which conforms to the RS-232C interface, is used for host
computer output of the KX-21. The serial interface port for the connection with the host
computer ison the rear panel of the main unit, when an option isincorporated.

NOTE: » When the optional serial interface function is intended to incorporate to
this instrument, following optional part should be ordered in prior to the
installation so that Sysmex service representative could install at once.

973-4531-1 OUTPUT UNIT NO. 1 KX-21

1.1 Hardware

1.  Connector
» The connector for the output to the host computer is located on the rear panel.
* Usea9-pin D-SUB, female connector.
» Fixing screws for this connector are in inch-specification.

2. Connector Signals

Pin No. Signal Name Signal Direction

1

2 Receive data (RxD) From Host to KX-21
3 Transmit Data (TxD) To Host from KX-21
4 Data Terminal Ready (DTR) To Host from KX-21
5 Signal Ground (SG)

6 Data Set Ready (DSR) From Host to KX-21
7 Request to Send (RTS) To Host from KX-21
8 Clear to Send (CTS) From Host to KX-21
9

Table B-1-1: Pin Assignment

3. Communication Format
The data is communicated in the asynchronous, half duplex mode.

4. Signal Leve
Signal level conformsto JIS C6361.

Level Data signal Control signal
+3V or higher Logic "0", Start bit ON
-3V or lower Logic "1", Stop bit OFF

TableB-1-2: Signal Level
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5. I nterface Circuit
e Output circuit

D@ 45 AVAVAY, 0 —q ouT
jg 300 Q EMI filter

Vss

MC145407 Driver

Figure B-1-1: Interface Output Circuit

* Input circuit

VDD
js 15 kQ
AYAYAY, 0—0 IN
EMI filter
5.4 kQ
Vss -

MC145407 Receiver |

Figure B-1-2: Interface Input Circuit
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1.2 Software

1. Communication Format

1) Code
ASCII codes are used for output.
(Except for K-DPS outpuit)

2)  Structureof text
"STX" (02 H) issent prior to dataand "ETX" (03 H) is sent at the end of data.
(Except for K-DPS output)

%
S E
T T
X X
%

Order of transmission g
Figure B-1-3: Order of Transmission

3) Communication protocol

The following 2 protocols are provided in the system, and can be selected according to

the system status.

* ClassA
One-way transmission to the host computer without requiring ACK nor NAK from
host computer.

* ClassB
The KX-21 transmits data and then waits for ACK or NAK to complete the data
transmission.

() (omm )
v ’

Analysis data is sent. p Analysis data is received.

Analysis data transmission When an error does not

is completed correctly. < ACK occur, ACK (06H) is sent.
Communication error
occurs. > When an error occurs, NAK
Analysis data is sent NAK (15H) is sent.

automatically (retrying up
to 3 times). If the reply is
still NAK after 3 retries,
instruction is made whether
the same data is sent again
or the transmission is
canceled by key input.

Figure B-1-4: Data Transmission

Sysmex KX-21 Operator’s Manual -- Revised October 1998 B-3



TECHNICAL INFORMATION

4)

5)

Transmission errors

If the KX-21 detects atransmission error, the datatransmission is canceled and an
error message is displayed. Re-transmission of the data ([1] key) or cancellation of the
transmission ([3] key) can be selected. Transmission errors occur in the following
situations.

» The computer isoff line.

» Thecontrol signal DSR is off.

» After the datais transmitted, there is no response from the computer in 15 seconds.
(Class B only)

o After the datais transmitted, other than ACK or NAK is sent from the compuiter.
(Class B only)

» After the dataistransmitted, the fourth NAK issent. (ClassB only. The KX-21
resends the data automatically up to 3 times when NAK issent.)

Timing, subject, and content of transmission

Serial interface
!
Host computer

Normal analysis Analysis data (A)

Quality control QC data (A)

Table B-1-3: Content of Transmission

» Analysis dataincludes the date, sample ID No., 18-parameter data, and the flag.
* QCdatais X or L-Jdata
» The setting of the connecting device is changed in the setting program.

Text Format

The following two types of formats are used for computer outpuit.
» K-1000: Format for connecting to the host computer

* K-DPS: Specid format for connecting to K-DPS

NOTE: » K-1000 format is selected at the time of shipping from the factory. “

The details of K-1000 format are as follows.

e K-1000 format
K-1000 format has two formats; one is"analysis dataformat" for output of the
sample data, and the other is"QC dataformat” for output of the QC data. They
differ in length and content of the text. (They are distinguished by the sample
distinction code.)
Thetext distinction code Il isfixed at "1".
However, when the text exceeds 256 bytes in afuture modification, the text is
divided into 2 or more blocks. The number in text distinction code Il shows the
order of the blocks. The ETB (17 H) is not used.

B-4
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TECHNICAL INFORMATION
(1) Anadysisdataformat (121 characters)
Parameter No. of Characters Example
STX 1 (02 H)
Text distinction code | 1 "D"
Text distinction code I 1 "1
Sample distinction code 1 "U"
Year (Month or Day) 2 "97"
Month (or Day) 2 "09"
Day (or Year) 2 "30"
Analysis information 1 (O
Sample ID No. 12 (00000000 0000)
PDA information 6 (O00000)
RDW select information 1 "S"or"C"
WBC [x103%/uL] 5 XXX XF
RBC [x10%/pL] 5 XXXXF
HGB [g/dL] 5 XXX XF
HCT [%] 5 XXX XF
MCV [fL] 5 XXX XF
MCH [pgl 5 XXX XF
MCHC [g/dL] 5 XXX XF
PLT [x10%/pL] 5 XXXXF
LYM% (W-SCR) [%] 5 XXX XF
MXD% (W-MCR) [%] 5 XXX XF
NEUT% (W-LCR) [%] 5 XXX XF
LYM# (W-SCC) [x10%/pL] 5 XXX XF
MXD# (W-MCC) [x103%/uL] 5 XXX XF
NEUT# (W-LCC) [x10%/pL] 5 XXX XF
RDW-SD/CV [fL/%)] 5 XXX XF
PDW [fL] 5 XXX XF
MPV [fL] 5 XXX XF
P-LCR [%] 5 XXX XF
ETX 1 (03 H)
Table B-1-4. Analysis Data Format
B-5
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(2) QCdataformat (99 characters)

Parameter No. of Characters Example
STX 1 (02 H)
Text distinction code | 1 "D"
Text distinction code |l 1 "1
Sample distinction code 1 "C"
Data distinction code 1 "X" or "L"
Year (Month or Day) 2 "97"
Month (or Day) 2 "09"
Day (or Year) 2 "30"
Hour 2 "09"
Minute 2 "59"
QC File Number 1 "5"
Not used 1 "0"
RDW select information 1 "c"
WBC [x103%/uL] 4 XXX X
LYM% (W-SCR) [%] 4 XXX X
MXD% (W-MCR) [%] 4 XXX X
NEUT% (W-LCR) [%6] 4 XXX X
LYM# (W-SCC) [x103%/uL] 4 XXX X
MXD# (W-MCC) [x10%/uL] 4 XXX X
NEUT# (W-LCC) [x103%/uL] 4 XXX X
RBC [x10%/uL] 4 XX XX
HGB [g/dL] 4 XXX X
HCT [9%6] 4 XXXX
MCV [fL] 4 XXX X
MCH [pal 4 XXX X
MCHC [g/dL] 4 XXX X
RDW-(CV/SD) [%/fL] 4 XXX X
PLT [x10%/uL] 4 XXXX
PDW [fL] 4 XXX X
MPV [fL] 4 XXX X
P-LCR [9%6] 4 XXX X
W-SMV [fL] 4 XXX X
W-LMV [fL] 4 XXX X
ETX 1 (03 H)

Table B-1-5: QC data format
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3)
1)

2)

3)

4)

5)

6)

Details of the analysis data output in K-1000 format

The order of output isfrom the top parameter to the bottom. The datais sent
from the upper line without performing zero suppression.

Because the decimal point is not sent, the decimal point specified in each
parameter has to be added and represented by numeric value at the host
computer.

The order of the date conforms to the format in the setting program in the setting
program.

Analysisinformation shows the following content of the analysis.

Manual No. input
WB mode analysis "0"
Pre-diluted mode analysis "5"

Table B-1-6: Analysis|nformation

The sample ID No. is 6-digit numerals, but 12 digits are output in this format.
The upper 6 digitsare 0’'s (zeros). Depending on the usage, "-" (2D H) may be

inserted in the numeral column. Inthiscase, "-" isincluded in the 12 digits.

PDA information consists of the following 6 items.

Item No. of Characters
WBC histogram information 1
WBC histogram flag 1
RBC histogram information 1
RBC histogram flag 1
PLT histogram information 1
PLT histogram flag 1

Table B-1-7: PDA Information

Code Description
"0 Histogram is normal.
"1 Histogram is abnormal.
"2" Manually discriminated

Table B-1-8: Histogram Information
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Code Description

"o" Normal
WBC/RBC/PLT

"1 (L) discriminator degree is high.
WBC/RBC/PLT

"2 (U) discriminator degree is high.
WBC/RBC/PLT

"3" Analysis is impossible because there is no pair of intersection on the 20%
degree level for calculation of DW.
RBC/PLT

"4 Two peaks are recognized in the particle distribution.
RBC/PLT

"5 (T1) discriminator cannot be determined.
WBC

"6" (T2) discriminator cannot be determined.
WBC

" (T1) discriminator level is high, and the data is not reliable.
WBC

"g8" (T1) or (T2) discriminator level is high, and the data is not reliable.
WBC

"g" (T2) discriminator level is high, and the data is not reliable.
WBC

"A" The particle count equal to or less than (L) discriminator exceeds the range.
WBC

Table B-1-9: Histogram Flag

The histogram flag corresponds to the flagging characters of the LCD and the built-in
printer as follows.

Particle distribution Flagging characters of LCD and built-in printer

FLAG WBC RBC PLT
“Q
“1” WL RL RL
“2" wuU RU RU
“3” DW DW
“qr MP MP
“5” T1
“6” T2
‘7" F1
“8” F2
“9” F3
"A" AG

Table B-1-10: Flagging Char acter
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7) RDW sdlect information
It shows whether RDW-CV or RDW-SD is output.
"C": RDW-CV
"S': RDW-SD

NOTE: « RDW-SD is selected at the time of shipping from the factory.
» To output RDW-CV, refer to Chapter 10, Section 2: System Setup.

8) Thenumerica data configuration in the Analysis Data Format is as follows.

Upper digit Lower digit
00000

.

Data Flag

Figure B-1-5: Numerical Data Configuration

Code Description
"o" Normal
"1 Abnormality judgment is "+."
"2" Abnormality judgment is "-."
"3" Out of linearity limit
"4" Reliability is low.

Table B-1-11: Details of Flag

9) If thedataover-flows, it isindicated as follows:
*0003

10) Incaseof anaysiserror, or if the data lacks some data such as the calculation
parameter in pre-diluted mode, the dataiis transmitted as follows:
*0000

Sysmex KX-21 Operator’s Manual -- Revised October 1998 B-9



INDEX

0.5 kg/cm2 Pressure Error -------------------- 7-7
0.5 kg/cm2 Pressure Error at count ---------- 7-9
250 mmHg Vacuum Error--------=--=--=----- 7-8
A
Abnormal Detection Sensitivity------------- 7-22
Adjusting Pressure to 0.5 kg/cm?® ------------- 8-5
Adjusting Vacuum to 250 mmHg------------ 8-6
Alarm SouNds--------========-=n=nmnmumeeeoo- 1-11
Analysis Error--------=-=====zmcmmmmmmamcooen 7-21
Analysis for Automatic Calibration ---------- 6-6
Analysis of Histogram------=----=--=-=------ 9-11
Analysis of RBC/PLT Histogram ----------- 9-20
Analysis of WBC Histogram ---------------- 9-11
Analysis Parameters--------------=-=-=-=------- 1-4
Analysis Procedure Flow Chart --------------- 2.2
Analyzing Samples (in PD Mode)---------- 2-21
Analyzing Samples (in WB Modeg) --------- 2-12
As-Needed Maintenance and Procedure--- 4-24
AULO RINSE----====== == m oo 4-24
Automatic Calibration ---------------=--------- 6-3
Automatic Calibration Procedure------------- 6-4
Automatic Stop Function of Pneumatic Unit1-3
B
Background Error --------=-=-=-=-=m-enmuooo- 7-17
Bellows Unit ------=-=-=-=--m-mmmmeeeeo- 8-6, 9-33
Blood Cell Discrimination Circuit ---------- 9-10
C
Calculating Calibration Valug----------------- 6-9
Calculation of RBC Constant-----------=------ 9-9
Calibration Error-----------=-s=msmmmommmumx 7-26
Calibration Execution Timing---------------- 6-1
Calibration Flow Chart------------=-=----=----- 6-2
CBC Analysis------=-=======mmmmmmoeoeeeeo - 9-5
Cell-Count Parameters------------=-=--=----- 2-26
Check before Installation-----------=====----- A-2
Check Trap Chamber Level and Discard ----4-6
Clean Rinse Cup------=-=-========m=m=mmmamnux 4-26
Clean Sample Rotor Valve (SRV) ---------- 4-16
Clean SRV Tray-------==========c=mmemmmmmeeeo- 4-7
Clean TD Chamber and Diluted Sample Line
(Shutdown) =-=-=-=====mmmmmmmme e 4-4
Clean Transducer (Rinse Sequence)-------- 4-12
Clean Waste Chamber (Rinse Sequence)----- 4-9
Clean WBC/RBC Transducer Aperture----- 4-28
Clog in the aperture----------=-=-=----------- 7-15

Correcting a Sample Number --------------- 3-17
Collecting and Preparing Samples-----2-9, 2-16
Confirmation of Cycle Number ------------ 4-41
Connect CELLPACK ------------mmmmmmmmeeo- A-6
Connect Power Cord------------------------- A-12
Connect STROMATOLY SER-WH ---------- A-8
Connect Tube ---------==--mmmmmmmmmmece oo A-6
Connect Waste Ling-------------===--==------- A-9
Contents of Display------------===--===-------- 1-7
Contents of Package------------------------- 1-11
D
Daily Maintenance and Procedure ----------- 4-4
Date/Time Settings-------------==========---- 10-7
DC Detection Method ------------=------------ 9-2
Deletion-------=---emmmeoe e 5-25
Deletion (Stored Data)-------------=--------- 3-15
Detection Principle----------------mmmmmemmmmme- 9-2
Display and Printing of Analysis Result --- 2-24
Display of Analysis Result ------------- 2-24, 3-2
E
Electric Diagram ---------------=------------- 9-29
Electric System----------------mmmmmmmmmeoe- 9-28
Emergency Stop Procedure----------------- 1-11
Entering Calibration Value------------------ 6-11
Entering Target Values------------------------ 6-5
Erase All ----------mmmmmm e 5-6
Every 3-month Maintenance and

Procedure--------------mmmmmmemee- 4-16
Execute X Control --------------=-mmmmmemmmmme- 5-9
Execute L-J Control --------------==mmoumm--- 5-18
Execute QC Program -------------------------- 5-5
Executing and Quitting Stored Data

Processing Program------------------- 3-11
Executing Automatic Calibration Program--6-3
Execution of Shutdown --------------------- 2-30
Exit from QC Program -----------=---------- 5-24
Expected Results---------------------nmmn--- 2-28
F
Factory Settings-----------==--===-===------- 10-27
Front Panel -----------------cmmmmmmme e 9-30
Front Interior-----------------commmmommmmmee- 9-31
Functional List of Error Messages------------ 7-5
G
Graphic Screen----------------mmmmmmme e 1-7
Grounding--------=========---smmmmmm oo 1-12
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H
Hardware-----------====------cmmmmmmm oo B-1
HC Output éQC Data)------------------------ 5-29
HC Output Stored Data)-------------------- 3-16
Help -----mm oo 7-1
HGB Error---------------------mommoomoo - 7-20
Host Comm. Error --------------------------- 7-33
Host Settings--------------==-=-==---==-mmn--- 10-16
How to Set Mark Limits-------------------- 10-10
I
Inputting Sample No.----------------- 2-11, 2-19
Inspection before Turning ON the Power ---2-3
Inspection of Printer Paper-------------------- 2-4
Inspection of Reagents ------------------------ 2-3
Inspection of the Instrument------------------ 2-4
Inspection of Waste------------=---==---nnnm-- 2-4
Installation and Relocation------------------ 1-12
Installation Environment ------------- 1-12, 1-14
Installation Space ---------------------- 1-13, A-3
Instrument Specifications ------------------- 1-15
K
KX-21 Maintenance Checklist---------------- 4-2
L
Levy-Jennings Control (L-J)------------------ 5-1
LCD Brightness Adjustment ---------------- 1-11
Left Side Interior-----------------==--------—- 9-34
Left Side Panel --------------------mmmommmo 9-33
Limitations ------------====--mmmommemmeee - 2-26
Limitations on Hemoglobin----------------- 2-27
Location of Control Knobs ------------------- 8-2
M
Manual Calibration ---------------------------- 6-9
Manual Calibration Procedure-------------- 6-10
Manual Discrimination ------------------------ 3-6
Marking------------=-==---mmmmm oo 3-13
Measuring Unit Hydraulic System Block
Diagram----=--===-scmneeomemmomneannannes 9-4
Memory Error---------------emmmmmmmoeo- 7-23
Menu Tree---------------cmommmmm e 1-18
Momentary power failure occurred -------- 7-24
Monthly Maintenance and Procedure-------- 4-9
N
Names and Functions of Instruments ------ 9-30
No Printer Paper ------------------oomcmmuemn 7-31

Non-Cyanide Hemoglobin Analysis Method9-2

O

Operation Procedure-------------===--==----- 4-41
Option UnNits-------=-=nnmmmmmmmmmom oo 1-3
Outline of Operation------------====-====------ 1-3
Output Format for Host Computer (Option) B-1
Overview of Analysis Modes------------------ 2-1
Overview of Instrument------------------------ 1-2
P

Panel Keyboard ----------=--=--nnmmmmommmemoe 1-6
Peripheral Settings-----------------=-------- 10-25
PLT Discriminator --------=---==--====------- 9-10
Pre-Diluted (PD) Mode---------------------- 2-15
Prepare Reagent-------------=---cmmoummmeumn A-6
Preparing Analysis Samples in PD Maode - 2-17
Pressure/Vac Error ------------------ 7-7, 7-8, 7-9
Pressure and Vacuum Adjustment------------ 8-2
Pressure and Vacuum Display ---------------- 8-3
Print (QC Data)-----------====-===-====--=---- 5-27
Print Error ----=--e=ceeeoeeoommcocecceccnene 7-30
Print Set Values ---------------------m-mmo- 10-24
Printer Error------=---==ceeceeomeoocncnnns 7-32
Printer Paper Feed -------------=---nnnmmmuum- 3-10
Printer Settings------------=--=--=--=-------- 10-21
Printing (Latest Sample)--------------------- 3-10
Printing (Stored Dat@) -------------=--------- 3-15
Printing of Analysis Result------------------ 2-25
Procedures in Analysis Modes---------------- 2-9
Processing Latest Samples--------------------- 3-2
Processing Stored Data---------------------- 3-11
PU Sleeping -----------=---===--==------- 1-10, 7-2
Q .

QC Analysis Procedure---------------=-------- 5-4
QC Analysis Procedure Flow Chart----------- 5-4
QC Chart Screen -----=--=--====nmmmmmmmmmeoaee 5-2
QC Error---------mmmmmmmmm oo 7-25
QC Settings---==--=======scemommecmmemannanns 10-13
Quality Control--------===========smmmmmmmmeme 2-8
R

RBC Aperture Clog -------=--=========-==---- 7-15
RBC Discriminator -------=============------- 9-10
RBC/PLT Analysis Flow ----------------------- 9-7
Rear Panel ~-------~-=--m=rreereeem oo 9-35
Reference Values---------------=--=mmmmmmemone 6-1
Regulator Unit---------=---===--=n-ummn-- 8-5, 9-33
Remove Shipping Clamps-------------------- A-4
Replace Fuse------=--===cemcmeecmeacnacnnns 4-36
Replace Printer Paper------------------------ 4-37
Replace Waste Tank---------=--=--=--=------- 4-32
Replenish Diluent --------------------- 4-33, 7-11
Replenish Lyse------------------------ 4-33, 7-12
Replenish Reagent --------------------------- 4-33
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Reset Sampling Vave (SRV)

Cycle Counter ------------===---------- 4-22
Right Side Pan€l-----------=====--cnmmmcmmmuu- 9-32
Rinse Motor Error -------------------- 7-13, 7-14
Room Temp. High--------------nmmmmmemmmoo- 7-16
Room Temp. LOW--------------------mmmmm-- 7-16
S
Samplin% Error--------------cememeeeo- 7-18, 7-19
Select QC File ----====mmmmmmmmeeee o 5-5
Selecting Automatic Calibration Parameter--6-4
Selecting Pre-Diluted Mode----------------- 2-18
Selecting Whole Blood Mode--------------- 2-10
Set Printer Paper ---------------------ccmmee- A-10
Set TARGET/LIMIT Values ---------=-------- 5-7
Set Value Error-------------mmmmmmoeeee - 7-23
Shutdown Procedure------------------------- 2-30
SOftWare----=--===--smmmmmmme oo B-3
Start-up Procedure--------------==---noommnu-- 2-3
Status Display ----------===--===mmmmmmemmmee 7-34
Status Display Messages----------------------- 1-8
Stopping the Pneumatic Unit --------------- 2-29
Stored Data Screen---------------=----------- 3-12
Supplies List---=---===-==mnemmcmmemcmeaaeaas 4-40
Supplies Replacement ----------------------- 4-33
System Setup ----------======-==mmmmmmmeeee 10-2
T
Troubleshooting Guide------------------------ 7-7
Troubleshooting Guide

(Analysis Errors)---------==----=------ 7-17
Troubleshooting Guide

(Built-in Printer Errors) -------------- 7-30
Troubleshooting Guide

(Chamber Errors) -------=====nnnnmnnnn 7-10
Troubleshooting Guide

(External Device Errors) ------------- 7-33
Troubleshooting Guide

(Maintenance Errors)  -------------- 7-27
Troubleshooting Guide (Memory Errors)- 7-23
Troubleshooting Guide (Motor Errors)----7-13
Troubleshooting Guide (Others) ----------- 7-25
Troubleshooting Guide

(Pressure/Vacuum Errors)-------------- 7-7
Troubleshooting Guide

(Temperature Errors)----------------- 7-16
Troubleshooting Guide

(Transducer Errors)------------------- 7-15
Turn Power ONn----------------omommmmmomooo - A-12
Turning ON the Power and Self-Check ------ 2-5

U
Updating Calibration Value

(Manual Calibration) ----------------- 6-12
Updating Calibration Value

(Automatic Calibration) ---------------- 6-8
w
Waste Not Draining ---------------=---------- 7-10
WBC Aperture Clog--------------==---=------ 7-15
WBC Discriminator ----------=---==---------- 9-10
WBC/HGB Anaysis Error ------------------- 7-21
WBC/HGB Anaysis Flow---------------------- 9-5
Weekly Maintenance and Procedure--------- 4-7
When Y ou Suspect A Trouble ---------------- 7-2
Whole Blood (WB) Mode ------------=-------- 2-9
X
X CONtrol --=-=-======mmmmmmmomo o 5-1
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